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User Interface 

In the heart of Adarian Money™ is a database that contains all your financial 
information, e.g., transactions, accounts, budgets, bills, etc. Because these information 
are important to you, and you may want to examine them from different angles, e.g., 
you may want them be presented as a logbook of all transaction records, or as a 
summary report based on categories, Money provides users with different ways of 
viewing these information, called Views. Money comes with eleven built-in views, each 
of which serves a specific purpose. In order to make it easier for you to read the 
information, all views in Money present their information in the format of a table.  

This table, thus, becomes the most important part of Money’s user interface. As a 
matter of fact, it occupies the most part of the screen; you can’t miss it once you have 
Money up and running. Although the columns in the table for each view are different, 
the look and the operation of the table is the same across all views. This consistency 
greatly reduces your learning curve.  

Because views provide different ways for you to examine your financial information, 
you’ll find yourself often switching among views. To make this easier for you, Money 
houses all view-related commands in one centralized place – the View Menu, located 
at the top-right corner of the screen. From there, you can not only switch among the 
built-in views, you can even define your own custom views, or define Quick Access 
Keys that can be used as a shortcut for switching among views. (Custom views and 
Quick Access Keys will not be covered in this chapter but later in this Manual.) Again, 
no matter which view you’re in, the View Menu is always there at the same place and is 
always available – another consistency in user interface. 

Anther common user interface element in most (not all) views is the Range Selector. 
The Range Selector lets you select a date range, e.g., from June 1 through July 31, so 
that only information within this range will be displayed or counted in.  

Last but not least is Adarian’s proprietary Online Help program that came with Money. 
Palm OS has a system-supported online help mechanism – the “i” button located at the 
top-right corner of dialog boxes’ titles. But frankly, this mechanism doesn’t work very 
well. First it’s limited to show helps for dialog boxes only; second, there is no text 
formatting at all, which makes it difficult to read when the information is long. To give 
our users an online help that really works, we developed this hyperlinked, rich-format 
Online Help program that you can get help any time you want. Best of all, it’s 
uninstallable! 
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 The Table 

The most noticeable part of Money’s user interface is the table. All views 
in Money use this table to display view-specific information. Although 
every view has its own set of columns, the operation of the table is 
always the same. Here in this section we will concentrate on how to use 
the table; as for the contents of the table, i.e., which columns are in there 
and what do they mean, will be left to the discussion of the views in their 
respective chapters. 

  Horizontal Scrolling  

At the bottom right corner of the screen, there are two arrow buttons. 
They are used to scroll the table horizontally. Every time you tap on 
them, the table scrolls left or right by one column. These buttons can be 
grayed out if scrolling is not available. 

 

  Changing Column Widths  

To adjust the width of a column, use the stylus to drag the right vertical 
separator of a column in the table header. When you drag, a black line 
will appear to let you know how the column width changes. When the 
width of a column is changed, all columns to its right are shifted left or 
right accordingly.  The following pictures shows how to drag the right 
edge of the Category column to make it wider: 

 

As you can see, after the dragging, because the Category column 
becomes wider, the Amount and Balance columns are shifted right, and 
the latter becomes partially outside the screen. 
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  Showing/Hiding Columns  

Besides changing column widths, you can also make a column show or 
hide by dragging its right separator. To hide a column, drag its right 
separator all the way to the left to make its width become 0. In the 
pictures below, after the dragging, the Category column becomes 
hidden and the Payee column which was originally outside the table is 
now shifted inside the table. 

 

In the picture above, you’ll also notice that the separator between the 
Date and Amount columns has become thicker. A tick column separator 
indicates that there is one or more columns at this position are hidden.  
To make a hidden column show, press and hold down the stylus at just a 
few pixels right to a thick separator and drag it to the right. This makes 
the rightmost hidden column (if there are more than one hidden 
columns at this position)  show. 

 

  The Table Menu  

Other than dragging the separators, there is a lot more you can do with 
the table. Just tap anywhere in the table header (away from separators of 
course), a pop-up menu will appear which contains more commands to 
manipulate the table. 

 

The menu is divided into three parts: commands in the first part affect 
only on the column that’s tapped on; the rest of the commands apply to 
the entire table. Let’s look at these commands in detail: 

 Hide command hides the column that’s tapped on. This has the same 
effect as dragging the right separator as described earlier. 
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 Align Right Edge shifts the right  edge of the column that’s tapped on 
so that it coincides with the right edge of the table. The following 
picture shows that the Amount column’s right edge is extended to 
the far right of the table and becomes wider: 

 

If the right edge of the column was outside the table, then it’s made 
narrower. See the Balance column in the following picture: 

 

This command helps you to make the best use of the limited screen 
space so that nothing is wasted. 

 Freeze command makes all columns to the left of the column that’s 
tapped on (inclusive) not scrollable when the table is scrolled 
horizontally. When a column is made frozen, there will be a vertical 
dotted line shown along the right edge of the column. The following 
pictures show the results of scrolling right two times with  the 
leftmost column frozen. 

         

 Swap is a submenu that houses the names of the columns that are 
not currently visible in the table, including the ones that are hidden, 
and the ones that are not hidden but scrolled out of screen. When 
one of them is selected, the program swaps the column that’s tapped 
on and the selected column so that the latter is made visible while 
the other is gone. This command saves you from scrolling around to 
find a column you want to see. 

As for exactly which columns will be in this submenu is dependent 
on the view that you’re in and which of them are not currently visible. 
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An easier way to directly access this sub-menu is by pressing and 
holding down the stylus anywhere inside the table header for over 
0.5 seconds, the Swap sub-menu will pop up directly. 

 Sort is also a submenu that houses four commands. The first three 
are used to sort or unsort the table based on data in the column 
tapped on. The fourth command QuickSort does not actually perform 
a sort operation, instead it selects the sorting algorithm that will be 
used in the next sort operation. This needs a little more explanations, 
so we will explain it later in this section. 

If you chose No Sorting from the Sort submenu, records in table will 
be arranged in their default order.  

  The sort status for a view can optionally be remembered and 
automatically applied the next time when you enter this view. 
Please refer to “The Preferences Command” section. 

 Adjust Columns command will bring up a dialog box that lets you 
show/hide columns and change the ordering of columns. The dialog 
box is shown below: 

 

You can tap on the checkboxes in front of column names to show or 
hide the corresponding columns. You can also first highlight a 
column then use the Up and Down buttons to change column 
ordering. The topmost column in this dialog box corresponds to the 
leftmost column in the table. 

Because each view has its own set of columns, column names shown 
in this dialog box entirely depends on what view you’re in.  

 Unfreeze command removes the freezing, if it’s been enabled. After 
selecting the command, the dotted vertical line in the table will 
disappear and all columns will be shifted when the table is scrolled 
horizontally. 

 Undo Changes command undoes any changes you’ve made to the 
table since you last switched to the current view. If you switch to 
another view without undoing, the changes you made will be 
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remembered and applied next time when you switch to this view. 
This command appears only after you have made changes. 

 Colors lets you change the colors used in the table. This change 
affects only the view you’re currently in, and it will be remembered 
and applied next time you switch to this view. 

 Font command lets you change the font size for the text used in the 
table. Unlike the Colors command, this command affects all views 
and cannot be undone. 

  QuickSort vs. Insertion Sort  

Money supports two ways of sorting: QuickSort and Insertion Sort. 
The former is generally faster than the latter. But this benefit comes 
with a price: Quick Sort is an “unstable” algorithm that the original 
sort order is lost after sorting. This is best understood by an example. 
Let’s start with the picture below.  

 

In the above picture, transaction records are sorted by dates in 
ascending order, which is the default sort order that Money’s 
database uses.  (There are almost 900 records in this  table, but only 
the first 9 records can be seen now.) 

These records belong to either the “Business” class or the “Personal” 
class.  So next we will use the two sorting methods to sort these 900 
records based on class names (the third column), in ascending 
alphabetical order. The results are shown in the following pictures: 
the left one is done by QuickSort, the right one is by Insertion Sort.  
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As you can see, both sorting methods correctly grouped Business-
class records together. But if you take a closer look, you’ll find that 
for Insertion Sort, all the Business-class records are not only sorted 
by class names but also by dates; whereas the Quick Sort’s results are 
not. That is, after sorting, the Insertion Sort retained the original 
order (in this case, the date order) for records that are of the same 
key (i.e., the text “Business”). 

Now let’s sort them again. This time, we sort them by their 
transaction status (the first column) alphabetically in ascending 
order. The results are in the following pictures: 

         

Again, both sort methods correctly grouped “C”-records together. 
But in the Insertion Sort example, among the same C-records, the 
original sort order (by classes) is retained, whereas Quick Sort can’t.  

After two consecutive sorts, the Insertion Sort’s results are now 
sorted first by status, then by class names, and then by dates. For 
this reason, we say Insertion Sort is a “stable” sort algorithm. 

If you want the table be sorted first by column A, then by B, then by 
C, you can use the Insertion Sort to perform three consecutive sorts: 
first by C, then by B, and then by A. 

  Saving Table Display Attributes  

All table display attributes (column ordering, column widths, show/hide 
state, …, except the font size) are view-specific. That is, each and every 
view (including custom views) has its own set of display attributes. 
These attributes are remembered when you leave the view, and are 
automatically applied when you enter the view. 
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 The View Menu 

 

Views are the ways how you look at Money’s database. Money supports 
11 built-in views covering all your needs, and you can define you own 
custom views. When you tap on the selector , the following menu 
appears: 

 

Everything you need about views is centralized in this View menu. You 
can: 

 Switch to a built-in or custom view by choosing its name from the 
menu; 

 Use the two arrow buttons to the left of the selector , you can 
jump back and forth among of the views that you’ve visited; 

 Create, edit, delete custom views by using commands in the Custom 
View submenu; 

 Define Quick Access Keys as shortcuts to views; 

 Access the four Goodies that Money provides for your convenience. 

Details about these commands can be found in their respective chapters. 
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 The Range Selector 

 

Except the Scheduled Transactions view, there is always a range selector 
located between the title and the table. This selector allows you to select 
a date range within which the data you’re interested in will be processed 
by Money. When Money displays transactions or generates summary 
reports, it always works on transactions within the selected date range. 
Transactions outside this range will not be processed. Tapping on the 
selector in the middle , you’ll be presented with a pop-up menu: 

 

From this menu, you can set the date range either by the month, by the 
week, by the day, or a range between any two dates.  

The two navigation buttons  are used to advance or back up the date 
range. Every time you tap on these buttons, the date range is 
incremented or decremented by one unit of whatever unit you’re now 
using. For example, if the current date range unit is a month, then 
tapping on these buttons makes it advance to the next month or back up 
to the previous month. The same goes for weeks and days.  

If the current date range is Last Year, the navigation buttons will advance 
or back up the date range by a whole year. If the date range is Year-To-
Date, then they will change the range to the same period as in the 
previous or the next year. 

But if the current date range is not of any particular unit, then they 
simply change it by the same number of days as you’re using. For 
example, if the current range is June 1 to June 5, then tapping on these 
buttons will advance or back up by 5 days. 

The navigation buttons are not available if the current date range is All 
Dates . 
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 Online Help 

Adarian Money™ comes with a proprietary online help program. With 
this program installed, you can get to read the hyperlinked, rich-text 
format online help any time you want. The Online Help can be 
uninstalled. That is, when you’re familiar with Money and you don’t 
need help any more, you can remove it from the handheld to save you a 
few hundred KB of the precious RAM. Details about installing and 
uninstalling the Online Help can be found in the “Install” and 
“Uninstall” sections. 

To access the online help, you can either use the Help command under 
the Options menu. Or, in almost all dialog boxes in Money, at the 
bottom-right corner, there is a question-mark button. You can tap on 
that button to get information about the dialog box that you’re using. 

 

The online help document is hyperlinked, i.e., you can tap on any text 
that is underlined to jump to that topic. There are seven buttons in 
Online Help’s window: 

 

The left and right arrow buttons are just like a Web browser’s Back and 
Previous buttons. They let you navigate through the history list of topics 
that you have read.  

The up and down arrow buttons are used to navigate through topics in 
their logical order. This is just like flipping through a book from chapter 
1 to chapter 2 to chapter 3, …  
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The “A” button is used to change font size. If your handheld has a high-
resolution display, you can choose to use any of the three different font 
sizes that Money supports. If yours is a low-resolution, this button has 
no effect. 

The Home button brings you to the first topic. Usually it’s the table of 
contents. The Close button closes it and brings you back to Money. 
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Views 

In the hear of Adarian Money™ there is a database. This database contains all your 
transaction records and other auxiliary information such as lists of accounts, 
categories, monthly bills, …, etc. What Money does is nothing but two jobs: provide 
you ways to edit the data in the database, and to view the data in the database. Views 
are the ways how the data are summarized and presented to you. 

Money comes with eleven built-in views, five of which will be discussed in their 
respective chapters. They are: Transaction Log, Account Register, Accounts List, 
Categories/Budgets, and Scheduled Transactions. In this chapter, we will discuss the 
rest of the four views: Cash Flow, Trend, Summary, Classes, and Payees. 

In addition to the eleven built-in views, Money also allows you to create your own 
views based on those eight views. These are called Custom Views, which will be 
discussed in this chapter. 

No matter which view you’re in, you can always use the Export command from the 
Data menu to export whatever is shown in the table. Rows in the table can be exported 
in CSV, HTML, RTF, or text format and saved in the handheld’s memory, next time you 
perform a HotSync, the exported files will be transferred to your PC’s hard disk.  

Switching among these views is easy, because all view-related commands are 
centralized in one place: the View Menu. But in order to let you quickly switch to the 
view you want, Money has this unique function Quick Access Keys which lets you get 
to the view you want by entering just one letter; if your screen is in extended mode 
(320x450 or 450x320), you can use Quick Assess Buttons. 

 Cash Flow View 

This view plots the daily ending balances of the selected account or 
account group using an area chart. By default, you can use Graffiti or 
hardware keyboard to enter the Quick Access Key ‘f’ to switch to this 
view. 

Balances shown in this view are always the posted ending balance of a 
day. Please refer to the “Balances” section for details on different types 
of account balances. 
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The X-axis represents the dates, you can use the plus- and minus-sign 
buttons at the bottom to zoom-in and zoom-out, or use the left and 
right buttons to scroll the chart. The dotted vertical line is today’s date. 

The date range of the chart is selected from the selector located at the 
upper-left corner of the screen. When you tap on it, the following dialog 
box appears: 

 

Here you can choose the range of the chart. Note that all the date 
options except Custom… are relative to the current date.  

By checking on or off the Show future transactions you can decide if 
unrealized and upcoming scheduled transactions should be included in 
the chart. In the above example, today’s date is 8/17, and there is a 
scheduled transaction of $1400 to be paid from AMEX credit card on 
8/27, so the curve drops down a little on 8/27 to show the change in 
AMEX”s balance. To clearly see the balance amount and the name of the 
scheduled transaction, you can tap and press the stylus any where 
inside the chart area, a little yellow box will show. See the pictures below: 
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You can move the stylus around while keeping it pressed down, 
information shown in the box will change as you move the stylus. 

Y-axis is the balance amount; its unit is shown at the bottom-left corner 
if the y-scale unit is one thousand or one million. The currency of the 
balances is also shown at them bottom.  

It’s worth noting that if there is only one account selected, then only that 
account’s balances are used to plot the chart, and the currency used in 
the chart will be the same as that account’s currency. If an account 
group is selected, the combined balances from all accounts in the group 
are shown. If the currency types of the selected accounts are different, 
then balances are converted to home currency; if they are the same, 
then the currency used in the chart will be the same as that of those 
accounts’. 

Balances shown in the chart are not affected by filters. 

 Trend View 

This view plots the monthly/weekly/daily trend on income and 
expenses. All transactions in the database are enumerated except the 
ones that are filtered out by filters. By default, you can use Graffiti or 
hardware keyboard to enter the Quick Access Key ‘e’ to switch to this 
view. 

 

Because filters take effect on this view, you can use proper filters to 
easily get to know the trend of spending (or earning) on a particular 
category or payee or anything. 

Tapping on the chart will pop up a little yellow pop-up box to show the 
date and the exact number. 
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 Pie Chart 

This view summarizes and draws the incomes or expenses for categories, 
payees and classes in a pie chart. By default, you can use Graffiti or 
hardware keyboard to enter the Quick Access Key ‘i’ to switch to this 
view. 

 

In the popup list on the right, you can select what data to plot. You can 
choose categories, payees, or classes, you can also choose if you want to 
plot only incomes or expenses.  

If there is a filter currently in effect, the chart is drawn with the filter 
being applied. You can tap on any pie in the chart to bring up a little 
yellow box which contains detailed information about that pie, 
including its name, amount, and the percentage. 

When drawing the chart, pies whose amounts are smaller than a pre-
defined threshold will not be shown in the chart. Instead, these small 
pies will be combined into a special item named (others) in the chart. 

At the bottom of the screen, there is a Sort checkbox. When checked, 
pies are sorted, in clock-wise direction starting from the north, by their 
amounts. If not checked, pies are sorted alphabetically.  

If the chart shows categories, another checkbox will appear: the Combine 
checkbox. When checked, all sub-categories’ expense or incomes are 
combined into their parents’; only parent categories are shown  in the 
pie chart.  

 Summary View 

This view gives you a quick glance of your financial status. You can get to 
know how much is left, how much has been earned and spent, etc. By 
default, you can use Graffiti or hardware keyboard to enter the Quick 
Access Key ‘s’ to switch to this view.  
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The table in the Summary view is divided into four sections: Summary, 
Income, Expense, and Accounts. All amounts in the first three sections 
are in home currency; amounts in the Accounts section depend on the 
currency types of their respective accounts. You can control whether or 
how currency symbols are shown from the Preferences dialog box. 

  Section 1: Summary  

All amounts in this section are in home currency. This section has the 
following rows: 

Income – total income of all transactions that are in the selected date 
range and have passed the filter test, if there is one.  

Expense – total expense of all transactions that are in the selected date 
range and have passed the filter test, if there is one. 

 For a complete discussion on how Money calculates incomes and 
expenses, please refer to the “Calculation of Income/Expense” 
section. 

Net Total – the sum of the above two numbers. If this is a negative 
number, it means you spent more than you earned, given the date range 
and the filter. 

Beginning Balance – the sum of beginning balances of all accounts at the 
beginning of the selected date range. This number is not affected no 
matter if there is a filter or not. 

Ending Balance – the sum of ending balances of all accounts at the end of 
the selected date range. This number is not affected no matter if there is 
a filter or not. If this is a negative number, it means you’re in debt at the 
end of the given date range. Note that a negative number in the Net Total 
row only means you’ve spent more than you earned, but not necessarily 
you’re in debt; you’re in trouble only if the Ending Balance row is negative. 

 For a complete discussion on what all these balances mean, 
please refer to the “ Balances” section. 
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  Section 2: Income  

Forecast  – total amount of income forecasts within the selected date 
range.  

Income – same amount from the Income row in the Summary section. 

Difference – the difference between the forecast and the actual income. 
If this is a negative number, it means your income is not as good as 
expected. 

  Section 3: Expense  

Budget  – total amount of expense budgets within the selected date 
range.  

 For a complete discussion on how Money calculates forecasts 
and budgets for a given date range, please see the “Date Range 
and Budgets” section. 

Expense  – same amount from the Expense row in the Summary section. 

Difference – the difference between the budget and the actual expense. If 
this is a negative number, it means you’re over your budget; if it’s 
positive, it means you’re safe, for now. 

  Section 4: Accounts  

This section gives the beginning and ending balances of the given date 
range for each and every account in the database. Each account in this 
section has two rows, one for the beginning balance, the other for the 
ending balance. These balances are not affected no matter if there is a 
filter or not. 

For a complete discussion on what all these balances mean, please refer 
to the “Balances” section. 

 Classes View 

This view gives a summary based on transactions’ classes, from this view 
you can get to know how much was spent or earned for each class. By 
default, you can use Graffiti or hardware keyboard to enter the Quick 
Access Key ‘c’ to switch to this view.  
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Tapping on the Setup button at the bottom has the same effect as using 
the C assesl  command from the Lists menu, please see the “Defining 
Classes” section for detail. 

  Tapping on Rows  

If you tapped on a class (except the <Unassigned> and Total rows) in the 
table, Money will jump to the Transaction Log view and a filter will 
automatically be applied so that only transactions  having the class you 
chose will be shown in the table.  

 If there is already a filter in use, Money will “synthesize” a filter 
for you. Please refer to the “Synthesized Filters” section for details. 

  Columns in the Table  

Name – name of the class. 

Total –  summation of amounts in the Income and Expense columns. 

Income – total income of all transactions that 1. belong to this class, 2. 
are in the selected date range, and 3. have passed the filter test, if there is 
one. 

Expense – the total expense of all transactions that 1. belong to this class, 
2. are in the selected date range, and 3. have passed the filter test, if 
there is one. 

 For a complete discussion on how Money calculates income and 
expenses, please refer to the “Calculation of Income/expense” 
section. 

Note Text – note text of the class. 

Note Icon – a note icon if the class has note text attached with it. You can 
tap on a note icon to bring up a little text box to show the first four lines 
of the note. 
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 Payees View 

This view gives a summary based on transactions’ payees, you can get to 
know how much was spent or earned for each payee. By default, you can 
use Graffiti or hardware keyboard to enter the Quick Access Key ‘p’ to 
switch to this view.  

 

Tapping on the Setup button at the bottom has the same effect as using 
the Payees command from the Lists menu, please see the “Defining 
Payees” section for detail. 

  Tapping on Rows  

If you tapped on a payee (except the <Unassigned> and Total rows) in the 
table, Money will jump to the Transaction Log view and a filter will 
automatically be applied so that only transactions having the payee you 
chose will be shown in the table.  

 If there is already a filter in use, Money will “synthesize” a filter 
for you. Please refer to the “Synthesized Filters” section for details. 

  Columns in the Table  

Name – the name of the class. 

Total – summation of amounts in the Income and Expense columns. 

Income – total income of all transactions that 1. belong to this payee, 2. 
are in the selected date range, and 3. have passed the filter test, if there is 
one. 

Expense – the total expense of all transactions that 1. belong to this payee, 
2. are in the selected date range, and 3. have passed the filter test, if 
there is one. 

 For a complete discussion on how Money calculates income and 
expenses, please refer to the “Calculation of Income/expense” 
section. 
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Note Text – note text of the payee.  

Note Icon – a note icon if the payee has note text attached with it. You 
can tap on a note icon to bring up a little text box to show the first four 
lines of the note. 

 Custom Views 

To better understand your financial status, you may often wan to view 
data in a particular way. But it’s time-consuming to manually set up 
Money in the way you want every time. In this case, you can define a 
Custom View so that every time you switch to it, data are already 
organized in exactly the way you want for you. Custom views can be 
thought of as shortcuts to viewing data in the way you want. 

A custom view is built upon five things: a base (built-in) view, table 
display format, a filter, a relative date range, and a Quick Access Key. 
Well, it’s easier to understand the idea by looking at two examples. 

  Example 1: Checks in the past 15 days  

Assuming you have several checking accounts and you often write 
checks from those accounts. From time to time, you want to find out 
what checks (especially those of large amounts) have been made in the 
past 15 days, so you decided to set up a custom view for this task. 

Step 1 –The best way of viewing check transactions from more than one 
account is the Transaction Log view. So first, switch to the Transaction 
Log view by using the View Menu. This will be the base view of the 
custom view. 

Step 2 – Because you want to view only check transactions, so you can 
use the Filter command form the Data menu to set up a filter like 
following and apply it: 

Check # is not empty and Amount <= -100 

This filter makes only transactions where a check is involved and the 
amount is over -$100 be displayed in the view. See below: (note the  
icon showing at the top beside the View Menu, this means a filter is in 
effect) 
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The current date range is This Month, not the “past 15 days” you want. 
But never mind about that at this point, we’ll come to that later. 

Step 3 – Because the information you’re interested in checks, so you can 
use the Adjust Columns command from the Table menu to make the 
Check # column shown in the table. Also, it’s a good idea to use different 
colors so that it can be easily identified. So you used the Colors 
command to assign a different color combination for this custom view: 

 

Step 4 – Now everything has been set up, you can use the Save 
command from the View Menu to save everything that you just did as a 
custom view. 

 

Step 5 – In the Save View dialog box, you can give the custom view a 
name, like “Checks in Past 15 Days”. And use the Date Range option to 
assign a relative date range for it. 
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In this example, we gave a range of Past 15 days, that means when  you 
use it, the date range will always be set to the past 15 days counting 
backward from the date when you use the custom view. That’s why we 
call it “relative” date range – relative to the date when you use the 
custom view, not the date when you defined it. 

Optionally, assign as Quick Access Key for this custom view. With it, you 
need only enter a letter ‘z’ to jump to this view. Very convenient. 

Tap on the OK button and you’re done! From now on, no matter which 
view you’re in, just enter a letter ‘z’ and you’ll be directly brought to this 
custom view: (note the screen title tells you where you’re, and the date 
range has changed) 

 

Step 6 – well, not quite yet. You see, because you’ve changed the display 
format for the Transaction Log view, if you don’t change it back, then 
this new format will be remembered as the new defaults for Transaction 
Log view. And that means Transaction Log view will look just like the 
“Checks in Past 15 Days” view. This defeats the purpose of setting up a 
unique display format for the custom view! Therefore, at this point, you 
may wan to use the Undo Changes command from the Table menu to 
undo the changes you just made.  

Of course, this is optional. You don’t need to do this if you don’t mind 
about the uniqueness or if you never changed the display format in the 
first place. 

  Example 2: How Expensive My Kids Are?  

Assuming you have a few kids and you always wonder exactly how much 
you spent for them during the past month. 
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Step 1 – You have set up a class called “Kids” which is used for all 
transactions that are for kids. So the best way to view this is using the 
Classes view, so first switch to this view. 

 

Step 2 – This time we don’t need a filter because the Classes view 
already summarizes the amounts based on classes for you. But because 
you’re interested in expenses, so maybe you can use the Swap 
command from the Table menu to pull the Expense column to the front. 
And this time you want to use a greenish color for this view. After adjust 
the columns and the colors, this is how it looks like now: 

 

Step 3 – Now we use the Save command from the View Menu to save 
this as our second custom view. 

 

Note that we chose to use Previous month as our relative date range, and 
a Quick Access Key ‘y’. Tap OK to exit this dialog box. 

Step 4 – Again, use the Undo Changes from the Table menu to make the 
Classes view back to what it was. 
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 Manipulating Custom Views 

Now that we’ve seen what custom views are, we can start to describe in 
detail how to define and use them. By now you should have an idea that 
in order to define a custom view, you need to: 

1. Choose  a base view, and jump to that base view; 

2. Adjust display format as you wish; 

3. Apply a filter if necessary; this filter can be either a saved filter or a 
simple filter; 

4. Select the Save command from the Custom View submenu in the 
View Menu, then in the Save View dialog box, choose a relative date 
range and assign a Quick Access Key; 

5. Use Table menu’s Undo Changes command to restore the base view’s 
original display format. 

  The Custom View Submenu  

In the View Menu, there is a Custom View submenu, see the picture 
below: 

 

The first part of this submenu are up to 5 most recently used custom 
views, you can jump to any of these views by selecting one from the list. 
The second way to jump a custom view is use the Switch To command 
from the submenu. The following dialog box appears: 
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This dialog box has a list of all the custom views, you can choose any one 
of them to jump to. The third way of switching to a custom view is by 
using a Quick Access Keys, which will be explained in the next section. 

Also in the submenu is a Delete command. Apparently, it’s used to 
delete the custom views you no longer need. 

We have mentioned about the Save command earlier. But we may need 
a little more elaboration here. This command is used to create a new 
custom view, but can also be used to modify an existing one. 

 

If you’re already in a custom view when you invoke this command, 
you’ll see its name, date range, and Quick Access Key are already in the 
dialog box. Moreover, you’ll see an option Overwrite existing. If this 
option is checked, any change made in this dialog box plus the 
environment settings (filter, table format, etc.), will overwrite current 
custom view’s definition. That is, with proper setup procedures, you can 
change an existing custom view’s filter, display format, date range, 
access key, and even rename it. (But you won’t be able to change the 
base view. Because as we said, in order to overwrite a custom view’s 
definition, you have to switch to that view first. That is, the base view is 
already determined when you switch to that view and thus cannot be 
changed.) 

If the Overwrite existing option is not checked, you’ll be able to create a 
new custom view. But remember, be sure to give a different name to the 
new view, or Money won’t accept it. 

In the Save View dialog box, there is a pop-up list where 
you can select a relative date range. In this list, This month 
refers to the month when you invoke the custom view; the 
Previous month is the month before the current month. 
Year-to-date is from the first day of the year to the day 
when you invoke the view. Past  option, as we’ve seen 
earlier,  lets you specify a number of days before the current date. Retain 
original means the date range will not be changed when the custom view 
is invoked, it remains what it was.  All selects all date in the database. 
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 Quick Access Keys 

Money comes with eleven built-in views, and four “Goodies”, that’s 
already 12 views. Plus, you can define your own custom views. With so 
many views, it’ll be a shame if there is no an easy way to switch among 
them. That’s where Quick Access Keys come in. 

With Quick Access Keys, you can assign each view with a unique letter. 
No matter which screen you’re in, simply by entering a letter using 
Graffiti or the handheld’s keyboard, you’ll brought directly to the 
corresponding view. 

 When entering Quick Access Keys, do not precede them with the 
Command Stroke (the Graffiti stroke going from lower-left to 
upper-right.) Just the letter. 

Following is the default Quick Access Key assignments: (Quick Access 
Keys are case-insensitive) 
 

Key View Key View 

t Transaction Log c Classes

r Account Register h Scheduled Transaction

a Accounts List e Trend

s Summary 1 Arithmetic Calculator

f Cash Flow 2 Calendar

b Categories/Budgets 3 Currency Converter

p Payees 4 Loan Calculator

i Pie Chart   

  Defining Quick Access Keys  

To define your own quick access keys, you can select the Quick Access 
command from the View Menu. 
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In this dialog box, you can define up to 20 Quick Access Keys for any of 
the eleven built-in views, the four Goodies, and custom views you 
defined. To remove a key definition, simply select <Unassigned> from the 
list to the right of the letter, or delete the letter from the text editing field. 

  Limitations  

There are limitations to Quick Access Keys when you’re in one of the 
Goodies.  

First, you can use a Quick Access Key to jump to the Calendar or the 
Arithmetic Calculator views. But once you’re in there, you won’t be able 
to use Quick Access Keys to jump to another view.  

Second, for Currency Converter and Loan Calculators views, they both 
have text editing fields on the screen. These text editing fields make 
things a little difficult . See the following pictures: 

        

In the Currency Converter picture (left), you can see a blinking cursor in 
the first text editing field (well, it’s not blinking right now, because 
you’re looking at a still image. But I swear, it will blink when you see it 
on your handheld!). And in the Loan Calculator (right), you can see text 
in the first text editing fields is highlighted (black on light yellow). When 
in such conditions, we say the text editing field “has the focus.” When a 
field has the focus, anything you entered from Graffiti or keyboard will 
be sent to that field. That is, if you enter a Quick Access Key when one of 
the fields has the focus, it won’t work because the key is “absorbed” by it. 

What you can do now is to first tap on an empty spot on the screen -- a 
spot that doesn’t have any fields, buttons, menus, etc. After doing so, the 
focus will be gone – the blinking cursor and the highlight will disappear. 
This means the fields don’t have the focus any more, now you’re safe to 
use the Quick Access Keys. 
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 Quick Access Buttons 

On some handhelds, the screen can be extended to portrait (320x450) or 
landscape (450x320) mode. When extended, the Graffiti area is closed so 
that user has no way to enter Quick Access Keys. To remedy this, Money 
provides a second way of switching views – the Quick Access Buttons. 

When the screen is extended, a row (or column) of buttons will be 
shown at the bottom (or the rightmost part) of the screen: 

     

The first 12 (or 11) Quick Access Keys will be shown as buttons. Tapping 
on these buttons have the same effect as entering keys. 

The button bar can be disabled by checking off the Show button bar 
option from the Preferences dialog box. 
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Transactions 

Transactions are the most important part of Adarian Money™. In this chapter, we will 
start from the most basic and important thing about transactions: their attributes. We 
will explain what they are how you can use them. Then, we will describe how to create 
and edit transactions. In the last section, we will explain what are Split Transactions, 
and how to use them. 

 Transaction Attributes 

Each transaction in Adarian Money™ has several attributes that need be 
assigned when you enter a transaction. Following are these attributes: 

 Transaction Type – the type of a transaction. It can be one of the 
following: (1) Deposit: Money coming in from an account that’s not 
in Money’s list of accounts; (2) Withdrawal: Money going out to a 
destination that’s not in Money’s account list; (3) Transfer: Money 
going from one account to another, where both accounts are in 
Money’s account list. 

The first two types are easy to understand. But the transfer type 
needs a little more elaboration. 

More on Transfer Transactions 

Let’s say you have two bank accounts, A and B, and they both have 
been entered into Money; and you have a third account C, for some 
reason, you did not put it in Money. So to Money, you only have two 
accounts. When you transfer funds from A to B, you can enter such 
transactions as Transfer transactions. But when you move funds 
from A to C, to Money, this is a withdraw transaction because you’re 
moving money out of Money’s “jurisdiction”. 

From net-worth's point of view, transfers among accounts inside 
Money's jurisdiction do not change your net worth; you're just 
moving money for your left pocket to your right pocket. So usually 
when Money calculates income and expense, transfers are not 
counted in. But there are times when you'd want to count transfers 
as expenses or incomes. For example, when you pay your mortgage, 
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although your net worth does not change, but you'd still want to see 
the monthly payment be taken as your expenses. Adarian Money 
provides an easy way for doing so, please refer to the section of 
"Calculation of Income and Expense."

“Transfer Out” and “Transfer In” 

When a Transfer transaction is entered into Money, e.g., transfer 
from A account to B, two records will be created in the database. The 
first is a “Transfer Out” transaction from account A, the second is a 
“Transfer In” transaction into account B. These two terms are used 
only in some places in the user interface; mostly they are just 
referred to as “Transfer”. 

When the Transfer Out transaction is displayed in either Transaction 
Log or Account Register view, the Category column would show [B] 
and the amount will be negative. On the other hand, the Transfer In 
transaction will have [A] in its Category and a positive amount. The 
following picture depicts the situation when transferring $100 from 
Checking account to Cash, note how the Account and Category 
columns are different. 

 

Transferring Between Different-Currency Accounts 

Usually when you transfer funds from one account to another, the 
amount sent and amount received should be the same, as in the 
above picture.  

If the two accounts are of different currencies, then things will be a 
little more complicated. We will have more details in the last section 
of this chapter. 

 Date – usually this is the date when a transaction was made, or 
posted date. The date when the bank finished processing the 
transaction is called clearing date. Often clearing date is several days 
later than the posted date. If you often compares Money records and 
bank statement, it’s better to use clearing dates. 

 Amount – the amount of a transaction. Adarian Money supports 
multiple currencies; you can enter amounts in any currency you 
want.  

For example, if you live in Germany and travel to Hong Kong form 
time to time. When you use your Euro credit card to purchase things 
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in Hong Kong, you would most likely enter transactions using local 
currency – HK dollar. Money will do the conversion for you, and 
both amounts will be remembered in the database. You can view a 
transaction’s original amount in the Transaction Log and Account 
Register views. 

When you enter transaction amounts, you always enter them as 
positive values; Money will determine its actual sign based on the 
transaction type. 

 Exchange rate – is the exchange rate used in this transaction if a 
different currency is involved. See “Exchange Rate” section for 
details. 

 Account – an account that’s held in a financial institution, such as a 
bank or a credit card issuing company. You can create checking, 
savings, credit card, asset, and liability accounts in Money.  

Accounts must be assigned with a currency. All transactions’ 
amounts will be converted to the currency of the account they 
belong to.  

For more information on how to define and use accounts, please 
refer to the chapter “Managing Accounts”. 

 Category – a way to categorize your transactions, usually the 
purpose of the transaction. For example, “Salary”, “Grocery”, 
“Clothing”, “Rent”, etc. Please refer to the “Categories and Budgets” 
chapter on details about categories and budgets. 

 Payee – the party who receives money from you or pays money to 
you. Please refer to the “Defining Payees” chapter to see how to 
define payees. 

 Class – in addition to category, this is another way of categorizing 
your transactions, you can think of it as a secondary categorization. 
For example, if you have a category called “Dinning Out” and you 
use it to keep track of the money used on dinning in restaurants. 
Sometimes you dine with your family, and sometimes with your 
customers or business associates. So for transactions like these, their 
categories will all be “Dinning Out”, but the classes can be either 
“Personal” or “Business.” 

Please refer to the “Defining Classes” chapter to see how to define 
classes. 
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 Transaction Status – the status of a transaction, it can be one of the 
following: 

Posted –a transaction has been entered into Money’s database but 
not yet cleared the bank. 

Cleared – bank has received and finished processing the transaction 
and it is showing on bank’s statement. 

Reconciled – a transaction has passed the Reconciliation process 
and it matches with bank’s statement. This status is usually not set 
by the user, instead, Money automatically sets transactions to 
Reconciled after a successful reconciliation. Although you can 
manually set a transaction’s status to Reconciled, but Money will 
issue a warning message to ask you to confirm it. Similarly, when 
you try to modify a reconciled transaction, Money will also ask you 
to confirm. The Reconciled status means a Money’s transaction 
record matches with the bank record, supposedly it should not be 
changed at all. 

Imported – After importing from a QIF file, Money sets imported 
transactions’ status to Imported to let the user clearly know which 
transactions were imported and need be reviewed. This status is only 
temporary; they will be changed to Posted status when you quit 
Money or before you use the Reconcile command. 

Unrealized – This status means this transaction hasn't happened yet. 
By entering a yet-to-happen transaction into the database, you give 
yourself a reminder that something should have or will be done. For 
example, you received a bill from your lawyer (which doesn't repeat, 
otherwise you should've used a scheduled transaction), but you're 
not ready to pay the bill yet. So you can enter it into the database 
and leave it as Unrealized. This way, whenever you see it, you'll 
know there is an unpaid bill. For more details, please refer to the 
section of “Unrealized Transactions”. 

 Excluded – when checked, this transaction will be excluded form the 
calculation of income and expense. For details, please refer to the 
“Calculation of Income and Expense” section.  

 Check number – the number of the check that a transaction uses. 
Money can remember the check number you last used and 
automatically assign the next check for you. For details, please see 
the “Defining Accounts” section. 
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 Note – note about a transaction. A note cannot be longer than 64KB 
and is subject to how much memory is available. Note that the note 
text is not encrypted in the database. That is, even if you used a 
password to protect Money’s data from prying eyes, but if you lost 
your handheld and someone found it, and if this person is 
knowledgeable enough, he still can have ways to access your data. 
When this happens, any sensitive information you put in the note 
field may be compromised. Therefore, it is not recommended to save 
sensitive information in Money, such as credit card numbers.  

 Creating Transactions 

Creating transactions must be done from either the Transaction Log 
view, Account Register view, or Accounts List view (or any custom views 
that are based on these three views.) To create a new transaction, switch 
to one of these views, then tap on the New button located at the bottom 
of the screen.  

To modify a transaction, you have to first switch to either of the 
Transaction Log view, Account Register view (or any custom views that 
are based on these two views), then tap on the transaction in the table. 

Either way, you’ll be brought to the following dialog box: 

 

In this dialog box, it’s easy to see that each field corresponds to one of 
the attributes we introduced in the previous section. So it should be 
pretty easy to get to know what you should enter in this dialog box. But 
with one exception: 

One time – this checkbox (not shown in the above picture, but it’s 
located to the right of the Cancel button) appears only when you are 
executing a scheduled transaction. If this check box is not checked, 
whatever changes you made to the transaction (like its amount, category, 
etc.) will be remembered into that scheduled transaction so that when it 
happens next time, you don’t have to enter again. If this checkbox is 
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checked, then all the changes you made here will not be remembered, 
that is, the changes are for one-time only and will not affect future 
transactions. 

You can tap on the calculator icon  to call up the built-in calculator to 
do some calculations and tap on the Enter button in it to put the 
calculated result back into the Amount field. You can choose any 
currency type for the amount of the transaction. But no matter what 
currency you choose, when saved to the database, it will automatically 
be converted to the currency of the account of this transaction. 

When you use the stylus to tap on the Chk (check number) field, the next 
available check number for the account you chose will automatically be 
put in the editing field.  

The two arrow buttons by the date selector can be used to advance or 
backward the date. They are very useful when you are just a few days 
away from the date displayed in the date selector. 

  Auto Fill-In  

In order to save you from entering the same information over and over, 
Money remembers the association between a payee and the category, 
account, class that are used with it. When you select a payee in the 
dialog box, the program automatically fills in the rest of the information. 
For example, you often go to Starbucks to get a cup of coffee, so when 
you have selected the payee as “Starbucks”, the remembered category 
“Snack”, class “Personal”, and account “Cash” would be filled into the 
dialog box. 

This auto fill-in feature can be disabled by checking off the Auto Fill-In 
option from the Preferences dialog box. Money can remember up to 50 
most frequently used such relations. Information for transactions that 
have sub-transactions are not remembered. 

If your handheld uses a double-byte Palm OS, such as Chinese or Korea, 
auto fill-in also works if you use the Manual QuickSelect technique, 
which will be explained later in this section. 

  Editing Lists  

It’s very common that the account, category, payee, or class you want to 
use does not exist in the list. At this point, you don’t need to quit the 
dialog box to edit the list then come back again, Money lets you edit 
these lists right from this dialog box.  
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To do so, just tap on the triangle button by the label (such as ), a 
list would pop up. At the top of the list, there is a special command that 
looks like “--- Edit xxxx ---”where xxxx is the name of the list. When you 
select this command, the respective list editing dialog box  will appear. 
You can add, modify, or delete items in there. Then when you’re done, 
Money will update the lists to reflect the changes you made in the list 
editing dialog box. 

  Using QuickSelect  

In order to make it easier for you to pick out an item from a long list, 
Money provides a convenient way QuickSelect to do this. Here is how to 
use it:  

When you want to enter an account, payee, or category in Transaction 
dialog box, you can simply tap on the downward triangular icon to the 
right of the text label , a pop-up list will appear along with a scroll 
bar. We’ll use the category list as an example in the following pictures: 

               

Scrolling 

You can use the scroll bar to scroll down the list and pick the one you 
want1. Another way to scroll down the list is by entering a letter through 
Graffiti or your Palm’s keyboard. When doing so, the list scrolls down to 
the first item that starts with the letter and the item become selected. If 
you’re in the Category list, sub-categories can be selected this way too. 

Entering Text 

Alternatively, you can enter text directly into the text editing field next to 
the triangular icon, and the program will automatically find from the list 
the first item that matches with what you have already entered and put 
the matching item into the editing field.  

                                                            
1 The standard Palm OS user interface uses a small triangular icon at the top-right and bottom-
right corner of the list for you to scroll it. We believe using a scroll bar is a lot easier than that. 

 Page 37 of 171 



Adarian Money™ for Palm OS® User’s Manual  © 2003-2006, Adarian Software, LLC 

For example, if you have the following three items, among others, in the 
Category list: Insurance, Interest, and Investment. When you enter the 
first letter “i”, the program shows “Interest” in the field because it’s the 
first one that matches with “i”, see below. At this point the first letter “i” 
is not highlighted whereas the rest of the word is highlighted; this shows 
what you entered was just “i”, the rest of the word was automatically 
appended. 

 

When you entered the second letter “n”, “Insurance” stays there 
because alphabetically it’s the first one that matches with “in”. But now 
the first two letters “in” are not highlighted, see below: 

 

When you continue to enter the third letter “v”, it changes to 
“Investment” because it’s alphabetically the first one that matches with 
“inv”. 

 

At any time during the input, you can stop inputting when the text 
shown in the field is already what you want. You don’t have to do 
anything special to end the input, just leave the text there and tap on 
some where else to continue with what you want to do next. In the 
previous example, you only need to enter one letter ‘i’ to select 
“insurance” and three letters “inv” to select “investment”. Usually 
entering 1 to 3 letters is enough to get what you want. 

The same goes for Account and Payee fields. 

  ManualQuickSelect  

The QuickSelect feature described above works well for single-byte Palm 
OS systems (such as English, German, etc.), but doesn’t work on Chinese 
and Korean Palm OS systems. In order to utilize this feature, the user has 
to manually enter a Return character using Graffiti or the keyboard (if 
your handheld has one) to force the program to perform the match. 

This is how it works: 

Tap on the text entry field to establish the blinking cursor, then enter the 
first double-byte character. Nothing will happen at this time if your 
handheld is a Chinese or Korean system. Now you can enter the Return 
character, which forces the program to search for an item in the list 
which begins with the character you just entered. 
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If there is more than one item which begins with the same character, 
you can continue to enter the second character, then enter a Return, the 
program will search for the first item whose first two characters are the 
ones you entered. Then you can enter the third character and a Return, 
etc. 

Alternatively, you can enter two (or more) characters at once then enter 
the Return character.  

This technique works also on sing-byte systems. 

  Unassigned Items  

When you first enter this dialog box to create a new transaction, all list 
fields are empty. You can leave them empty if you don’t want to assign 
anything. In this case, they will automatically be assigned with 
<Unassigned> when you exit the dialog box. Or, you can select 
<Unassigned> from the list.  

  The Category List  

In the category list, there are two special items: “--- Expense ---” and “ -- 
Income ---”. They are not actual categories or commands, they are just 
separators to separate expense categories from income categories. You 
should not select these two items. 

-

There is another command in the category list, the “--- Split ---” 
command. You can use this command to enter a Split Transaction.  

Note that no matter if the transaction is a deposit or withdrawal, you can 
choose either expense category or income category as you wish. As we 
said earlier, a deposit transaction using an expense category is perfectly 
legal, it means reduction in expenses, not income. 

  Transfer Transactions  

If you want to enter a transfer transaction, first select the Type to be 
Transfer, then the dialog box will change to the following: 
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This dialog box is largely the same as we have described above with only 
one exception: the From and To fields. As can be expected, they are used 
to enter the source and destination accounts of the transfer. Of course, 
you can’t select the same account as both the source and destination. 
Note that transfer transactions don’t have Category or Payee attributes. 

When entering a transfer transaction, Money inserts two transaction 
records into the database: one for the source account, the other for the 
destination account. Details can be found here. 

 Exchange Rates  

If a transaction is made using a currency that’ different from the 
account’s currency, Money will always remember both the original 
amount and the converted amount. By default, the conversion rate will 
be the one defined in the Currency list. If you want to specify a different 
rate, you can use the - Exchange Rate-- command from the Currency pull-
down list. You can view the original amounts and exchange rates 
information in the 

-

Transaction Log and Account Register views. 

For example, a traveler goes to Japan from the US. Before depart ring, he 
bought some Yen at a local bank at the rate of 1USD : 112JPY. Then he 
bought some more at the hotel concierge in Tokyo, this time the rate is 
1USD : 105 JPY (hotel’s rates are usually the worst.) And when he uses 
his USD credit cards to buy things, the rates can be different again 
because they are defined by the banks. Using this command, you can 
accurately obtain the equivalent home currency amounts. 

The use of this command is a little different for different types of the 
transaction. These are discussed below: 

  Withdraw and Deposit Transactions  

When selected, the following dialog box appears: 

 

Here in this dialog box, by using the Change button, you can enter any 
two of the three parameters of a currency conversion (original amount, 
exchange rate, and converted amount), the program will calculate the 
third for you. The exchange rate can be different from or the same as the 
rates set up in the Currency list. The rates you entered here will not 
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affect the one defined in the Currency list. Up to 10 exchange rates will 
be remembered by the program, you can tap on the triangle button to 
the left of the rate entry field to quickly access previously used rates. 

The exchange rate you enter here should be the rate from the currency 
selected in this dialog box to the account’s currency. For example, if you 
selected an account whose currency is USD, and you selected JPY in this 
dialog box, then the rate should be from JPY to USD, around 0.01 or so.  

Both the original amount and the exchange rate will be remembered as 
part of the transaction. You can view them using the Transaction Log 
and Account Register views. 

After you have OK’ed this dialog box, you will be brought back to the 
Transaction dialog box. You will notice that both amounts are displayed 
in a selector: 

 

You can tap on the amount selector to get in to the Exchange Rate dialog 
box. If you want to remove the exchange rate and use the default one, 
use the Clear button from the Exchange Rate dialog. 

  Transfer Transactions  

Sometimes when you transfer money from one account to another, and 
when the currencies of the accounts are different, the bank would 
negotiate the exchange rate with you. You can get a better rate if the 
amount is large enough. In this situation, the rate is usually different 
from what you have set up in the Currency list. So you may want to use 
the --Exchange Rate-- command to specify a different rate. 

Before using it, it’s better, though not necessary, to specify both the 
source and destination accounts. By doing so, the program can correctly 
display currency symbols in the Exchange Rate dialog box. 
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Note the difference between this and the above dialog box: You can’t 
change the currency type. The currency type shown to the left of the 
amount entry field is the source account’s currency; the converted 
amount’s currency is always the destination account’s currency. And the 
exchange rate you specify should be the rate from the source account's 
currency to that of the destination account's. The above picture shows 
the user is transferring $90,000 from a USD account to a HK$ account, 
so the rate from USD to HK$ is set to 7.82 for this transaction. 

 Modifying and Duplicating Transactions 

To duplicate a transaction, you can tap on the transaction while you’re 
in either Transaction Log or Account Register view. The Transaction 
dialog box that we’ve just seen will come up, and attributes of the 
transaction that’s tapped on will be placed in the dialog box. But this 
time, it has a few more different buttons: 

 

Tapping on the Modify button will make any changes you made in this 
dialog box replace the information in the database. To duplicate this 
transaction, just tap on the Dup button. The dialog box will turn into the 
one we just saw in the “Creating Transactions” section. All the 
transaction’s attributes are still there with only the date is changed to 
today’s date. And the buttons at the bottom will have OK and Cancel only. 
Tapping on the OK button will insert a new transaction into the database. 
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 Deleting Transactions 

To delete one transaction, you can tap on the transaction while you’re in 
either Transaction Log or Account Register view. The Transaction dialog 
box that we’ve just seen will come up. Usually you use this dialog box to 
edit its contents, but there is a Del button in the dialog box can be used 
to delete it.  

If you want to delete a range of transactions, you can use the Delete 
command from the Data menu. This command allows the user to delete 
transactions within a current date range: 

 

Besides specifying a date range, there is an option Adjust opening 
balances in the dialog box, this option is useful only when the date range 
is early enough that the earliest transactions of accounts would be 
deleted. In this case, if this option is checked, Money would adjust 
accounts’ opening balances such that the ending balances remain the 
same. This is best understood by the following example: 

 

In this example, account Checking has an opening balance of $300.00, 
and the earliest entry in the database is June 23, 2003. If we delete 
transactions in the range from June 1 through July 31, 2003, the 
following picture on the left shows the situation when Adjust account 
balances option is enabled; the picture on the right is without this option: 
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Comparing these three pictures you’ll find that the balances (the 
rightmost column) in the picture on the left are not changed after 
deletion, whereas in the picture on the right, all balances are changed 
after deletion. What can not be directly seen from these pictures is the 
opening balance of the Checking account is changed from $300 to 
$620.80, which “happens to be” the ending balance on July 31 before 
deletion. 

 Transaction Log View 

Transaction Log view is one of the eleven built-in views. This view is like 
a logbook that shows everything you did in every detail. Unlike the 
Account Register view, the Transaction Log view lists transactions from 
all accounts, no matter which accounts they are of. Therefore, 
Transaction Log is particularly useful for you to get to know all your 
financial activities. 

By default, you can use Graffiti or hardware keyboard to enter the Quick 
Access Key ‘t’ to switch to this view.  

 

Unrealized and upcoming scheduled transactions will also be shown in 
this view. Unrealized transaction will show a letter “U” in the status 
column; upcoming scheduled transactions will have a letter “S”. They 
both are shown on pink background. But you have to enable this feature 
by checking the Show future transactions option from the Display group 
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in the Preferences dialog box. For more details, please refer to the 
“Unrealized Transaction” section. 

  Tapping on Rows  

Tapping on a row in the table (except on the Status column) will bring 
up the Transaction dialog box. This allows you to modify the transaction 
details. But if the transaction tapped on is a Transfer In transaction, then 
the Change Amount dialog box will come up.  

  Columns in the Table  

 Status – transaction status. You can tap on this column to change a 
transaction’s status. If you changed a sub-transaction’s status, the 
main transaction’s status will change too. 

Transactions whose Status fields show a letter “S” are upcoming 
scheduled transactions. Based on what you’ve set up for scheduled 
transactions, these are the transactions that are about to happen in 
the coming days, but haven’t happened yet.  

A letter “U” indicates that this transaction is an unrealized 
transaction. 

 Date – transaction date. 

 Category – the Category name of the transaction. You can use the 
Preferences command to control whether the full category name 
(such as “Auto: Fuel”) or just the subcategory name (such as “Fuel”) 
is displayed in this column. If the transaction is not assigned with a 
category, this column will be left empty. If the transaction is a Split 
Transaction,  this column shows --Split--. If the transaction is a 
Transfer Out transaction, the destination account name is displayed 
between a pair of square parentheses, such as [Checking], and the 
amount will be negative. If this is a Transfer In transaction, the 
source account’s name is shown, and the amount is positive. 

 Amount – amount of the transaction. Negative amounts are 
displayed in red. You can use the Preferences command to control if 
and how currency symbols are displayed. 

 Account – account name of the transaction. If the transaction is a 
deposit or withdrawal, this is the account where the money goes to 
or comes from. If this is a Transfer Out transaction, this column 
shows the source account; if it’s a Transfer In, it shows the 
destination account. 
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 Payee – Payee of the transaction, it’s empty if there is no a payee 
assigned or if the transaction is a Transfer transaction. 

 Class – Class of the transaction, it’s empty if there is no a class 
assigned. If the transaction is a Split Transaction, it shows --Split--. 

 Scheduled – if the transaction is inserted because of a Scheduled 
Transaction, the name of the Scheduled Transaction is displayed in 
this column. 

 Check Number – the check number of the check used in this 
transaction. It’s empty if it does not involve a check. 

 Original Amount – if the transaction involves different currencies, 
this column shows the original amount before conversion. 

 Exchange Rate – if the transaction involves different currencies, this 
column shows the exchange rate used. 

 Note Text – note of the transaction. 

 Note Icon –a note icon if the transaction has note text attached with 
it. You can tap on a note icon to bring up a little text box to show the 
first four lines of the note. 

  Footnote  

Below the table is a color box showing the summary of transactions 
currently in view, i.e., transactions which are within the current date 
range and satisfy the filter test, if there is one. 

 

You can tap on this color box to select what information is to be 
displayed here: 

  

IMPORTANT: The way how Money calculates income and expenses is 
based on a transaction’s Category type, not on its Transaction Type. For 
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a detailed discussion on the differences between Category Type, 
Transaction Type, and incomes and expenses, please refer to the section 
of  “Income/Expense vs. Deposit/Withdrawal”. 

If there are unrealized or upcoming scheduled transactions showing in 
the table, they will not be included in the calculation of these numbers. 

The Color command is used to change the background color of the color 
box. 

 Split Transactions 

Supposedly each transaction you make appears on your bank statement 
as one entry. This one-transaction-one-entry correspondence is 
important if you want to keep your database consistent with bank 
statements. 

But sometimes a transaction has multiple purposes. For example, you 
bought a lot of things in a supermarket. At the checkout, the total 
amount was $100. On the bank statement, this is one single transaction. 
But actually you bought a lot of things for different purposes, e.g., $30 
for clothing, $50 for grocery, and $20 for video rental.  

To have a better idea of what the money was spent for, you may want to 
clearly identify all the different purposes, but you don’t want to create 
multiple transactions in the database because that would break the one-
to-one correspondence. This is when Split Transactions come in handy. 

  Sub-Transactions  

A Split Transaction is a transaction that can be viewed as a collection of 
multiple sub-transactions. Each of these sub-transactions can have its 
own amount, category, and class. In the example above, you can create a 
main transaction of amount $100 with 3 sub-transactions: $30 on 
Clothing category, $20 on Video Rental category, and $50 on Grocery 
category. 

To enter a Split Transaction, select the– Split – command from the 
Category list in the Transaction dialog box. When selected, the following 
Split Transaction dialog box appears: 
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To enter a new sub-transaction, first enter the amount, category and 
class, then tap on the Add button. To modify an existing sub-transaction, 
first tap on a sub-transaction from the table below the three buttons, 
Money will put its values in the fields above. Then you make the 
necessary changes to those values, and tap on the Change button, the 
sub-transaction in the table will be updated. To delete a sub-transaction, 
tap on it from the table and then tap on the Delete button. 

Note that although there is a sign button in front of the amount field, 
but in most cases the amounts you enter are positive values. Only in rare 
cases would you need to enter negative values, you can refer to the 
“Paychecks” section for an example of negative sub-transaction 
amounts. (In case you’re wondering, why there is no a sign button for 
the amount field in the Transaction dialog box? Because it doesn’t 
accept negative numbers. Why? Because in that dialog box, you always 
enter positive numbers and the sign of the amount is automatically 
determined by the transaction type – deposit or withdrawal.) 

If the sub-transaction is a transfer, you can use the – Show Accounts – 
command from the category list so that the category list is replaced with 
the list of accounts. Similarly, you can use the – Show Categories – 
command from the account list to show categories. 

The last three rows in the table tells you the current total of all sub-
transactions (the Total Splits row), the amount of the main transaction 
(the Transaction row) , and the difference between the two (the Difference 
row). When you’re done, tap on the OK button, the amount of the main 
transaction will automatically be updated to the total of all sub-
transactions. Note that the Difference and Transaction rows do not 
appear if you did not enter an amount in the main transaction dialog 
box or if the amount was zero. 

Similarly, you can edit the Category list and Class list from this dialog 
box. 
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  Transfer Sub-Transactions  

Sometimes a sub-transaction can be a transfer transaction. For example, 
if at the supermarket checkout you asked for a cash back2 of $20, then 
this is a transfer sub-transaction of $20 from your checking account to 
your cash account.  

To enter a transfer sub-transaction, choose the –Show Accounts– 
command from the Category list. After choosing this command, the 
Category list becomes Account list, then you can choose the destination 
account from this list. To change back to the Category list, just select the 
–Show Categories— command and the list changes back to the Category 
list. 

When inserting a main transaction into the database, if it contains one 
or more transfer sub-transactions, then one ore more Transfer In 
transactions will be created at the same time. In the Transaction Log 
view or the Account Register view, these transfer sub-transactions are 
shown in separate rows. Using the example above, inserting the $120-
transaction will create two entries in the database: 

 

The Category column in the second row shows [Checking] and the 
amount is a positive number, this indicates it’s a Transfer In transaction 
from the Checking account. 

 Unrealized Transactions 

Unrealized transactions are a special kind of transactions. They are like 
scheduled transactions in that they haven’t happened yet; but they do 
not repeat, they happen only once. For example, if you owe somebody 
some money, you are supposed to return the money some time in the 
future. You can enter an unrealized transaction in Money as a reminder 
for yourself.  

To enter an unrealized transaction, just set the transaction’s status to 
“Unrealized”, everything else is the same as ordinary ones. The date of 

                                                            
2 Cash back is a common type of transactions in some countries. This is how it works: In such 
countries, ATM cards can be used to buy things in the same was as credit cards can, but your 
bank account is debited directly. When doing so, you can not only use the ATM card to pay for 
the things you buy, you can also ask the cashier to give you some cash. This is like buying things 
and withdrawing cash from an ATM machine at the same time. 
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an unrealized transaction does not have to be in the future; it can be any 
point in time. Later when it's actually realized (like you returned the 
money), you can change its date and its status to Posted to reflect what 
has actually happened. 

Unrealized transactions have the following characteristics: 

1. When Money calculates income and expense, unrealized 
transactions are not included whatsoever. When calculating ending 
balances, they are not included either. 

2. In Account Register and Transaction Log views, their status column 
shows a letter “U” and shaded in pink color. You can make 
unrealized transactions show or hide in these two views by checking 
or unchecking the Show future transactions option under the Display 
group in the Preferences dialog box. 

 

In the Preferences dialog box, you can also decide how far into the 
future should such transactions be displayed. For example, you can 
choose the End of year option so that unrealized transactions within 
the range from the beginning of the selected date range to the end of 
the year will be displayed in the Account Register and Transaction 
Log view. 

When in the Account Register view, you will see the running balance 
(shown in the Balance column) is affected by unrealized transactions. 
But the ending balance shown in the footnote is not affected by 
unrealized transactions. 
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3. In the Cash Flow view, you can make unrealized transactions be 
included or not included in the chart by checking or unchecking the 
Show future transactions in Cash Flow's Chart Range dialog box. 

 

 Paychecks 

Paychecks is one of the most commonly used transactions that use split 
transactions. In this section we will use paycheck transactions to 
exemplify how and when to use split transactions. 

Assuming you receive your salary on the 5th or every month. The 
company pays you a total of $3,000, but not all of this $3,000 goes into 
your pocket, there are lots of deductions. For example: 

 $100 pays for the group insurance, 

 $200 is for your income tax withholding,  

 $300 is deposited into your retirement account (e.g. 401k in the 
United States),  

 $1,000 goes directly to a savings account so that you can enjoy a 
higher interest rate, 

 and the rest goes to your checking account for daily use. 

To enter this paycheck, first create a transaction like following: 

 

In the above picture, this transaction is set to be a deposit transaction 
into account Checking. The payee “XYZ Corp” is the company you work 
for. Leave the amount empty. Then select the ---Split--- command from 
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the category list, you will be brought to the Split Transaction dialog box 
we have discussed in the previous section. Enter the following 5 sub-
transactions, see following: 

 

In this dialog box,  

 The first sub-transaction is your monthly salary, $3,000. Its category 
should be set to Salary. 

 Although this is a deposit transaction, but the insurance $200 goes in 
another direction – out of the Checking account, so we should use a 
negative value -$200 here. And its category is set to Medical 
Insurance. (You will receive a reminding message when entering this 
sub-transaction, but it’s just a friendly reminder. Don’t worry.) 

 Similarly, the tax withholding is also a negative value, and the 
category is Tax. 

 The $300 investment on your retirement is a transfer from the 
Checking account to the Retirement account. It’s also a negative 
value. 

After you have entered the above transaction, you will see the following 
results: a deposit of $1,400 into your Checking account; a $300 deposit 
into your Retirement account; a $1,000 deposit into your Savings 
account. And if you go to the Categories/Budget view, you will see that 
you have spent $100 on insurance, $200 on paying taxes, and your total 
income is $3,000. 
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 Income/Expense vs. Deposit/Withdrawal 

Each category in Money has a type: Income or Expense; each 
transaction in Money also has a type: Deposit or Withdrawal. Although 
income/expense and deposit/withdrawal seem to be the same thing at 
first, but they are not. Let’s see how they are different: 

Let’s say you bought a digital camera at $500, which comes with a $50 
mail-in rebate3. To record this transaction, you entered a withdrawal 
transaction of amount $500 and put it into an expense category 
“Hobbies”. Then you sent in the mail-in rebate and after eight weeks, 
you got a $50 check back from the manufacturer. After you have 
deposited the check into your bank, you’d want to record this deposit 
into Money too. But the question is: How?  

You can have two choices: Go back and modify the original transaction 
to make it become $450. This is straightforward, but the only problem is 
it doesn’t match with the bank statement. To your bank, there are two 
transactions, one is $500 withdrawal and one is $50 deposit. In order to 
make Money’s database match with your bank statement, you’d better 
enter another transaction for this $50 check. This time you should enter 
a deposit transaction using the same Hobbies expense category.  
Although it’s a deposit, but it should be categorized as an expense. Why? 
Because this $50 is not your income, it’s just a reduction in your expense. 
Therefore you still put it under the original expense category even 
though it’s a deposit.  

                                                            
3 Mail-in rebates are a way of sales practice in some markets. This is how it works: When you 
buy something, you pay the full price, say $500. But at the same time you’re given a mail-in 
rebate form. You just fill out that form and send it to the manufacturer, they will return you part 
of the money, say $50. So what you actually paid is just $450.  Some manufacturers prefer mail-
in rebates to direct price cuts for 1. cutting prices can sometimes lead to negative impressions, 2. 
some people (like me) always forget sending back the rebate forms or even cashing the checks! 
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(If this is still not clear, let’s put it this way: You’re supposed to pay 
income taxes for whatever you’ve earned, right? But do you think you 
should pay taxes for that 50 bucks? “Hell, no! It’s not my income, it’s a 
reduction in expense!”, you’d scream. Yes, you’re right, and I’m sure 
now you get it.) 

For this reason, when Money calculates income and expenses, it always 
calculates based on a transaction's category instead of its type (Deposit, 
or Withdrawal). For more details on how Money determines your 
income and expense, please see the next section. 

 Calculation of Income and Expense 

There are many places in Money that displays your income and expense, 
such as Transaction Log, Payees, Trend, and Categories views. This 
section explains the rules based on which Money obtains the numbers. 

  Categories  

As explained in the last section, income and expense are not the same as 
deposit and withdrawal. Money calculates income and expense based 
on the category a transaction belongs to: If a transaction’s category is an 
expense category, then its amount is added to expense; otherwise, it’s 
added to income. If a transaction’s category is <Unassigned>, then it’s 
an expense if it’s a withdraw transactions; income if it’s a deposit 
transaction. 

This simple rule applies to sub-transactions too. But because transfer 
transactions do not have categories, so this rule does not apply to them. 

  Excluded Transactions  

However, you can override the above rule for individual transactions by 
assigning a transaction to be excluded from the calculation of income 
and expense. When creating or modifying a transaction, you can set the 
“Excluded” flag to Yes, see the picture below. 
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When set, no matter which category it belongs to, no matter if it’s a 
withdrawal, deposit, or transfer transaction, it will never be counted as 
either income or expense; it’s simply neutral. Other than this 
characteristic, all other operations on excluded transactions are still the 
same as ordinary ones. 

For example, you found that the money left in your pocket is somehow 
less than what the Cash account’s balance is. You don’t remember 
where did you spend the money, or if it’s lost somewhere, or even worse, 
stolen! But you don’t care, you don’t want to find out and you don’t 
want to count it as an expense. So you can enter a withdraw transaction 
to make up the difference in balance, and mark it as Excluded. 

Using excluded transaction is easy, but one should use this feature with 
great care. If used abusively, you may find the status of your income and 
expense is out of balance – large income is missing and all. 

To make it easier for you to compare the before and after, there is an 
option Include excluded transactions in the Preferences dialog box that 
lets you disable or enable this feature. Once disabled (uncheck this 
option), all excluded transactions will be just like the ordinary ones 
whose amounts are included in the calculation of income and expense. 

 

  Transfers  

As mentioned earlier, transfers don’t have categories; therefore transfer 
transactions are not counted in as income or expense. But, there can be 
exceptions. One common example why transfers should be calculated is 
like this: You have a mortgage on your house. Every month you transfer 
some money from your checking account to your mortgage account to 
make the monthly payment. Although your net worth is not changed by 
these transfers, but you most likely would like to count these transfers as 
your monthly expenses.  

To do so, you should go to the mortgage account’s account definition 
dialog box.  There is a Transfers setting. 
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You can select from one of the three options for this setting:  

Are not included – transfers into and out from this account should not be 
counted in as income or expense. Usually accounts of types Cash, Bank, 
and Credit Card should use this option. 

Transfer-ins are expenses – transfers into this account should be treated 
as expenses. In the example we mentioned above, you should choose 
this option.  Conversely, transfers out from this account are treated as 
reduction in expense.  Usually this option is suitable for liability 
accounts like mortgage, car financing, or other types of loans. 

Following is an example of the use of this feature. Assuming you have a 
Mortgage account and it’s been set up to Transfer-ins are expenses. You 
can enter a transfer from Checking to Mortgage account of amount 
$2,300 as its monthly payment, see the picture on the left. Then in the 
Categories view, you will see a special category [Mortgage] in the 
Expense section that has this transfer as an expense. Similarly, this 
$2,300 will be shown as expense in other views. 

     

Transfer-outs are incomes – transfers out from this account will be 
counted in as incomes. Conversely, transfers into this account are 
treated as reduction in income.  For example, you have an asset account 
for your baseball card collections, the balance should be a positive 
number. When you sold some of the cards, you can use a transfer 
transaction from this asset account to your cash account. This transfer 
will be counted in as your income. 
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  Options for Transfers  

In the Preferences dialog box there are also a few options for enabling 
and disabling the inclusion of transfer transactions, see the picture 
below. 

 

In this dialog box, if you uncheck the Include transfers to or from, then 
none of the transfers will be counted in when calculating income and 
expense, no matter what you have set in the account definition. 
Following is the picture showing what the Categories view will look like 
when this option is unchecked. As can be seen, the [Mortgage] item is 
not present in the picture. 

 

If you have checked the Include transfers to or from option AND the All 
accounts option, then transfers to or from ALL accounts that have been 
properly setup (i.e., accounts that are either Transfer-ins are income or 
Transfers-outs are expense) will be included in the calculation.  

If what you checked is Accounts not in the filter option, then only 
transfers to or from accounts that are not in the filter currently in use are 
included. For example, if the filter in use is “(Account=Checking or Cash) 
and Payee=Chase Manhattan”, then the account Mortgage is not in the 
filter. Therefore transfers into this account will be included as an 
expense. If your filter is “Account=Checking or Cash or Mortgage) and 
Payee = Chase Manhattan”, then because Mortgage is in the filter, so the 
$2,300 transfer will not be included.  
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The idea of using a filter is like this: If you used the filter to select part of 
the accounts, then these accounts are like a small group. Transfers 
within this group are just money going from one pocket to another, they 
are not included in the calculation of income or expense; only transfers 
going out of this group are.  

  Excluded Transactions and Transfers  

Transfer transactions can also be set to Excluded. Once set, this transfer 
will never be included when calculating income or expense no matter 
how the transfer options or filter are, unless the Include excluded 
transactions option is not checked. In another word, the Include excluded 
transactions option has higher precedence than the transfer options. 

  Unrealized Transactions  

Unrealized transactions are never included in the calculation of income 
and expense whatsoever. 

 Transferring Between Different Currencies 

When you transfer money from one account to another which is of a 
different currency type, Money automatically calculates the amount 
received according to the exchange rate you set up in the Currency list.  

For example, the exchange rate of U.S. Dollar to Japanese Yen is 1.00 to 
112. So when you enter a transaction of transferring $100 to a Japanese 
Yen account, Money automatically creates two transactions in the 
database: one is the $100 Transfer Out transaction, and the other is a 
¥11,200 Transfer In transaction. 

However, 99.99% of the chances are the bank’s selling rate is different 
from what you have in your Palm. Usually it’s lower (can’t blame them, 
this is how they make money), say, 1.00 to 110. So your Japanese Yen 
account actually received ¥11,000, which is different from what Money 
expected. 

To avoid this discrepancy, you can have two choices. One is you enter 
the bank’s rate before entering the transaction into Money. If you forgot 
of if you do not wish to change the rate, then after you have entered the 
transaction, you can go to either the Transaction Log view or the 
Account Register view, tap on the Transfer In transaction in the table 
(the second row in the following picture). 
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You will be brought to the Change Amount dialog box: 

 

This dialog box lets you change only the amount of a Transfer In 
transaction, nothing else. You can see the currency symbol of the 
destination account is showing in the dialog box. Here you can change it 
to ¥11,000 to reflect the true amount of the transaction. Or, you can tap 
on the Go To button to modify the main transaction if you want. 
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Lists 

Other than transactions, Adarian Money™ also needs some other information in order 
to effectively manage money. Because these information exist in the form of lists, so we 
sometimes collectively call them “lists.” Lists in Money include the list for accounts, 
categories, payees, classes, scheduled transactions, and currencies. All list-related 
commands are conveniently centralized in one place: the Lists menu. Everything you 
need to manipulate them can be found in this menu: 

 

In this chapter, we will examine how to define three of the six lists – payees, classes, 
and currencies. The rest of the three lists will be explained in their respective chapters: 
Accounts list will be covered in the “Managing Accounts” chapter; categories in 
“Categories and Budgets”, and scheduled transactions in “Scheduled Transactions”. 

 

 List Editing Dialog Box 

No matter which list you chose from the Lists menu, you’ll first see a list 
editing dialog box that looks like this: 

 

This dialog box is common to all lists, same layout, same buttons. In fact, 
only three things are different in this dialog box for different lists: the 
dialog box title, the items in the list, and the description text (between 

 Page 60 of 171 



Adarian Money™ for Palm OS® User’s Manual  © 2003-2006, Adarian Software, LLC 

the list and the OK/Cancel buttons) for the selected item. From this 
dialog box, you can create new items, edit existing items, or delete items. 
When you tap on the New or Edit button, you’ll be brought to a list-
specific dialog box to define the actual details of a list item. Because the 
use of the list editing dialog box is pretty straightforward, we won’t 
spend much time here.  

 Defining Payees 

A payee is the party who receives your money, or pays you money. It is 
useful to assign payees to transactions to further describe what the 
money was for. For example, you may use a category “Auto: Fuel” for all 
fuel expenses, in addition to that, you can use the Payee field to record if 
it was a Chevron, 76, or Texaco gas station. Money can summarize your 
transactions according to the payees. To get a summary on how much 
was spent on or received from a payee, you can go to the Payees view. 

Following is the dialog box that’s used to define/edit a payee: 

 

There are only two things to enter about a payee: a name and an 
optional note. You can use the note field to keep some additional 
information about a payee, for example, the telephone number of a dry 
cleaning shop. The maximum length for payee’s name is 31 bytes; the 
maximum length for note is almost 64K. 

 Purge Payees Command 

After using Money for a while, you will probably find that the list of 
payees gets very long because every time you spend money at a new 
place, a new name gets added into the list. A long list of payees can not 
only bring overhead to the processing time of Money, but also make 
selecting an item from the list difficult. At this time, you may want to 
delete a few payees that are not active any more, e.g., a coffee shop that 
you no longer go to, or a hotel you stayed in during vacation but most 
likely won’t go there again. To let you easily remove such inactive payees 
from the list, Money supports the Purge Payees command that’s housed 
in the List menu.  

Select this command and the following dialog box will appear: 
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You can filter inactive payees by one of two ways: The last date that a 
payee was used, or the total number of uses of a payee. No matter which 
criterion you choose, you can optionally preserve payees that are used 
in scheduled transactions or unrealized transactions. And after deletion, 
you can let Money keep the deleted payee’s name in the note field of the 
transaction. Then tap on the Next button and the following dialog box 
will appear: 

 

Here you can preview and select the payees you want to delete. The 
column on the right shows the last date this payee was used, if Not used 
since option was selected in the previous dialog box; or the total number 
of uses if Used less than option was selected. 

 Defining Classes 

Class is another way of categorizing your incomes/expenses. For 
example, you can have a class “Business” and another class “Personal”. 
You can use these two classes to differentiate money spent for business 
or personal purposes.  

Following is the dialog box to define a class: 
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There are only two things to define about a class: a name and an 
optional note. The maximum length for class’s name is 31 bytes; the 
maximum length for note is almost 64K. 

 Defining Currencies 

Following is the currency definition dialog box: 

 

Name is the name of the currency, Currency symbol is the symbol used 
when displaying amounts of this currency. You can leave this field 
empty so that no symbols are displayed. (You can also control whether 
or not currency symbols should be displayed from the Preferences 
dialog box.) The Symbol after digits checkbox is used when you wish the 
currency symbol to be displayed after the amount, e.g., 300.00€.  

You can choose how many digits to be displayed after the decimal point 
by entering a number between 0 and 2 in the No  of decimal digits field. 
For example 1.00, or 1.0, or just 1. For example, Japanese Yen and New 
Taiwan Dollar don’t use decimal digits, whereas U.S. Dollar and Euro 
have two. 

.

To define the exchange rate, you can use either the home currency or 
the currency being defined as the basis, whichever is convenient for you. 
You can use the Swap button to toggle between this. For example, if your 
home currency is Japanese Yen, to enter the exchange rate for Euro, you 
can use either of the following: 
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Managing Accounts 

In this chapter we will introduce you how to manage your accounts in Adarian 

Money™. Before we begin, you need to know what the different terms about balances 
mean. 

Money provides you with two built-in views to manage your accounts. The Account 
Register view shows all transactions made from an account, this view is best for 
comparing with bank statements. Accounts List view gives a list of all your accounts 
and a brief summary of them, this is best for having a bird’s eye view of what’s going on. 

There are two menu commands designed exclusively for managing accounts, available 
only when you’re in the Account Register view. The Reconcile command is for making 
sure the data in Money database matches with the bank statement. The Adjust Balance 
lets you easily adjust an account’s balance if there is a discrepancy. 

In the Overdraft Alerts section, we will show you how Money can help you in 
preventing overdrafts from happening, and thus saves you the costly bank charges. 

 Balances 

Balance is how much money you have left available in a bank account, 
or how much you have debited from a credit card account. Money uses 
several different kinds of balances and terms, it’s important for you to 
understand what do they mean. 

 Opening Balance – how much credit (or debit) you have on an 
account before the account’s earliest transaction was made.  

In the following picture, we switch to the Account Register view to 
show transactions from a Checking account. The first row (dated 6/20) 
shows the earliest transaction4 from that account. This transaction is 
a withdrawal of $267.30 from the Checking account. After the money 
was withdrawn, there is still $132.70 left in the account. Although 
you can’t tell the account’s opening balance from the screen shot, 

                                                            
4 How do you know it’s the earliest transaction? Notice the date range is set to All Dates, and the 
scroll bar is at the top. That tells you it’s the earliest. 
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but it’s easy to figure out there must be an opening balance of 
$400.00. 

 

Note that when we say “the earliest” transaction, it means the 
earliest in Money’s database. It’s very possible that you opened the 
account 10 years ago, but you started using Money just yesterday. In 
this case, to Money, the account’s opening balance is the balance 
before yesterday. 

 Beginning Balance – the balance at the beginning of a given date 
range.  

Along the same example, the following picture shows transactions of 
the same Checking account in the range of July 2003. 

 

From this picture, you can tell that the beginning balance for July 
2003 is $172.49 - $110.79 = $61.70.  (Actually, you can tell from the 
first picture that the balance after the 6/26 transaction is $61.70. This 
number is exactly the beginning balance of July, and also the ending 
balance of June.) 

 Ending Balance – the balance at the end of a given date range.  

From the above picture, the date range is set to July 2003, and the 
balance after the last transaction within this range is $649.80. This is 
the ending balance of the Checking account in the period of July 
2003. 
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 Posted Balance vs. Cleared Balance – Posted balance is the balance 
(beginning or ending) calculated by counting in all transactions 
regardless of their transaction status. Cleared balance is calculated 
by counting in only Cleared and Reconciled transactions.  

By the definition given above, there are supposed to be posted 
beginning balance, cleared beginning balance, posted ending balance, 
and cleared ending balance. Sounds pretty complicated, right? 

Just for the sake of discussion, let’s try to find out what’s the posted 
beginning balance for July 2003 using the same data as we’ve used 
earlier. This time in order to show more transactions, we set the date 
range to be from 6/1/3003 to 7/31/2003. See the picture below: 

 

(Columns marked with a letter ‘C’ in the first column are Cleared 
transactions; ‘R’ for Reconciled transaction; blanks for posted 
transactions.) 

As explained, posted balance counts in all transactions regardless of 
their status. So to calculate the posted beginning balance for July, 
you need to count in all transactions in June. That is: 

$400.00 (the opening balance) - $267.30 - $71.00 = $61.70.  

Now let’s try to obtain the cleared beginning balance. Remember, 
only Cleared and Reconciled transactions count. Therefore, the 
calculation becomes: 

$400.00  - $71.00 = $329.00.  

Note that the $267.30-transaction is left out this time. $329.00 is both 
the cleared beginning balance for July 2003 and the cleared ending 
balance for June 2003. 

Next let’s try to obtain the cleared ending balance for July 2003. The 
calculation is like following: 

$400.00 - $71.00 + $110.79 - $149.48 + $54.9 = $345.21. 

 Page 66 of 171 



Adarian Money™ for Palm OS® User’s Manual  © 2003-2006, Adarian Software, LLC 

As you can see, only “C” and “R” transactions are counted. 

  Unrealized and Upcoming Scheduled Transactions  

In the Account Register view, unrealized transaction and upcoming 
scheduled transactions can optionally be shown in the table, if the 
option is set in the Preferences dialog box, see the following picture: 

 

When they do, they will affect the running balance in the table, but 
will not affect the ending and cleared balances shown in the footnote 
area. Take following two pictures for an example, the one on the left 
shows when unrealized transactions are made hidden, the right one 
is when they’re showing. As can be seen, the running balance (the 
rightmost column) changes when the -$51.2 unrealized transaction 
(shaded in pink color) is showing, but the ending balance (shown in 
the footnote) is always -$945.75. 

     

(In the above picture, although the two transactions dated 9/16 are 
on a future date, but their status is set to Posted. This is allowed – 
you can enter a transaction in a future date but don’t have to set its 
status to Unrealized. Therefore they don’t have a “U” and are not 
shaded.) 

  Balances in Adarian Money™  

Because of the limited screen space, Money has to make some 
simplifications when displaying names. Following is how Money 
displays all these different balances’ names: 
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The terms Opening or Opening Balance stand for opening balances. 
There is no such thing as posted or cleared opening balances; 
Opening balances are always considered as cleared in Money. 

Whenever you see the terms Begin, Beginning, or Beginning Balance, 
they always stand for posted beginning balances – all transactions 
count. Money never calculates or displays cleared beginning 
balances. 

Whenever you see the terms End, Ending, or Ending Balance, they 
stand for posted ending balances. 

On the other hand, the terms Cleared or Cleared Balance, they are 
cleared ending balances. 

 Defining Accounts 

To define or modify an account’s definition, you can select the Accounts 
command from the Lists menu. From the list editing dialog box you can 
tap on the New or Edit button to get to the following dialog box: 

 

 Name – name of the account, max. 31 bytes. 

 Currency –  currency type of the account. When a transaction is saved 
into database, its amount is always automatically converted to the 
currency of the transaction’s account. Currency type is not allowed 
to be changed when modifying an existing account. 

 Type – type of the account, it can be either one of the following: Bank 
(such as checking and savings accounts), Credit card, Cash (usually 
the money you kept in your pocket or a cash box), Asset, and Liability. 
Money’s main program actually does not distinguish among account 
types, you can choose whatever you want and won’t affect Money’s 
operations at all. They are useful only when exporting account 
information to Quicken or Microsoft Money. These software may 
behave differently on different types of accounts. Please see the 
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“Import and Export” chapter for more details on exporting 
information. 

 Transfers – this option specifies how transfer transactions to or from 
this account will be treated when calculating income and expense. 
For details on how Money obtains income and expense and how this 
option affects the calculation, please refer to the “Calculation of 
Income and Expense” section. 

 Opening balance  – opening balance of the account. For checking, 
savings, or cash accounts, this number should be a positive number 
or zero; for credit cards, this should be a negative number or zero. 

 Account limit – In some countries, banks set a minimum balance 
requirement on accounts. If your balance is lower than that, they will 
charge you for some fees5. Or, in all countries this time, credit cards 
have credit limits. If you go over that limit, bad things can happen. In 
these cases, you should enter the minimum balance requirement or 
credit limit into this field.  For the former, this number should be a 
positive number; for the latter, this should be a negative number. 

 Alert when – Money will give alerts when your balance is about to be 
over or below the amount set in this field. For example, your credit 
limit is -$100,000, you can set an alert level at -$95,000. Whenever 
you’re over -$95,000, Money will remind you that you should be 
careful. Please see the Overdraft Alerts section for more details. 

Therefore the alert level should be set close to the limit but not over 
it. And it should have the same sign as the Account limit. If these 
conditions are not met, Money will issue a message to ask you to 
confirm: 

 

                                                            
5 I never understand this. They charge you “account maintenance fee” if the balance is lower 
than a limit they set. But what’s there to “maintain?” It’s just a few bytes in their computers for 
crying out loud! What’s there to maintain? Besides, how dare they fine me because I didn’t put 
enough money in their pocket??? When I grow up I’ll open a bank too. And I won’t fine people, 
I’d say “thank you” to all who put their money in my pocket. 
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Money automatically checks for overdraft  or over-limit  conditions 
when  you create or modify a transaction. You can also use the Check 
Balances command from the Data menu to check account balances. 

If you don’t want Money to check the balance for an account, you 
can just leave the this field empty or enter a 0. 

 Next check # -- the number of the next available check. This number 
is useful in the Check # field in the Transaction dialog box. When  you 
use the stylus to tap on that field in the Transaction dialog box, the 
next available check number you entered here will automatically be 
filled in there. 

 Account Groups 

In Cash Flow and Accounts List views, you can group accounts together 
in order to view combined balances of several accounts at a time. This is 
called Account Groups. In the Cash Flow view, Money displays the 
combined daily ending balances in an area chart; in Accounts List view, 
only accounts in the selected group are displayed, and their combined 
ending balance is displayed. 

An account can be in more than one group, for example, AMEX account 
can belong to a group called “All credit cards”, and at the same time, it 
can belong to another group called “All US$ credit cards.” 

To define or edit account groups, go to either Cash Flow or Accounts List 
view. On the upper-right part of the screen, there is an account selection 
pull-down list. In that list, there is a command called Edit Groups. Select 
this command and you will be brought to the familiar list editing dialog 
box. From there, you can tap on the New button to create a new group, 
or use the Edit button to modify an existing group.  

Defining or modifying an account group is easy, just select the accounts 
you want and give the group a name then you’re done. 
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 Deleting Accounts 

You can delete accounts from the list editing dialog box just like any 
other lists. But unlike others, deleting accounts have a very important 
consequence that you have to know: 

When you delete an account, all transactions from that account will be 
deleted too! 

For simple deposit or withdrawal transactions, they are simply deleted 
and that’s all. But for transfer transactions whose source or destination 
accounts are deleted, they will be changed to deposit and withdrawal 
transactions, respectively. 

Let’s take a look at an example. In the following pictures, the one on the 
left shows a transfer transaction of $100 from Checking account to Cash 
account. As explained in the “Transfer Sub-Transactions” section, the 
second row is a sub-transaction that’s part of this transfer transaction. 
Now if we deleted the Checking account (picture on the right), the first 
row is deleted because it belongs to the Checking account. The second 
row becomes a Deposit transaction of $100 into the Cash account, and 
its Category is set to “Unassigned”. 

     

If what we deleted is the Cash account, this time, as you can see from 
the pictures below, the transaction left is a Withdrawal transaction from 
the Checking account. And the category is also set to “Unassigned”. 

     

 Account Register View 

Account Register view is one of the eleven built-in views. Unlike the 
Transaction Log view, this view shows transactions from one account 
only. This is best when you want to compare Money’s data and bank 
statements.  

By default, you can use Graffiti or hardware keyboard to enter the Quick 
Access Key ‘r’ to switch to this view.  
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The range selector can be used to choose a date range; the New button 
can be used to create a new transaction. Beside the range selector, there 

is a pop-up list , you can use it to choose the account you want 
to see. 

Unrealized and upcoming scheduled transactions will also be shown in 
this view. Unrealized transaction will show a letter “U” in the status 
column; upcoming scheduled transactions will have a letter “S”. They 
both are shown on pink background. But you have to enable this feature 
by checking the Show future transactions option from the Display group 
in the Preferences dialog box. For more details, please refer to the 
“Unrealized Transaction” section. 

Note that the running balances shown in the table will be affected by 
unrealized and upcoming scheduled transactions, if they are enabled. 
But the ending balance shown in the footnote area will not be affecyed. 

  Tapping on Rows  

Tapping on a transaction in the table (except on the Status column) will 
bring up the Transaction dialog box. This allows you to modify the 
transaction details. But if the transaction tapped on is a Transfer In 
transaction, then the Change Amount dialog box will come up.  

If the row you tapped on shows ‘S’ in its Status column, this is an 
upcoming scheduled transaction. When tapped on, you will be able to 
execute it. 

  Columns in the Table  

 Status – transaction status. You can tap on this column to change a 
transaction’s status. If you changed a sub-transaction’s status, the 
main transaction’s status will change too. 

Transactions whose Status fields show a letter “S” are upcoming 
scheduled transactions. Based on what you’ve set up for scheduled 
transactions, these are the transactions that are about to happen in 
the coming days, but haven’t happened yet.  
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A letter “U” indicates that this transaction is an unrealized 
transaction

 Date – transaction date. 

 Category – the Category name of the transaction. You can use the 
Preferences command to control whether the full category name 
(such “Auto: Fuel”) or just the subcategory name (such as “Fuel”) is 
displayed in this column. If the transaction is not assigned with a 
category, this column will be left empty. If the transaction is a Split 
Transaction,  then this column shows the text  --Split--. If the 
transaction is a Transfer Out transaction, the destination account 
name is displayed between a pair of square parentheses, such as 
[Checking], and the amount will be negative. If this is a Transfer In 
transaction, the source account’s name is shown, and the amount is 
positive. 

 Amount – amount of the transaction. Negative amounts are 
displayed in red. You can use the Preferences command to control if 
and how currency symbols are to be displayed. 

 Balance – balance amount after this transaction is made. This 
number will not change for each transaction even if you used a filter 
to filter out a few transactions in the middle. Numbers shown here 
will be affected by unrealized and upcoming scheduled transactions, 
if they are made shown. 

 Payee – Payee of the transaction, it’s empty if there is no a payee 
assigned or if the transaction is a Transfer transaction. 

 Class – Class of the transaction, it’s empty if there is no a class 
assigned. If the transaction is a Split Transaction, then the text --
Split--  is shown. 

 Scheduled – if the transaction is inserted because of executing a 
scheduled transaction, the name of the scheduled transaction is 
displayed in this column. 

 Check Number – the check number of the check used in this 
transaction. It’s empty if it does not involve a check. 

 Original Amount – if the transaction involves different currencies, 
this column shows the original amount before conversion. 

 Exchange Rate – if the transaction involves different currencies, this 
column shows the exchange rate used. 

 Note Text – note of the transaction. 
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 Note Icon –a note icon if the transaction has note text attached with 
it. You can tap on a note icon to bring up a little text box to show the 
first four lines of the note. 

  Footnote  

Below the table is a color box showing the summary of all transactions 
currently in view, i.e., transactions which are within the current date 
range and satisfy the filter test, if there is one. 

     

 The footnote area will show different information when 
reconciling an account. Please refer to the Reconcile command 
for more details. 

You can tap on this color box to select what information is to be 
displayed in it. Beginning is the beginning balance for the current date 
range; Ending is the posted ending balance; Cleared is the cleared ending 
balance. Note that these balances are the balances for the “real” 
transactions; unrealized and upcoming scheduled transactions are not 
counted in. 

You can refer to the “Balances” section for a complete discussion on 
what these balances are.  

 These balances are not affected by the filter, if there is one.  

Deposit is the total amount of Deposit  transactions currently viewable in 
the table, excluding the ones that have been filtered out by the filter, if 
there is one; Withdrawal is the total mount of Withdrawal transactions.  
Transfer In is the amount of total transfers that come into this account. 
Transfer out is money that goes out. If there are unrealized or upcoming 
scheduled transactions showing in the table, their amounts will NOT be 
included. 

 These four amounts are affected by the filter, if there is one. 

The Color command is used to change the background color of the color 
box. 
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 Accounts List View 

Account List view is also one of the eleven built-in views. This view lists 
all accounts in Money’s database and their brief information. This is 
best used to have a glance of all your accounts’ status. 

By default, you can use Graffiti or hardware keyboard to enter the Quick 
Access Key ‘a’ to switch to this view.  

 

The range selector can be used to choose a date range; the New button 
can be used to create a new transaction. Beside the range selector, there 

is a pop-up list , you can use this list to choose the account you 
want. 

The Account Group pull-down list is used to select which accounts are 
to be displayed in the table. The amounts shown in the footnote are 
totaled from all accounts in the selected group. If the accounts have 
different currencies, home currency is used for amounts in the footnote; 
if they are of the same currency, then that currency is used. 

  Tapping on Rows  

When you tap on a row, Money will automatically jump to the Account 
Register view with the account you tapped on selected in the view. 

  Columns in the Table  

 Name – name of the account. 

 Begin – beginning balance of the account for the current date range. 
This amount is not affected by the filter, if there is one. 

 End – posted ending balance of the account for the current date 
range. This amount is not affected by the filter, if there is one. 
Ending balance is not affected by unrealized and upcoming 
scheduled transactions. 

 Cleared – cleared ending balance of the account for the current date 
range. This amount is not affected by the filter.  Cleared ending 
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balance is not affected by unrealized and upcoming scheduled 
transactions. 

 Open – opening balance of the account. 

 You can refer to the “Balances” section for details about all these 
balances used in this view. 

 Deposit – total amounts of Deposit transactions. This amount is 
affected by the filter. 

 Withdrawal – total amounts of Withdrawal transactions. This 
amount is affected by the filter. 

 Chk/d – total amount of check deposits made in the current date 
range.  

 # Chk/d –number of check deposit transactions made in the current 
date range. 

 Chk/w – total amount of check withdrawals made in the current 
date range. 

 #Chk/w – number of check withdrawals made in the current date 
range. 

 Note Text – note of the account. 

 Note Icon –a note icon if the account has note text attached with it. 
You can tap on a note icon to bring up a little text box to show the 
first four lines of the note. 

  Footnote  

Below the table is a color box showing the summary for all accounts 
showing in the table. 

         

You can tap on this color box to select what information is to be 
displayed in it. Beginning is the sum of all accounts' beginning balances 
for the current date range; Ending is the sum of all accounts' posted 
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ending balances; Cleared is the sum of all accounts' cleared ending 
balances. You can refer to the “Balances” section for a complete 
discussion on what these balances are.  

 These balances are not affected by the filter, if there is one. Nor 
will they be affected by unrealized or upcoming scheduled 
transactions. 

Deposit is the sum of all Deposit transactions of all accounts in the 
current date range. Withdrawal is the sum of all Withdrawal transactions 
of all accounts in the current date range. Xfer-in is the total transfer-in 
amount; Xfe -out is the total transfer-out amount. Net is the sum of these 
four values. These values are affected by the 

r
filter, if there is one. Nor are 

they affected by unrealized or upcoming scheduled transactions. 

The Color command is used to change the background color of the color 
box. 

 Adjust Balance Command 

This command is available only when you’re in the Account Register 
view or any custom view based on it. 

Sometimes you may find that the actual balance of an account doesn’t 
match with the data in Money’s database. For example the cash left 
available in your packet doesn’t match with the record in your Palm, 
and you just couldn’t remember where did it go. At this time, you can 
use the Adjust Balance command to force the balance to become the 
amount you want. 

First, switch to the Account Register view or a custom view based on that 
because this command is available only in this view. Then switch to the 
account that you want to adjust. Then select the Adjust Balance 
command from the Data menu. 

 

The first line in the dialog box shows the account you’re going to adjust. 
Enter the balance amount you want to set it to in the Balance field. 
Choose a date in the Date selector, the program will adjust the account 
so that the posted ending balance on the day you specified is exactly the 
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amount you entered. The two checkboxes at the bottom let you decide 
how to adjust it. You can either let Money change the account’s opening 
balance, or  you can let Money creates a new transaction with a proper 
amount. Let’s take a look at how these two options work. Assume 
following is how your Checking account looks like for the month of July 
2003: 

 

But you find from your bank that the actual balance is only $213.29 on 
July 31. There is a discrepancy. Either you don’t want to take the trouble 
to find out exactly why or you just can’t figure out why, anyway, you just 
decide to change the balance regardless the reason why. So you use the 
Adjust Balance command to change the opening balance for you. The 
results are shown on the right: 

         

Comparing the results on the right and the original records, you’ll find 
that the balance of each transaction is changed because the opening 
balance is changed. And of course now the ending balance is exactly 
what you entered in the dialog box.   

If you chose the Add a transaction option in the Adjust Balance dialog 
box, Money will insert a new transaction for the date you entered to let 
the ending balance become what you want: 
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As you can see, a new transaction is created for 7/31, and it makes the 
ending balance just right! This transaction is not assigned with any 
category or anything, so you may wan to assign it a category or make 
some special note about it so that you can get to know it was created 
“artificially”. 

 When adjusting balances, Money does not take into account of 
unrealized or upcoming scheduled transactions. Only “real” 
transactions count. 

 Reconcile Command 

This command is available only when you’re in the Account Register 
view or any custom view based on it. 

Reconciliation is a process of comparing records in Money’s database 
and the bank statement. The purpose is to make sure the two are exactly 
the same, nothing more and nothing less.  

To reconcile an account, you need to have a bank statement in hand. 
First, switch to the Account Register view, select the account you want to 
reconcile, then select the Reconcile command from the Data menu: 

 

You should enter information from the bank statement into this dialog 
box, including the statement period, the beginning and ending balances 
during that period.  

After tapping on the OK button, you will be put in the reconciliation 
mode. In this mode, the display will be back to the normal Account 
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Register view, but the information in the footnote area will be different, 
see the following pictures. 

     

In the footnote area, Money will display the difference between the two 
ending balances, i.e.,  

difference = bank’s ending balance – Money’s Cleared ending balance 

Note that the ending balance that Money obtained is the Cleared ending 
balance. That includes all transactions that are marked as Cleared or 
Reconciled and whose dates are within the statement period. Posted 
(neither ‘C’ nor ‘R’) transactions are not included in the ending balance. 

If you tap on the footnote, more information shows, this includes the 
numbers on the bank statement and the numbers Money obtained. At 
the bottom of the list are two commands: OK and Cancel.  The OK 
command will be enabled only when the current view is the Account 
Register view and the account being reconciled is selected and the 
difference is 0. You can use the Cancel command to abort the operation.  

When in this mode, you can access all the rest of Money’s functionality, 
such as changing to other views, view another account’s information, 
adding/modifying/deleting transactions, … etc.  So, what you need to 
do now is carefully compare Money’s data with bank statement, make 
any changes necessary to bring the difference to 0. For example, if a 
transaction is missing from Money’s database, add it; if a transaction 
matches with the statement, mark it as Cleared (by tapping on the Status 
column in the table), …, etc.  

No matter what you do, as long as you’re in the Account Register view, 
the new difference will be updated whenever an operation is completed 
so that you can immediately get to know the most up-to-date status. 

Once the difference becomes 0, you should go back to the Account 
Register view (if you’re not in it), select the account that you’re 
reconciling (if it’s not selected), and select the OK command from the 
footnote to finish the process. When finished, all transactions within the 
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statement period will be marked as Reconciled. This means they have 
been checked and they match with the bank statement. Supposedly you 
should not modify or delete reconciled transactions; if you do, you’ll be 
asked to confirm if this is really what you want. 

The Beginning Balance 

Before entering the reconciliation mode, Money will first check the 
beginning balances to make sure they match. If not, Money will display 
a message like following: 

 

When Money calculates the beginning balance for an account, it starts 
from the opening balance, then adds up the amounts of all Reconciled 
transactions up to the day just before the specified beginning date. That 
is, if you have a transaction that’s not marked as Reconciled before the 
statement period, it will not be counted in when calculating the 
beginning balance. As a result, if you did not faithfully reconcile your 
account month by month, it’s very likely that you get this warning 
message. 

This message is “harmless”. That is, you can leave the inconsistent 
beginning balance there and go on with the reconciliation of the 
account. It’s just that if you ignore it, it will appear again the next time 
you reconcile. To fully resolve this anomaly, you can OK this message 
and proceed to the reconciliation mode (explained above). When in this 
mode, you should review all your past transactions, mark them as 
Reconciled and make any necessary changes so that the beginning 
balance is what the bank statement says. 

Or, you can use the Adjust Balance command to change Money’s 
beginning balance if you don’t care about individual correctness of past 
transactions. Because this command is designed to adjust the ending 
balance, so you should tell the Adjust Balance command to adjust so 
that the ending balance on the day just before the beginning of the 
statement period to be the same as the statement’s beginning balance. 
For example, if the statement period is from 1/1/2004 to 1/31/2004, and 
the beginning balance is $5,920, then you should set the ending balance 
on 12/31/2003 to $5,920. 
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 When reconciling an account, Money does not take into account 
of unrealized or upcoming scheduled transactions. Only “real” 
transactions count. 

 Overdraft Alerts 

When defining an account, you can assign an “alert level” value so that 
once the account’s balance drops below this level, Money will give an 
alert to warn you about potential overdraft or over-limit conditions.  If 
you don’t want Money to check overdrafts for a particular account, you 
can, when defining an account, leave the Alert when field empty or set it 
to 0. 

For example, a checking account may have a minimum balance 
requirement of, say +$50, you can set the alert level at +$100 (Note: these 
two amounts are both positive). Once its posted ending balance at the 
last transaction of the entire database drops below $100, Money will 
issue an alert to ask you to be careful.  

Similarly, a credit card may have a credit line of -$5,000, so you can set 
the alert level at -$4,500 (Note: these two amounts are both negative). If 
the credit card account’s balance (again, the posted ending balance at 
the last transaction in the entire database) goes over -$4,500, Money will 
issue an alert too. 

 IMPORTANT: When Money checks for overdrafts, it always 
looks through the entire database to get the most current 
balances, no matter if or what a date range or  filter is in effect.  

This check is done automatically when a transaction is created or 
modified, if and only if the Auto check balances and budget option in the 
Preferences dialog is enabled. Or, it can be done manually by using the 
Check Balances command from the Data menu.  

 Automatically or manually, Money checks not just overdraft but 
also over-budget conditions at the same time. Details about 
over-budget alerts can be found in the section of “Over-budget 
Alerts”. 

When an account’s balance is over or below the alert level, Money will 
issue a warning like following: 
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In this message box, account name is shown along with the account 
limit (not the alert level) and the posted ending balance of the account. 
Not that at the bottom there is a checkbox Stop auto-check. This option 
appears in this message if it was an automatic check. You can check this 
option to disable the auto check. Later you can go to the Preferences 
dialog box to re-enable it. 
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Categories and 
Budgets 

In Adarian Money™, you can assign each transaction (or sub-transaction) with a 
category to indicate the purpose of a transaction. For example, you can set up a 
category called “Clothing” for all the money you spent on buying clothes, or a category 
“Salary” for all the pay checks you received. Categories are not just useful for 
categorizing transactions, they are also useful in budget planning. This chapter will 
explain in detail how to use categories and budgets. 

 Category Attributes 

  Category Type  

As can be seen from the previous example, there are two types of 
categories: one for expenses, and the other for incomes. When you 
define a category, you have to specify which type the category is. Only 
with this information, can Money correctly calculate your total income 
and expense when summarizing your financial condition. You can refer 
to the section “Calculation of Income and Expense” for a discussion on 
how Money calculates incomes and expenses. 

  Subcategories  

Sometimes you may want to further categorize transactions than just 
one level of categories. For example, you spend a lot of money on your 
car, you can use just one category “Auto” for all expenses on the car. Or, 
you can set up a few more subcategories to further categorize them. Like 
“Auto: Fuel”, “Auto: Insurance”, “Auto: Financing”, “Auto: Service”, 
“Auto: Accessories”, … With subcategories, you can have a better idea of 
where the money went. 

When a category has subcategories associated with it (i.e., it’s a main 
category), you still can assign transactions with it. For example, if you 
bought an air cleaner for your car, this expense does not happen often 
so it doesn’t make sense to create a category or subcategory just for it. 
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But it’s still related to the car, so in this case, you can assign the 
transaction to the main category “Auto”. 

  Budget/Forecast  

Each main category and sub-category can optionally be assigned with 12 
budgets (for expense categories) or forecasts (for income categories), 
one for each month in a year. You can use the same amount for all 12 
months, or you can use different amount for each month. For example, 
the expense for automobile registration usually happens only once a 
year, so you can make a budget for it only for that month, and enter a 0 
for all the rest of the 11 months. 

When defining a category, you can select the type of budget/forecast: 

No budget: The category is not assigned with a budget or forecast, 
hence, there will be no over-budget alerts issued for this category. Note 
that “no-budget” and “zero budget” are two different things in Money. 
For No-Budget categories, it means you can spend as much as you like 
on this category, Money will never bother you by warning you for over-
budget conditions – because there is no budget to be over! But it’s a 
totally different story for zero-amount budgets. Zero-budget means you 
can’t spend even a penny on that category. 

Own budget: The category has its own budget or forecast.  

Shared from parent: This type of budget can be used only on sub-
categories. When used, the sub-category does not have its own budget 
or alert level; rather, all spending or income on this sub-category will be 
combined with that of the main category’s and checked against the 
main category’s budget. For example, the main category “Auto” has a 
budget of $100, and its sub-category “Auto: Gas” shares budget with 
Auto. If you have spent $80 on Auto, and $50 on Auto: Gas, the 
combined spending is $130, then it’s considered to be over-budget. 

 Over-budget Alerts 

When defining categories, each category and subcategory can be 
assigned with a budget (for expense categories) or forecast (for income 
categories) for each month of the year. For expense categories, you can 
also specify an alert level for a month’s budget. When the spending in a 
month is over that alert level, Money will issue an alert to let you know 
about the potential over-budget condition.  
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For example, if you have a budget of $98 on “Auto: Fuel” category for 
January, and you set the alert level at $70, when the total expense on 
“Auto: Fuel” in January goes over $70, Money will issue an alert. But if 
you set a category’s budget or alert level to $0, then no checks will be 
done on that category. 

 Income categories don’t have alert levels, and therefore no alerts 
will be given for income categories. 

This over-budget check can be done automatically when a transaction is 
created or modified, if and only if the Auto check balances and budget 
option in the Preferences dialog is enabled. Or, it can be done manually 
by using the Check Balances command from the Data menu.  

 Automatically or manually, Money checks for not just over-
budgets but also overdrafts at the same time. Details about 
overdraft alerts are in the section of “Overdraft Alerts”. 

When a category’s total expense is over the alert level, Money will issue a 
warning like following: 

 

In this message box, category name is shown along with the budget (not 
the alert level) and the current balance. Note that at the bottom there is 
a checkbox Stop auto-check. This option appears in this message if it was 
an automatic check. You can check this option to disable the auto-check 
feature; later you can go to the Preferences dialog box to re-enable it. 

 Date Range and Budgets  

When Money checks for over-budgets, it always checks for all 
transactions within the current date range, no matter if there is a filter 
being applied or not. (Applying a filter only means you’re viewing fewer 
transactions, it certainly doesn’t mean the over-budget risk will go away! 
Managing money is not a head-in-the-sand game.) 

Because budgets and alert levels are set up for whole months, whereas 
the current date range can contain any number of days, so when Money 
calculates budgets and alert levels, it always makes sure the amounts are 
adjusted so that they are in proportion to the number of days in the date 
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range. For example, if you have set up budgets and alert levels from 
January to March like following: 

Month Budget Alert Level 

January $1,000 $800 

February $900 $700 

March $1,100 $950 

If the date range is set to be This Month (assuming this month is January), 
or Jan 2005, or 1/1-1/31, Money uses $1,000 as the budget for the date 
range, and $800 as the alert level. If the date range covers only one week, 
then the budget will be only $1,000 /  31 * 7 = $225.81, and the alert level 
will be $800 / 31 * 7 = $180.65.  

As a more complicated example, if the date range is 1/28 – 3/12, then the 
budget will be: 

$1,000 / 31 * 3 + $900 + $1,100 / 31 * 12 = $1,423.08, 

and the alert level is: 

$800 / 31 * 3 + $700 + $950 / 31 * 12 = $1,145.16. 

That is, if you set up the date range to be 1/28-3/12, and the total 
spending during this range is over $1,145.16, then Money will issue an 
alert to you. 

 Defining Categories 

To define categories, you should select the Categories command from 
the Lists menu. What comes up is the familiar list editing dialog box that 
we have explained earlier. When you tap on the New or Edit button in it, 
the following dialog box appears: 
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 Type – type of the budget. You can assign the type when creating a 
new one, but you can’t change the type when modifying an existing 
one. 

 Subcategory of – a list of main income or expense categories, 
depending on the Type selected above. If a main category is selected 
in this list, then the category being defined will be a subcategory of it; 
if <None> is selected, then the category being defined is a main 
category itself.  

 Monthly budget – amount of this category’s budget or forecast, 
depending on the Type of this category. If you chose No budget, then 
Money won’t issue any alert for this category.  

You can choose Share from parent’s if this category is a sub-category 
and it doesn’t have its own budget but will share from its parent. For 
example, the main category “Auto” has a budget of $100, and its sub-
category “Auto: Gas” shares budget with “Auto”. If you have spent 
$80 on Auto, and $50 on “Auto: Gas”, the combined spending is $130, 
then it’s considered to be over-budget. The option Share from 
parent’s can only be used with sub-categories. For sub-categories 
who are sharing budgets with their parents, you can’t specify 
budgets for them, because they user their parents’. 

If you want to let a category have its own budget, you can tap on the 
Use my own budget checkbox. When doing so, a second dialog box 
pops out where you can specify the details about the budgets, see 
below. 

 

Here you can enter the budget amounts for each month in the year and 
their associated alert levels (for income categories, the Alert if column 
does not show because income forecasts don’t have alerts.) If the Same 
for every month checkbox is checked, there will be only one row showing, 
and the numbers entered in this row will be applied to all 12 months. 

If the Can be rolled over checkbox is checked, this category’s budget and 
actual spending will appear in the Roll Over dialog box where you can 
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decide how much unused budget or overage will be carried over to the 
following month. If this option is not checked, then this category’s 
budget can’t be carried over. 

 Categories/Budgets View 

This view gives a summary for all categories and their respective budget 
or forecast conditions. By default, you can use Graffiti or hardware 
keyboard to enter the Quick Access Key ‘b’ to switch to this view.  

 

If a category’s name is displayed in bold text, this indicates that the total 
expense for this category in the current date range is over the alert level 
you have set. For example, in the above picture, the “Auto: Service” 
category is over budget now. 

When Money calculates incomes and expense, it never counts in 
transfer transactions or sub-transactions.  

Tapping on the Setup button at the bottom has the same effect as using 
the Categories Budgets command from the Lists menu, please see the /
“Defining Categories” section for details. 

  Tapping on Rows  

If you tapped on a category in the table but not in the Expand/Contract 
column, Money will jump to the Transaction Log view and a filter will 
automatically be applied so that only transactions (or sub-transactions) 
having the category you chose will be shown in the table.  

 If there is already a filter in use, Money will “synthesize” a filter 
for you. Please refer to the “Synthesized Filters” section for details. 

  Columns in the Table  

Expand/Contract – this column shows an expand or contract button if the 
category is a main category and it has more than one sub-categories. 
Tapping on these buttons will expand or contract the sub-categories. 
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Name – the name of the category. 

Budget – budget or forecast for the category. Amounts in this column 
may not be the ones you entered, they may be the adjusted budgets (or 
forecasts) if the current date range does not coincide with the budget 
period. See the “Date Range and Budgets” section for details on how 
Money calculates to get adjusted budgets.  

Actual – actual total expense or income of a category in the current date 
range. If there is a filter being applied, only qualified transactions are 
counted in when calculating this number. 

Actual %  – actual total expense or income of a category in the current 
date range. It equals to (Actual / Budget). 

Remain  – for expense categories, this column shows how much budget is 
still available; a negative number means you’re over the budget. For 
income categories, this is how much you’re off the forecast; a negative 
number means you’re over the forecast. It equals to (Budget – Actual). 

Remain %  – equals to (1 – Actual %). 

Note Text – note of the transaction. 

Note Icon –a note icon if the transaction has note text attached with it. 
You can tap on a note icon to bring up a little text box to show the first 
four lines of the note.  

  Transfers  

Transfer transactions do not have categories, so usually their amounts 
are not included in this view. However, if you have set up so that some 
transfers’ amounts are treated as income or expense, you will see a few 
more items appearing in this view.  

In the following picture, a transfer to account Mortgage is counted in as 
an expense. Therefore, there is an added item [Mortgage] at the bottom 
of the expense section. For a detailed description on why and how 
transfers are treated as income or expense, please refer to the 
“Calculation of Income and Expense” section. 
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  Viewing Shared Budgets and Expanding/Contracting  

When a main category is expanded, the amounts shown in the table can 
be either its own or the total of all sub-categories who share their 
budgets with this main category. You can check or uncheck the Show 
combined expenses option from the Preferences dialog box to control this. 
In the following two pictures, the one on the left shows the situation 
when this option is unchecked. 

     

Comparing the two, you will see that the column Actual for the main 
category “Auto” was $57  (picture on the left). When the Show combined 
expenses option is checked, this number becomes $82 (picture on the 
right). This is because the expense $25 from the “Auto: Registration” was 
added, because it shares budget from its parent’s budget so its spending 
is also combined into its parent’s spending.  

Not just the Actual column, other columns such as Actual %, Remain, 
and Remain % will all be affected by this option. 

Also worth noting is in the picture on the left, the category name “Auto” 
is displayed in normal font, but in the right, it’s in bold font. This is 
because when combined, the total expense $82 is over the budget $70, 
so the program uses bold font to show the name of the category. But 
either way, Money will treat the category of “Auto” as over-budget and 
issue an over-budget alert.  

When a main category is contracted, all its children’s budgets and actual 
spending are combined into the parent category’s row. In the following 
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two pictures, the Auto category is contracted in the picture on the right. 
You can see that all the numbers in the Auto row are the sums of Auto 
itself and all its children. 

     

 “No Budget” and Expanding/Contracting  

When specifying the monthly budgets for a category, Money lets you 
enter a budget of zero (and even negative) amount, which means every 
penny you spend on this category is considered to be over the budget. 
For such categories, the amount 0 will be shown in the Budget column, 
and all the other columns (Actual, Actual %, Remain, and Remain %) will 
show the correct amounts. 

On the other hand, there are no-budget categories, that means you can 
spend as much as you like, there is no such thing as “over the budget” 
for them! For such categories, all columns except the Actual will be 
blank– because there is no budget, of course there is no such thing as 
“remaining budget”, and of course there is percentage to show either. 

As explained in the last paragraph, if a parent category has no budget, its 
Budget (as well as Actual %, Remain, and Remain %) columns will all be 
blank.  But when its children are contracted, all their budgets are 
combined into the parent’s row. In this case, although the parent 
doesn’t have budget itself, but as long as one of its children has budgets, 
when contracted, the parent row will show the combined result of its 
children. 

In the following pictures, the left one shows the parent category Auto 
does not have budget, so its Budget is empty. When contracted, because 
3 of its children have their own budgets, so the Auto row shows the total 
budget amount of $560. 
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  Sorting  

When you sort rows in this view, main categories are first sorted among 
themselves. Then, sub-categories of the same parent are sorted, and 
they will always be kept together. In the following picture, the Show 
combined expenses option is not checked, and categories are sorted 
according to their actual spending in ascending order: 

 

The actual spending on “Auto” category is $57, so it’s placed in front of 
the “Dinning” category because $57 is less than $81. The four sub-
categories of the “Auto” category are all kept together and are sorted 
among themselves. 

But if we uncheck the Show combined expenses option, the table 
becomes: 

 

This time the “Dinning” category becomes in front of the “Auto” class 
because the spending on “Auto” becomes $82 – adding the $25 from 
“Auto: Registration” sub-category. 
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If you contract the “Auto” category and sort it again, you will see the 
table becomes: 

 

This time “Auto” is put to the bottom because its combined spending is 
$481, larger than any other categories. 

The same applies to sorting on other columns: categories are always 
sorted by the numbers shown on the screen, no matter if they’re 
combined or shared or what. 

 Roll Over Command 

Roll-over is the operation of carrying over the unused budgets or 
overage to the following month. For example, you have budgeted $60 for 
your cell phone bill in March, but turns out you used only $55. The 
unused $5 budget can be rolled over to April so that you can talk a few 
more minutes. Along the same line, if you used $70 in March, then by 
rolling over the $10 overage to April, you’ll have to watch it when you 
use your cell phone. 

To use the roll-over feature, switch to the Categories/Budget view, then 
select the Roll Over command from the Data menu, you will see the 
following dialog box: 

 

Here you select from which month’s budget to roll over. Remember, 
only budgets have been identified as “roll-overable” will involve in the 

 Page 94 of 171 



Adarian Money™ for Palm OS® User’s Manual  © 2003-2006, Adarian Software, LLC 

roll-over operation. To make a category roll-overable, please refer to the 
Defining Categories section. 

The Adjust alert levels option makes the program re-calculate the alert 
level of an expense category when its budget is changed. For example, a 
category’s budget is $100, and alert level is $80. Now you roll over $20 
from the previous month, so its budget becomes $120, or a 20% increase. 
At this time, if the option is checked, the alert level is adjusted 
proportionally and becomes $96. (Just a reminder: Income categories 
don’t have alert levels. So this option doesn’t have any effect on income 
categories.) 

When you tap on the OK button, and if you haven’t used the Details 
button to specify different amounts, the program will automatically 
calculate the maximum roll-overable amount for each category and add 
them to the next months’ budgets and forecasts. If you have specified 
different amounts, the program will roll over only as much as you 
specified. 

When you tap on the Details button, you will see another dialog box 
coming up where you can get to see exactly how much will be carried 
over, and you can change that. 

 

In this dialog box, all categories which have been marked as “roll-
overable” are shown in the leftmost column. The second column shows 
the information you chose by using the Show button at the bottom of the 
dialog box. You can choose to display any of the following: budget 
assigned for the previous month, budget assigned for the following 
month, actual amount spent or earned in the previous month, and the 
maximum amount that can be rolled over. 

The third column is the place where you enter the actual amount you 
want to roll over to the following month. When entering this dialog box, 
the program puts the maximum amount that can be rolled over in the 
third column. You can enter any number you want, as long as it does not 
exceed the maximum. 
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Note that in the above picture, the program does not allow you to enter 
a roll-over amount for Auto, Vacation, and Investment. This is because 
these parent categories are not marked as roll-overable. They are shown 
here is only because one or more of its children are roll-overable, so they 
have to appear in this dialog box, but they are not editable. 

More on Roll-over Amounts 

You can enter positive or negative roll-over amounts in the above dialog 
box. For expense categories, a positive roll-over amount means the 
following month’s budget will be increased, i.e., you can spend more. A 
negative value means your budget is reduced. For income categories, a 
positive value means you did not earn enough money in the previous 
month, and the forecast for the following month is increased, i.e., you’ll 
have to work harder and earn more. On the other hand, a negative roll-
over amount for an income category means you can relax a little next 
month. 
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Scheduled Transactions 

 

Scheduled transactions are transactions that have a pre-defined schedule6. For 
example, monthly bills like cable TV or telephone are expense transactions that 
happen once a month; magazine subscription payments happen once a year; salary 
are income transactions are once or twice a month; and credit card payments are 
transfer transactions that happen every month.  

These transactions all have pre-defined schedules and happen periodically. To save 
you the trouble of entering the same transactions every time they’re due, Adarian 

Money™ can do that for you automatically7. When it’s due, you can let Money insert a 
transaction automatically without asking you, or you can have Money prompt you. 
Moreover, you can set up an alarm so that Money notifies you about an upcoming 
transaction a number of days ahead. This will be a great help for people who always 
forget to pay their bills. 

In this chapter, we will look at how to work with scheduled transactions in Adarian 

Money™. 

 Defining Scheduled Transactions 

First off, you have to let Money know what scheduled transactions are 
there by selecting the Scheduled Transactions command from the Lists 
menu.  

 

                                                            
6 Many people use the term “monthly bills”. Monthly bills are scheduled transactions all right, 
but they are just only part of it. We’d rather use a term that’s more accurate than that. 
7 The automatic processing function must be enabled explicitly for it to work properly. To 
enable this function, you can go to the Preferences dialog box. 
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The same list editing dialog box appears (see below) From there, you 
can use the New, Edit, Delete buttons to define your scheduled 
transactions.  

 

Deleting a scheduled transaction does not remove the transactions have 
been made. For example, if you have a scheduled transaction called 
“Comcast Cable TV” for several years, but you decided to terminate the 
contract. At this point, you can delete the “Comcast Cable TV” 
scheduled transaction from the above dialog box, but all the payments 
you have made in the past are still kept in the database. This ensures the 
integrity of your financial record, i.e., Money’s transaction database is 
still consistent with your bank statements, the expense/budget 
summary is still correct, etc. However, because the scheduled 
transaction is deleted, so there is no way of knowing those transactions 
are made for paying cable TV bills, unless you have used other ways to 
identify them, such as using category or payee or note fields. 

Following is the dialog box that appears when you tap on the New 
button from the above list editing dialog box: 

 

 Name is the name of the scheduled transaction, maximum 31 bytes.  

 Next due date is the due date of the next transaction. When you tap 

on the date selector  , you’ll be brought to another 
dialog to pick a date. This date selector won’t be usable if the 
schedule is not periodical but a series of dates or stopped, see the 
following paragraphs for more on this. 
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 Repeat lets you specify how or when the transactions should repeat. 
You can choose periodical schedules like Monthly, Weekly, Yearly, 
etc. If you chose Day of Month from the list, the Day of Month dialog 
box appears to let you set up a schedule based on weekdays, see the 
picture below. 

 

In the Day of Month dialog box, you can set up a periodical schedule 
such that it happens on, say, the first Monday, the second Sunday, or 
the last Friday of every one or any number of months.  

 “the last Friday” is not the same as “the fourth Friday”. 
Sometimes there can be five Fridays in a month.  

If a scheduled transaction is to have a schedule based on weekdays, 
the Next due date mentioned above is automatically determined by 
the program, you won’t be able to change it. 

If the schedule is not periodical, you can specify a series of due dates 
by choosing the Custom… item from the Repeat list. The following 
dialog box appears to let you define up to 30 dates: 

 

If you defined a series of due dates as describe here, you won’t be 
able to use the Next due date option to change the next due date, 
because it has already been defined in the date series. 

The first option in the Repeat list is Stopped. When a scheduled 
transaction has finished, for example, you stopped subscribing a 
magazine, or you have paid off your mortgage (good for you!), you 
don’t need to delete the scheduled transaction from the database. 
Instead, by assigning it to Stopped, you can still use other functions 
like filters to find out how much you have paid for it in the past. 
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 Details shows the amount of the scheduled transaction. By tapping 

on the selector  on the right, you’ll be brought to the 
Transaction dialog box, see below. This is the same dialog box as 
described in the “Creating and Editing Transactions” section with 
only a few differences.  

 

Unlike the ordinary Transaction dialog box, you won’t be able to 
specify the date, the transaction status, the check number, and the 
note. These information are supposed to be entered only when the 
transaction actually happens. However, you still can assign 
everything else such as transaction type (withdrawal, income, or 
transfer), or Split Transaction here. Information entered here will 
automatically be applied when a transaction is due. 

It doesn’t matter if you don’t have the exact details about a 
scheduled transaction at this time. For example, electricity or water 
bills always have different amounts each month, it’s not possible to 
give an exact amount when setting up a scheduled transaction. In 
this situation, just enter an average amount, and choose Ask me or 
Remind me option from the Action option below, then you’ll have a 
chance to enter the correct information when it actually happens.  

 Stop specifies when this scheduled transaction should stop. You can 
have three options: Repeat indefinitely if it’s to repeat indefinitely 
until you stop it explicitly; After # of times if the scheduled 
transaction will stop after a number of occurrences; After date if it is 
to stop after a certain date. Note that when a scheduled transaction 
is stopped by choosing the Stopped option from the Repeat list, the 
Next due date option will be disabled. 

 Action specifies what action to take when the scheduled transaction 
is due. You can have three choices: 

 These options do not appear in the dialog box if automatic 
processing for scheduled transactions is not enabled. You should 
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check the settings in the “Sync with AMWin” group in the 
Preferences dialog box. 

Automatic insert: When you run Adarian Money for the first time on 
or after the next due date, the program automatically inserts a 
transaction into the database for you. This transaction will have 
exactly the same attributes as specified in the Details option 
mentioned earlier. 

Ask me: When you run Adarian Money for the first time on or after 
the due date, the program will fire up a dialog box asking you if and 
how you want to handle it, see the picture below. More details about 
this dialog box will be explained in the “Alarms” section later in this 
chapter. 

 

Remind me: When you chose this option, the program will issue an 
alarm at the specified time to remind you. To specify an alarm, you 
need to enter how many days ahead and at what time the alarm 
should be fired up, see the picture below. More details about alarms 
can be found in the “Alarms” section later in this chapter. 

 

 Scheduled Transaction View 

This view  give users a summary of their scheduled transactions, it 
summarizes all upcoming and past-due transactions.  

By default, you can use Graffiti or hardware keyboard to enter the Quick 
Access Key ‘h’ to switch to this view.  
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This view has only four columns: Name is the name of the scheduled 
transaction; Date is the overdue date or upcoming due date; Amount is 
the (estimated) amount of the scheduled transaction; Account is the 
name of the account where the scheduled transaction is paid from. 

Rows in the table are divided into two sections: 

 --Overdue-- The first section of the table lists all the overdue 
transactions. For each scheduled transaction, up to 20 overdue 
transactions can be remembered. After that, new ones replace the 
old ones.  

When tapping on an overdue row, a pop-up menu appears with only 
two commands in there: Insert and Remove. When you’re ready to 
pay an overdue payment (or receive an overdue income), choose the 
Insert command. A Transaction dialog box appears  to let you insert a 
transaction. After a transaction is inserted, the overdue record is 
removed from the database. Changes you made in the Transaction 
dialog box will be remembered for future use. 

If you choose the Remove command from the menu, the overdue 
record is removed but no transaction is inserted. This means you 
decide not to do anything about an overdue transaction. (!) 

 --Upcoming--  The second part of the Scheduled view lists the 
immediate next transaction for every scheduled transaction. When 
you tapped on any of them, the Transaction Due dialog box appears. 
In this dialog box, you can execute the transaction, skip it, or simply 
ignore it. Details about this dialog box are given in the next section. 

 Setup button  Tapping on the Setup button has the same effect as 
selecting the Scheduled Transactions command from the Lists menu. 
It allows you to set up scheduled transactions. 
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 Alarms 

 Alarm functions will not work if Adarian Money is installed on a 
memory expansion card 

 Alarm functions will not work if automatic processing for 
scheduled transactions has not been enabled for the handheld. 
For details, please refer to the Preferences dialog box.. 

Alarms are an important part of scheduled transactions and are 
extremely helpful for those people who always forget to pay their 
monthly bills. To make the program give you an alarm before a 
transaction is due, you must select the Remind me option from the 
scheduled transaction definition dialog box, see the “Defining 
Scheduled Transaction” section earlier in this chapter. 

For example, if the due date of a scheduled transaction is October 25, 
2004, and you want the alarm be triggered 7 days ahead at 10:00AM, 
then at 10:00 AM, October 18, 2004, no matter if your handheld is turned 
on or off, or what application you’re using, the following Reminder 
dialog box pops up: 

 

 Money’s alarms will stop working after a soft reset. To make 
them work again, you need to activate Money for at least once 
after a reset. 

If you tapped on the OK button in the Reminder dialog box, the alarm for 
this scheduled transaction will be disabled and there won’t be any more 
alarms until the next cycle. (Alarms for other scheduled transactions are 
not affected.) The next due date of this scheduled transaction will 
remain unchanged.  

If you tapped on the Snooze button, the dialog box will go away and you 
can go back to whatever you were doing, but the alarm will be triggered 
again after four hours. You can snooze an alarm for as many times as 
you want until you do something about it or it’s overdue. If your Palm 
OS is version 4.0 and up, the system will display a blinking icon at the 
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top-right corner of the screen (see the picture below on the left) to 
remind you that there is an alarm being snoozed. You can tap on this 
blinking icon to get details of the snoozed alarm, see the picture on the 
right. If you’re using Palm OS 3.5, no special indication is available. 

          

If you tapped on the Go To button from the Reminder dialog box, the 
alarm for this scheduled transaction will be disabled and there won’t be 
any more alarms until the next cycle. Furthermore, no matter what 
you’re currently doing will be closed and Adarian Money will be brought 
up automatically. Immediately after Money is called up, the Transaction 
Due dialog box is called up to let you decide what to do about this 
transaction. See the picture below: 

 

In this dialog box, you can tap on the Amount selector  to specify 
the transaction details. If the amount of a monthly bill always changes 
and you weren’t able to give the exact information when setting up the 
scheduled transaction, this is a good time to do it. When tapped on, the 
same Transaction dialog box will appear, you can enter the correct 
information there. Any information you entered at this time will be 
remembered for future use. 

If you tapped on the Insert button, a new transaction (having the 
information you just entered if you did) will be inserted into database. If 
you tapped on the Skip, nothing is inserted into the database, instead, an 
overdue record will be recorded. If you tapped on the Ignore button, 
nothing will happen, not even an overdue record. You simply ignore it!  
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Regardless which action you take, the next due date of this scheduled 
transaction will advance to the next transaction cycle. And no more 
alarms for this scheduled transaction will be issued until the next 
transaction cycle. 
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Filtering and Finding 

Filters are a set of test criteria applied to transactions. When applied, only transactions 
pass the test will be shown in the table, or be counted in when calculating summary 
reports. For example, you can define a filter to be (Category = Business), then in 
Transaction Log view, only transactions whose categories are Business get to be shown; 
in the table similarly, in Categories/Budgets view, only such transactions are counted 
in the summary.  

Filters a great way for users to analyze their financial status, or to focus only on 
transactions they are interested in. You can define simple filters containing only one 
condition (such as the above example), or you can define advanced filters using 
Boolean expressions with multiple conditions. Either way, filters can be named and 
saved for future use.  

In addition to filtering, filters can be used in finding transactions. You can set up a 
search criteria using filters, then search for transaction that match this criteria. 

 Working with Filters 

To better understand how filters work, let’s take a look at two examples. 
First, we have a database like in the picture below: 

 

Now we use the Filter command from the Data menu to apply a filter: 
(Category = Auto: Service), then only four transactions are shown in the 
view because only they satisfy the test condition, see the picture below. 

Also, note that there is a blinking  icon showing in the title area of the 
screen. This indicator reminds you that there is a filter being applied, 
and more importantly, that what you’re looking at right now is just part 
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of the database, don’t mistake it for the entire database. Also note the 
total amount shown in the footnote has changed too. 

 

 You can tap on the blinking  icon to remove the filter. 

With filter in effect, let’s use Graffiti to enter the key ‘c’ to switch to the 
Classes view. This is what Money displays in the Classes view: 

 

The total amount in the last row is -1,213, which is the same as the 
amount (after rounding) shown in the Transaction Log view we just saw. 
This means the filter is still in effect and the summary report calculates 
only transactions satisfy the test condition. Another way to tell that the 

filter is still in effect is the blinking  is still blinking.  

As you can see, using a filter can help reducing the number of 
transactions displayed in Transaction Log (and Account Register) view 
so that you won’t be distracted, and it also can help producing summary 
reports based on information that you’re interested in. 

  Synthesized Filters  

Now let’s continue. This time we tap on the first row in the above 
picture, the row that says “Business”.  

By Money’s design, tapping on a row in Classes views is to jump to 
Transaction Log view and Money will show only transactions of that 
class. But right now we already have a filter Category = Auto: Service in 
effect, so what Money does is to synthesize a new filter by adding a new 
condition to the filter in use and thus the filter becomes: 
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Category = Auto: Service AND Class = Business 

Note the addition of the second condition Class = Business. With this 
filter in effect, Money jumps to Transaction Log and shows the following: 

 

If you compare this picture with the first one, you will see that now there 
is only two transactions left in the view because only these two can 
satisfy the synthesized filter. As a matter of fact, Money can synthesize a 
new filter from any kind of filters, no matter how complicated they may 
be. For example, if you have a filter like this: 

(Category = Auto: Service OR Category = Auto: Fuel) AND  
Amount <= -$20 

After tapping on the “Business” class row, Money will create a filter like 
this: 

((Category = Auto: Service OR Category = Auto: Fuel) AND  
Amount <= -$20) AND Class = Business 

Money always add a pair of round parentheses around the original filter 
and append an AND operator and the new condition. 

Note that the blinking icon is now changed to , this tells you that there 
is a filter in effect, and this filter is a synthesized filter. Synthesized filters 
are different from ordinary filters in that they cannot be used in custom 
views, and they cannot be saved and reused. 

  Filter’s Effectiveness  

Once a filter is applied, it will stay in effect no matter which view you 
switch to – even if the view has nothing to do filters, such as the 
Scheduled Transactions view. But if you quit Money and come back 
again, the filter will not be remembered. If you want to have the filter be 
remembered, you need to define a custom view using the filter you want. 
Details about custom views can be found in the section of “Custom 
Views.”
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Each view uses filters in different ways. For Transaction Log and 
Account Register views, as we’ve mentioned, only qualified transactions 
will be displayed; for summary report views (i.e. the Classes, Categories, 
and Payees views), only qualified transactions are counted in in the 
summary. For the Accounts List view and the Summary view, please 
refer to their respective sections for details. 

The Scheduled Transactions view has nothing to do with filters, it just 
ignores them. But the blinking icon will still show. 

 Filters and Sub-Transactions 

In the section of “Split Transactions” we have explained how you can 
divide a transaction into several sub-transaction. Each of these sub-
transactions has its own amount, category, and class. When Money 
performs filter tests on a transaction with multiple sub-transactions, it 
examines each and every sub-transaction in it, and as long as one of 
them passes the test, the main transaction is considered to be qualified. 

Again, using an example would be easier for you to understand: 

Let’s say you went to a local Fred Myer’s store for shopping. At the 
checkout, the total price of the things in your cart is $100, where $50 is 
for grocery, $20 for clothing, and $30 for toys. In addition, you asked a 
$40 cash-back from the cashier. Therefore, you have a transaction with 
four sub-transactions: 

Transaction Category Class Amount 

Main transaction N/A N/A -$140 

Sub-transaction 1 Grocery For myself -$50 

Sub-transaction 2 Clothing For family -$20 

Sub-transaction 2 Toys For kids -$30 

Sub-transaction 2 [Cash] Unassigned -$40 

If you use a filter (Amount <= -30) to test this transaction, Money will 
consider it passed because there is at least one sub-transaction which 
can satisfy the condition. Similarly, this transaction will pass the filter 
tests (Category = Clothing) and (Class = For Kids). 

But if the testing condition is (Amount <= -80), then this transaction will 
not pass because although the main transaction’s amount is <= -80, but 
none of its sub-transactions is. 
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When testing a transaction, Money tests all its sub-transactions, if any 
one of them can pass the filter, the main transaction is considered to be 
a qualified transaction. 

Similarly, when Money generates summary reports, it summarizes by 
sub-transactions. Using the above example, in the Categories/Budgets 
view, you will find that the $50 is added to the “Grocery” category, $20 
for “Clothing” category, and $30 for “Toys” category. The same goes for 
summary on classes. 

 Applying Filters 

To apply a filter, you can select the Filter command from the Data menu:  

 

This dialog box is divided into two parts. The first part Show transaction 
if lets you quickly define a simple filter with only one condition8. The 
benefit is they’re simple, easy and quick to use; but the downside is they 
can’t be saved and reused. If you want to use a filter having more than 
one condition, or if you plan to reuse it in the future, you have to use an 
advanced filter. We’ll come to that later. 

It should be very straightforward in defining single-condition simple 
filters, just select an attribute then enter a value. The only thing that 
needs a little explanation is when you choose to filter on amounts, you 
need to enter a numeric value. This value is always in home currency, 
and can have a sign. For example, if you want to find transactions 
withdrawing more than $20, because withdrawal transactions’ amounts 
are always negative, so you should enter <= -20, not > 20.  

Other than using simple filters, you can also check the Use saved filter 
checkbox and select a saved filter. In the pop-up list, in addition to a list 
of saved filters’ names, you’ll find a command ---Filter Manager---, you 
can use this command to call up the Filter Manager and define a new 
filter, if none of the existing ones fit you needs.  

                                                            
8 A condition is a comparison, such as amount > 20 or category = auto: fuel. 

 Page 110 of 171 



Adarian Money™ for Palm OS® User’s Manual  © 2003-2006, Adarian Software, LLC 

When you enter this dialog box, usually the current filter in use (simple 
filter or saved filter) will be shown in it so that you can clearly get to 
know what’s the filter you’re using. But if the current filter is a 
synthesized one, the program cannot display it in this dialog box – it’s 
not a simple filter, and it’s not a saved filter, so the program can’t 
properly display it in the dialog box. 

 Defining Filters 

If you need a filter that requires more than one condition, or if you plan 
to reuse a filter, you can select the Filter Manager command from the 
Data menu to create a saved filter. Other than this command, the Filter 
Manager can also be called up by using the --Filter Manager--- command 
from the Filter dialog box described in the last section. The Filter 
Manager is a typical 

-

list editing dialog box that we have seen many times. 
When you tap on the New or Edit button, the following dialog box 
appears: 

 

When defining a new filter, first you need to give it a name. Then as the 
description text in the Expression area said, you need to tap anywhere 
inside the area. When doing so, a pop-up menu appears which has only 
one command: Add condition. Select this command and Money will 
bring you to the Condition dialog box, in which you can enter a test 
condition. This Condition dialog box is actually the same as the upper 
half of the Filter dialog box as we have seen earlier: 

 

 When you choose to filter on Amounts, be aware that Money uses 
sub-transactions’ amounts for split transactions. Please see the 
“Filters and Sub-Transactions” section. 
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After you have done with a condition, it will be displayed in the 
Conditions box like following: 

 

If you have more conditions to add, just repeat the above procedure. 
Let’s say you have added another condition and now there are two: 

 

By default, every time when Money adds a new condition, it appends it 
to the end of the filter with an OR operator. But if OR is not what you 
want, just tap on the word or in the box, now another pop-up menu 
appears: 

 

In this menu, Or has a checkmark in front of it, you can select the And 
command to change it to AND. And it becomes: 

 

As you probably have realized by now that the way of editing a filter 
definition is by tapping in the box to access a pop-up menu, then from 
the menu select an appropriate command. Money will give you different 
menus when you tap on different objects in the box. Next we will show 
you the details about these menus: 

Tapping on an empty space, you’ll get a menu that has only one 
command: Add condition. Because you tapped on an empty space, 
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so the new condition is appended to the end of the filter with an Or 
operator joining this and the rest of the conditions. 

Tapping on an operator (AND, OR), you’ll get the menu shown on 
the left. In this menu, the first two commands And and Or are used 
to change the operator that’s tapped on. The Group command 
groups the two conditions to the left and right  of the operator 
tapped on with a pair of round parentheses. The Ungroup 
command removes the parentheses. For example, if you used the 
Group command on the Or operator in the following example, 

Category = Bank charges Or Category = Bills 

Then it will become: 

(Category = Bank charges Or Category = Bills) 

If you selected the Add condition command, a new condition will be 
added to the right of the one that’s tapped on with an Or operator 
joining the two. 

Tapping on a condition, you’ll get a menu that lets you modify this 
condition, or simply remove it. When selecting the Modify 
command, the same Condition dialog box described above will 
appear to modify the condition. The Remove command removes 
the condition tapped on. If you selected the Add condition 
command, a  new condition will be added to the right of the one 
that’s tapped on with an Or operator joining the two. 

Tapping on a round parenthesis – you’ll get a menu with two 
commands. The Upgroup command removes the parenthesis 
tapped on and the one corresponds to it. The Add condition 
command adds a new condition to the fitler. 

  Selecting multiple items  

If the field you selected is category, payee, class, scheduled, or 
account, you will be brought to another dialog box: 
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Here you can use the checkboxes to select more than one item. If a 
transaction has any one of the selected items, it’s considered to be 
qualified. Take the above picture for example, transactions having 
Comcast, or Denny’s, or McDonald’s will be considered to be qualified. 

In this dialog box, you can use Graffiti or the built-in keyboard to enter a 
letter. The list will automatically jump to the first item that starts with 
the letter you entered. 

 Finding Transactions 

In addition to being used in filtering out transactions, filters can also be 
used in finding transactions. When you’re in the Transaction Log or the 
Account Register view, you can select the Find command from the Data 
menu to look for qualified transactions. The contents and the use of the 
Find dialog box are exactly the same as the Filter command we have just 
seen. The only difference is after you have OK’ed the dialog box, the 
screen turns to: 

 

You can repeatedly tap on the Find Next button to go to the next 
qualified transaction, which will be highlighted. When in the Find mode, 
all the rest of the functionality are still available. Find mode can be 
terminated by tapping on the Done button, then you’re back to the 
normal mode. 
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Beaming 

If you and your spouse or partner are both using Adarian Money to manage your 
money, this will be a great feature to you. Through beaming, you can keep you 
databases in synch. This chapter will show you how to do this. 

 Sending 

To send data to another handheld, select the Beam command from the 
Data menu. You will see the following dialog box: 

 

Here you can decide what information to send. But one restriction exists: 
When you send transactions, you cannot send lists (accounts, categories, 
etc.); conversely, when you send lists, you can’t send transactions.  

  Sending Transactions  

To send transactions, tap on the Transactions checkbox, another dialog 
box will appear: 

 

Simply by checking the checkbox to the left of a transaction’s date, you 
can select which transactions to send. Note that only “main” 
transactions are listed here; sub-transactions that exist because of 
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transfers are not listed. Several commands of selecting/deselecting 
transactions, as well as changing information to display can be accessed 
by tapping on the Menu selector at the bottom. When you’re done, tap 
on the OK button to exit this dialog box. When you’re back to the Beam 
dialog box, you’ll find the number of transactions selected is 
conveniently displayed at the right of the Transactions checkbox. 

Note that when sending transactions, you have to make sure list items 
used in those transactions must exist in the recipient’s database. For 
example, you are sending a transaction coming from AMEX account, 
with a category “Clothing” and payee “Dress for Less”, then all these 
three items AMEX, Clothing, and Dress for Less must exist in the 
recipient’s database; or he/she will get an error message. 

  Sending Lists  

To send lists, just check the name of the lists in the Beam dialog box. All 
items in checked lists will be sent. The receiving side will have the 
chance to decide whether and how these information will be merged 
into his/her handheld. Here you only need to decide which lists to send. 

Once after you tapped on the OK button, the beaming starts. 

 If you’re not familiar with Palm’s beaming function, make sure 
you consult Palm OS’s manual for details about beaming, 
especially when the beaming gets fancier and fancier these days, 
like through MMS or e-mails. 

 Receiving 

The receiving side does not have to be running Money in order to 
receive data; data can be received no matter what you’re doing currently. 
Once the receiving side receives the incoming request, Palm will ask for 
your permission by popping up the following dialog box: 

 

Here you can have a chance to decide if  you want to accept incoming 
data. If you said no, the beaming simply stops. If you said yes, Palm 
starts receiving data through Infrared (or any other transport methods). 
When the receiving is completed, the current application that you’re 
using will quit and Money will be called up. As soon as Money starts 
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running, it’ll ask you how do you want to accept these data by showing a 
dialog box. 

  Receiving Transactions  

Depending on the type of information sent, if it’s transactions, the 
following dialog box would appear when Money starts: 

 

At the bottom are three action buttons: tap on Later if you don’t want to 
import the data right now. After you tapped on the Later button, this 
dialog box goes away and Money runs as usual. But next time when you 
call up Money, Money will ask you the same question again. If you 
tapped on the Delete button, after a confirmation message, the received 
data will simply be deleted from memory and nothing will happen. If 
you’re ready to accept the incoming data, tap on the Now button. 

When importing transactions, Money will try to match the list item 
names used in these transactions with the ones that already exist in the 
database. If an item is not found, it would pop-up an error message like 
following: 

 

In this example, one of the received transactions has a payee “Comcast”, 
but it doesn’t exist in the recipient’s database. Money will go through all 
the incoming transactions and pop up this message once for each non-
existent items, therefore the message may pop up more than once. After 
all messages have been shown, the recipient should add these items to 
the database, then leave Money and re-enter, the import will start again.  

If there are too many non-existent items, the recipient may have to go 
through the process a few items before all items are added. Or you may 
consider synchronizing the lists before sending the transactions. 

 Page 117 of 171 



Adarian Money™ for Palm OS® User’s Manual  © 2003-2006, Adarian Software, LLC 

  Receiving Lists  

 

If the incoming data is lists, then the above dialog box will appear when 
Money starts running.  

 Add new ones – when checked, any item in the incoming data does 
not have a same-name matching item in the database will be added. 
For example, if the incoming Class list has a class called “For Kids” 
and the receiving handheld’s database doesn’t have it, then it will be 
added. 

 Overwrite existing ones  – when checked, if a matching item is found, 
then the one in the database will be overwritten by the incoming 
item. For example, if the incoming data has a category called 
“Grocery” whose budget is $100, and the receiving handheld’s 
database also has the “Grocery” database but the budget is $90, then 
after importing, its budget will become $100. 

 Delete non-existent – when checked, any item in the receiving 
handheld’s database does not have a same-name matching item in 
the incoming data will be deleted. 

If you checked this option and Money finds there are items to be 
deleted for a list, it will issue a confirmation message before it 
deletes them: 

 

This message shows all the items to be deleted in one list. The above 
picture shows items to be deleted in the Category list; if Money finds 
there are items to be deleted in other lists, this message will pop up 
again. 
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You can tap on the No button if you decide not to delete them. 

After the importing has finished, Money will give you the summary 
of the importing by showing the following message. Unlike the 
deletion confirmation message, it shows only once; that is, the 
numbers shown in there are the total number for all lists. 

 

 Things to Note about Beaming 

Although it looks easy, but there are a few very important things that you 
need to know. We urge you read through this section before using the 
beaming function. 

  Items That are Renamed  

From the explanation above, you probably can tell by now that Money 
compares names of items to determine if they are new, existing, non-
existent. This is usually good in most cases, but it can cause unwanted 
results if there are items that were renamed. 

For example, if both user A’s  and user B’s databases have the same class 
“For Kids”. Then for some reason, user A renamed it to “Kids” and 
performed a beaming. When B imported the class list from A, he 
enabled the Delete non-existent option (among others). In this situation, 
to Money, all it sees is that the class “For Kids” does not exist in the 
incoming data and thus should be deleted. When Money deletes it, all 
transactions on B’s handheld which use “For Kids” class will become 
Unassigned! Although Money will still add the new class “Kids” (if the 
Add new ones option is enabled), but none of the transactions will have 
that class after beaming – because it’s a brand new class! 

To A and B, this is probably not what they expected; what they expected 
may be that all “For Kids”-transactions are automatically changed to 
“Kids”. But unfortunately, because Money compares items using names, 
all it can tell is an item deleted and a new one created.  

Money just doesn’t have any notion about “renamed items.” 
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  Deleting Non-Existent Accounts  

You can check the Delete non-existent option while beaming so that non-
existent items can be deleted. But when you’re using this option while 
receiving accounts list, be sure you are aware that: 

When an account is deleted, all its transactions will be deleted too. 

Along with the renaming issue we mentioned above, you should know 
by now that renaming an account on the sending end can make all 
transactions from that account be deleted on the receiving end! 

  Importing Accounts  

To ensure database integrity, Money does not allow the changing of an 
existing account’s currency type. Therefore, even though you enabled 
the Overwrite existing ones option, Money will not change accounts’ 
currency types when importing accounts list. (Supposedly such 
situation shouldn’t have happened in the first place. Supposedly, 
accounts of the same name should be of the same currency type.) All 
other account attributes, such as opening balance, account limit, check 
number, will be imported and overwritten as expected. 

When a new account is found and is to be added to the receiving 
handheld’s database, Money will ask the user to decide which currency 
type it’s going to be: 

 

  Importing Scheduled Transactions  

No matter if a new scheduled transaction is added or an existing one is 
overwritten, the transaction details (e.g.., amount of a monthly bill, or 
which category it belongs to, etc.) will all be left blank after beaming. 
The user needs to use the Scheduled Transactions command from the 
Lists menu to manually enter the transaction details for received 
scheduled transactions. 
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Import and Export 

The import function allows you to bring external data, usually created by another 
software, into Adarian Money’s database; the export function allows you to get data 
out of Money’s database and use them in other software. Money provides two methods 
of importing and exporting data, they largely have the same level of support; users can 
choose whichever that’s viable and most convenient for them.  

The first is by way of the PC Conduit9 (or the Conduit). Adarian Money™ comes with a 
free Conduit that runs under Microsoft Windows. If your desktop computer is a 
Windows PC, you can install it to your PC. When HotSync, the Conduit will import QIF 
or OFX files from the hard disk to your handheld, and export data to the hard disk from 
the handheld. 

The other method is by way of an expansion memory card, this is best for those who 
don’t use Windows PC but other operating systems, such as Mac OS. Today, many 
Palm-Powered devices have a slot where you can insert a memory card. Money can 
import and export data through files on this card. This is best for those who don’t use 
Windows PC and have a memory card in their devices.  

Following is a table that outlines and compares the functionality of these two ways of 
importing and exporting. 

                                                            
9 A conduit is a piece of software program that runs on your desktop computer (i.e., PC or Mac.) 
Unlike ordinary application programs, you cannot run conduits directly, instead, they can only 
be called up by HotSync Manager during HotSync. Many Palm OS applications have a 
companion conduit running on the desktop so that they can perform some necessary 
operations during HotSync. 
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Function PC Conduit Memory Card 

Sync with Adarian 
Money for Windows 

If you have installed Adarian 
Money for Windows10 on your 
Wintel PC, the Conduit can 
seamlessly synchronize the data 
between a PC and a handheld. 
With this, you can edit or view 
your financial information no 
matter where you are. For details 
about how to synchronize with 
Adarian Money for Windows, 
please refer to the online help 
that comes with that product.  

Not supported. 

Export data in the 
table 

You can save whatever data that 
are displayed in Money’s table as 
temporary “files”11 in the 
handheld’s main memory. Later 
when HotSync, the Conduit 
reads them out from the main 
memory and saves them as files 
in your hard disk.  

 

You can save whatever data that 
are displayed in Money’s table as 
files in the expansion memory 
card on the handheld. Later you 
can insert the card into a card 
reader and copy those files to your 
desktop computer’s hard disk. 

Export transactions  During HotSync, the Conduit can 
export transactions to QIF or CSV 
files on the hard disk in a 
Windows-based PC. 

You can use the Export command 
to export transactions to QIF or 
CSV files in the expansion 
memory card. Later you can insert 
the card into a card reader and 
copy those files to your desktop 
computer’s hard disk. 

Export to Quicken 
directly 

The Conduit can also export 
transactions to Quicken (2002 
through 2004) directly so that 
when Quicken starts, it will 
automatically load in the data. 

Not supported. 

                                                            
10 Adarian Money for Windows is a separate product from the Palm OS version, it’s downloaded, 
installed, and purchased separately. 
11 As a matter of fact, there is no such thing as “files” on a Palm-Powered device. Here we use the 
word “file” is only because it’s easier to understand. 
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Import transactions During HotSync, the Conduit can 
load QIF files from PC’s hard disk 
to your handheld, and then 
imported by Money into its 
database. 

You can save QIF files on a 
memory card (through a card 
reader), then insert that card to 
your handheld and use the Import 
command to get the data into 
Money’s database. 

Create extra backup 
copies 

The Conduit can create extra 
backup copies on the PC during 
HotSync. 

Not supported. 

 

If you intend to use Adarian Money with either Quicken 2002 (through 2004) or 
Microsoft Money 2002 (and above), be sure to read the section “Working with 
Quicken” or “Working with Microsoft Money”, respectively. They contain very specific 
and useful information that can save you a lot of time! Make sure you read them. 

In the following sections we will examine these operations in detail. But before that, we 
have to spend a few moments to take a look at how to install the Conduit and set it up, 
if you intend to use the Conduit. 

 Installing the PC Conduit 

1. Depending on the type of the delivery file you downloaded, the 
installation of the Conduit is a little different. If what you 
downloaded is an.exe file, you will run it to install Adarian Money. 
During the installation, you will have the chance to select which 
components to install. Make sure you have selected the PC Conduit 
component.  

If the delivery file you downloaded is a ZIP file (.zip), then in the zip 
there is a file named AMConduit.exe. You should run this file to 
install the conduit. 

2. After the installation completes, call up Palm Desktop software. In it, 
select the Customize command from the HotSync menu. The Cus om 
dialog box appears:  

t
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3. In the Custom dialog box, make sure your name appears in the list 
box located at the top (this is especially important if there are more 
than one person using the same PC for their handhelds.) Select 
Adarian Money from the conduit list, and click the Change… button.  

4. Now the Conduit Configuration dialog box appears: 

 

At the top of the Configuration dialog box is a line of text that shows 
the user whose settings are being configured. Make sure the right 
username appears there. 

 Page 124 of 171 



Adarian Money™ for Palm OS® User’s Manual  © 2003-2006, Adarian Software, LLC 

The Configuration dialog box is divided into 5 folders. In the General 
folder, there is only one edit box labeled Data Folder. You should 
enter the name of the folder where data uploaded from and 
downloaded into Money are stored. The Conduit will create four 
sub-folders under the folder you specified, they are: “AMWin”, 
“From Handheld”, “To Handheld” and “Backup”. The use of these 
three sub-folders will be explained later in this chapter. The AMWin 
sub-folder is for use with Adarian Money for Windows. For details 
about how to synchronize data between PC and handheld, please 
refer to the online help that comes with Adarian Money for Windows. 

Money’s default data folder is a sub-folder named “Adarian Money” 
under your default backup folder. If you don’t know where the 
default backup folder is, go to the Opt ons command under the Tools 
menu in Palm Desktop software. You can find it under the General 
panel. 

i

Now the basic setup for the Conduit has finished. Next we will go into 
details about how to use it. 

 Exporting the Table 

Adarian Money provides a unique function that lets you export whatever 
is displayed in the table, be it transactions or summaries, to a file in your 
hard disk. This is a what-you-see-is-what-you-get type export. The 
exported file can be in HTML, RTF, CSV, or plain text format.  

There are two places where the exported files can be saved: the 
handheld’s main (internal) memory, or the expansion memory card if 
your handheld has one. If you choose to save data in the main memory, 
you need to perform a HotSync and the Conduit will get the data out 
from the memory and save them in the “From Handheld” folder under 
your data folder in the computer. If the data are saved in the memory 
card, you need to insert the card into a card reader on your desktop 
computer, then copy those files out from the memory card to your 
computer’s hard disk. 

Here are the procedures for exporting table contents: 

1. In Adarian Money, first set up the table to the way you want to 
export. You should choose the view you want, set a date range, or 
apply a filter so that only necessary data are included. Note that all 
columns, no matter if they are hidden or not, will be exported. 
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  If you intend to export data in CSV format and let a spreadsheet 
software (like Microsoft Excel) to import, you have to make sure the 
data format is acceptable by Excel. For example, if you used ¥ as the 
home currency symbol and YYYY-MM-DD as the default date format, 
and if Excel does not recognize these formats, then the data 
imported will be treated as text, instead of numbers or dates.  

To change Money’s home currency symbol, use the Preferences 
command; to change foreign currency’s symbol, use the Currencies 
command under the Lists menu. To change date format, you need to 
use Palm OS’s Prefs application from the Application Launcher. 

2. In Adarian Money’s main program on your handheld, Select the 
Export command from the Data menu, you’ll see the Export dialog 
box come up: 

 

3. In this dialog box, you should give a name for the exported file. You 
don’t need to include a file extension; Money will automatically 
assign it with a proper extension.  

4. You can use the Memory pop-up list to select the destination for 
exporting. The first item in the list is always Handheld, this is the 
main memory; all other items in the list are your memory cards. If a 
memory card is chosen, you can change folder by double-tapping on 
a folder name (surrounded by square brackets []) in the list of 
filenames; the New Dir button can be used create new folders; the 
Delete button is to delete files or empty folders. Note that you can’t 
create folders in the main memory. 

5. Because you want to export data in the table, so in the Export what 
option, selected Tab e. l

6. Choose a file format from the File format pop-up list. It can be HTML, 
RTF (for word processing programs like Microsoft Word or Windows 
WordPad), CSV (for spreadsheet programs like Microsoft Excel), or 
just plain text file delimited by tabs. 
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7. Tap on the OK button and exit the dialog box. Money will save the 
exported data in the designated memory.   

8. If you exported data to the main memory, now you should perform a 
HotSync. When the HotSync is done, all exported files will be moved 
to the “From Handheld” sub-folder under the Data Folder specified 
in the Configuration dialog box. If there is already a file with the 
same name in the hard disk, the old one will be overwritten. After 
HotSync, all exported files in the main memory will be deleted 
automatically. 

9. If you exported to a memory card, take the card out and insert it into 
a card reader on your desktop computer. Then copy those file out 
from the card to the computer’s hard disk. 

 Exporting Transactions 

There are two ways to export transactions to QIF or CSV files: during 
HotSync,  let the Conduit export the transactions out to a file in your PC; 
the other way is to export them to a file in an expansion memory card, 
then read them out from the card on your desktop computer through a 
card reader. We will first explain the case of using the Conduit. 

  Export Transaction by the Conduit  

Another function that the Conduit performs is to export transactions so 
that other personal finance or spreadsheet software can use. The 
Conduit supports three export targets: 1. directly to Quicken 2002 
(through 2004); 2. to QIF files that can be imported by Microsoft Money 
2002 (and above) or Quicken 2002; and 3. to CSV files that can used by 
spreadsheet software. You can choose the target from the Conduit 
Configuration dialog box. 

  Unrealized transactions are never exported. 

To make sure the Conduit exports only when you want to, the export 
function can be enabled or disabled by selecting an option from the 
Export Funct on list in the Configuration dialog box under the Export 
folder. There are three options: Enabled, Disabled, and Disabled after next 
HotSync. The first two options permanently enable or disable the 
exporting. The third option disables the exporting after the next 
HotSync, i.e., data are still exported in the next HotSync, but after that, 
no more exporting unless you enable it again. But if you have used this 
option, be sure to remember to re-enable it next time you want to export. 

i
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You can also choose which transactions to export by giving a date range, 
again, in the Conduit Configuration dialog box. And, you can use the 
Only new transaction checkbox to decide whether you want all 
transactions or just newly created ones get exported. 

If you intend to use Adarian Money with either Quicken 2002 (and above) 
or Microsoft Money 2002 (and above), be sure to read the section 
“Working with Quicken” or “Working with Microsoft Money”, 
respectively. They contain very specific and useful information that can 
save you a lot of time! Make sure you read them. 

Under the Export folder tab, you can select the export target. You can 
choose to export directly to Quicken, to QIF files, or CSV files. Here we 
will discuss how to export to CSV files. 

Exporting to CSV Files  

When you have selected the export file format to be CSV files, you can 
click on the Options button for more settings.  

 

You can check the Convert amounts to home currency if you don’t want to 
use foreign-currency amounts in the importing software. You can 
separate currency symbols from amounts by checking the nclude a 
column for Currency symbols radio button. This is useful when the 
spreadsheet software cannot recognize the currency symbol you use. 
When this happens, an amount of “HK$ 300” would be treated as text, 
instead of a number! To avoid this, you should check this option and let 
the currency symbol be in another column, and only “300” in the 
Amount column; this way, the spreadsheet software can correctly take it 
as a number. 

I
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The three double-quoting options control how the exported data are 
quoted in the CSV file. Some software can’t determine the field types 
automatically; in this case, quoting some of the fields may help them 
identify which is which.  If when you import the CSV file to software and 
the imported data is not recognized correctly, you can try to use these 
options to make it better. If you’re using Microsoft Excel, you can just 
leave them all unchecked, because Excel can automatically detect the 
field types.  

If there are Split Transactions, you can check the Expand split 
transactions so that every sub-transaction is exported as a row in the CSV 
file. If not, only the main transaction gets exports. 

The exported file is named Transactions.csv in the “From Handheld” 
sub-folder under the Data Folder. 

Note that when exporting to QIF files, if files with same filenames 
already exist in the hard disk, the Conduit will not ask you for your 
permission to overwrite12, it’ll simply overwrite them and move on. 
Therefore, if you want to keep the exported QIF files, you’d better move 
them to another place before HotSync-ing. 

Locations of the Exported Files 

If the option you chose in the Conduit Configuration dialog box is Export 
to QIF File or Export to CSV File, then the exported .qif or .csv files are 
stored in the “From Handheld” sub-folder under the Data Folder. 
Because there can be more than one database in your handheld’s 
memory (please refer to the File Manager section for details on multiple 
database), to avoid confusion, Money will create another level of sub-
folders under the “From Handheld” folder. These sub-folders will have 
the same names as the database names. Exported .qif and .csv files will 
be stored under their respective sub-folder as they originated from. 

Note that databases reside in memory expansion cards are not exported. 

  Export Transactions to a Memory Card  

As mentioned in the beginning of this section, the second way to export 
transactions is export them to a file in the memory card. Here is how to 
do it: 

                                                            
12 The Conduit does not ask you for your permission before overwriting is because you may not 
be at the computer. Remember the HotSync can be done remotely through LAN or Internet, if 
you’re not there in front of the computer to answer the confirmation, the whole HotSync would 
simply be blocked and cannot proceed! That’s why good-behavior conduits don’t even give 
error messages during HotSync; they just save errors into the HotSync log. 

 Page 129 of 171 



Adarian Money™ for Palm OS® User’s Manual  © 2003-2006, Adarian Software, LLC 

1. In Adarian Money’s main program on your handheld, Select the 
Export command from the Data menu, you’ll see the Export dialog 
box come up: 

 

2. In this dialog box, you should give a name for the exported file. You 
don’t need to include a file extension; Money will automatically 
assign it with a proper extension.  

3. You can use the Memory pop-up list to select the destination of 
export. The first item in the list is always Handheld, this is the main 
memory; all other items in the list are your memory cards. If a 
memory card is chosen, you can change folder by double-tapping on 
a folder name (surrounded by square brackets []) in the list of 
filenames; the New Dir button can be used create new folders; the 
Delete button is to delete files or empty folders. Note that you can’t 
create folders in the main memory. 
Note that transactions can only be exported to memory card, but not 
the main memory. 

4. Because you want to export transactions, so in the Export what 
option, make sure you have selected Transactions. 

5. Choose a file format from the File format pop-up list. Once a file 
format is chosen, the Options button will be enabled which lets you 
further set up the options for exporting. The details about file format 
options have already been explained earlier in this section, please 
refer to explanations there. 

6. Tap on the OK button and exit the dialog box. Money will save the 
exported data in the designated memory.   

7. Take the card out and insert it into a card reader on your desktop 
computer. Then copy those file out from the card to the computer’s 
hard disk. 
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 Importing Transactions 

Money supports importing transactions which have been saved as QIF 
or OFX files. The source of these files can be downloaded from your 
bank’s web site, or exported from some other software like Microsoft 
Money or Quicken.  

You can import these files by using either the PC Conduit or a memory 
card. The second method is best for those whose desktop computer are 
not Windows PC (e.g., a Mac) and have a memory card on their 
handhelds. We will explain these both approaches in this section. 

  Download QIF or OFX Files from Web Sites  

If your bank provides statement download, make sure you choose the 
QIF format, “for Quicken”, or anything similar. If your bank supports 
OFX format, you can use that too. But QIF is better than OFX because it 
provides more detailed information.  

When downloading, some web sites let you specify a folder to save the 
file. In this case, you should choose the “To Handheld” folder and make 
sure the file extension is *.QIF. (If you’re using Microsoft IE, Try to click 
the right button on the Download button or hyperlink, sometimes you 
can use the “Save Target As…” to specify a folder.) 

However, not all web sites let you choose a places. Some webs sites put 
the downloaded file in a system-chosen place in your hard disk. In this 
case, your best bet is to look for the file in Windows temp folder after the 
download is completed. The temp folder is usually in: 

C:\Documents and Settings\your_name\Local Settings\Temp 

(your_name is your Windows username. Also note that the Local 
Settings folder is a hidden folder, to make it show in Windows Explorer, 
you have to check the Show hidden files and folders option from the View 
tab of the Tools> Folder Options menu command in Windows Explorer.) 

In that folder, look for the most recently created file by looking at the 
date (don’t count on the filename, it can be a very “ugly” name like 
“~0f4CE.tmp”). Then open it with a text editor such as Windows 
Notepad, it should look something like this: 

!Type:Bank 
D04/22/2004 
C* 
PShare Draft: 000001033 
T-552.00 
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N1033 
^ 

If you found it, move it to the “To Handheld” sub-folder, and rename it 
so that it has a file extension *.QIF. If you can’t find it, you’ll have to 
check with the bank’s webmasters, only they know how they download 
their statements. 

  Export QIF Files from Quicken or Microsoft Money  

If you want to use QIF files exported from Quicken or Microsoft Money, 
please refer to the “Working with Quicken” and “Working with Microsoft 
Money” sections, they contain a lot of very useful information to save 
you a lot of time. 

 Using a Memory Card  

If your desktop computer is not a Windows PC, e.g., Mac, and if your 
handheld has a memory card, you can import files through the memory 
card. Just insert the memory card into a card reader connected to your 
desktop computer, copy the files you want to import to any place in the 
memory card. Then insert the card into your handheld’s memory slot, 
activate Money, switch to any view that’s not a chart-based view, then 
select the Import command from the Data menu. Please proceed to the 
“The Import Command” below. 

  Using the Conduit  

If you are using the Conduit to import files, you should put them in the 
“To Handheld” sub-folder under Money’s data folder, then perform a 
HotSync. After the HotSync, all QIF/OFX files in the “To Handheld” sub-
folder will be downloaded to the handheld and removed from the your 
disk; other files remain intact. If you think you’ll need those files later, 
you should make a copy to another place before HotSync-ing. Now you 
can go to your handheld, and activate Adarian Money. When Money 
sees there are incoming data in the memory when starts up, it will ask 
you if you want to import the data right now: 

 

If you tap on the Now button, you will be brought to the Import dialog 
box,. If you chose later, nothing will happen until the next time when 
you enter Money again, you will be prompted again. 
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  The Import Command  

Before you proceed to import the transactions, you should make sure 
the accounts used in the transactions already exist. Otherwise you will 
receive an error message and have to start over. 

No matter where the import data come from, the memory card or the 
Conduit, you should use the Import command under the Data menu to 
get those data into Money’s database. 

 

First, you should select the file that you want to import. Don’t forget to 
select which account you want to import the transactions into. Then tap 
on the Opt ons button to set import options: i

 

 Set status to   You can decide what status to use for imported 
transactions. There are 4 choices: You can choose Posted, Cleared, or 
Reconciled so that all imported transactions will be set to one of these 
statuses. Retain original is to retain whatever status a transaction has 
in the imported file. 

 Import Payees to   If you’re importing data downloaded from bank’s 
web site, the information contained in the payee field may not be 
desirable to you. For example, the store code of a nationwide chain 
store may appear in the payee field and thus creating many different 
payees in Money although (to you) they are all Starbucks;  or 
sometimes even the address is in there. To remedy this, Money gives 
you three choices: you can simply discard all payee information (Do 
not import), or have Money put payee into the Note field (Payee field), 
or accept them let them be imported into Money’s payee list (Not 
field). 
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 Discard check numbers   Similarly, the check number field may also 
contain information that you don’t want, such as bank’s transaction 
ID! You can check the Discard check numbers option to discard them. 

 Match transactions   If this option is checked, Money would 
compare imported transactions with the ones that are already in the 
database. If a transaction is found to have same account, date, and 
amount as an existing one, then it’s considered to be a duplicate one 
and will be marked as “do not import” by default. You can specify a 
number of days the dates are allowed to be different; this is useful 
because the date you entered the transaction may very likely be 
different when it the bank cleared it. 

  Reviewing Transactions  

After tapping on the OK button from the Import command dialog box, 
the program will scan all the transactions in the imported file. All 
transactions found in the file will be displayed in the following dialog 
box for your review: 

 

Here you can preview the transactions and choose the ones that you 
want to import. By default, all transactions are checked, i.e., they will be 
imported. If you have enabled the Match transactions option from the 
import options dialog box that we described earlier, all matching 
transactions will not be checked initially. That is, these transactions 
already exist in the database; supposedly you don’t need to import them 
again. But if you do want to import them, you can just check them and 
the program will import them and may produce duplicates. 

Having reviewed all items in this dialog box, you should tap on the OK 
button to start the actual importing. 

  Income or Expense Category?  

When importing transactions from QIF (but not OFX) files, Money may 
encounter categories that it doesn’t recognize and thus can’t decide if 
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they should be income or expense categories. When this happens, it’ll 
ask you. See the following picture.  

 

 

  Done!  

When the importing has finally finished, Money will give you a summary 
report of what has been done to the database: 

 

It also shows how many new accounts, categories, payees, and classes 
were created. 

 Importing OFX Files 

OFX (Open Financial Exchange) files are usually downloaded from 
banks’ web sites. The procedures of importing OFX are exactly the same 
as importing QIF files, which we have discussed in the previous section.  

But because of the nature of OFX files, it is unable to decide the 
destination account for transfer transactions contained in an OFX file. 
Therefore, when Money sees a transfer transaction in the file, it will 
issue the following question to let you decided what to do about it.  
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In this example, a transfer with a negative amount is found. You should 
either assign the destination account for it, or simply import it as a 
withdrawal. 

 Backing up Money’s Database 

In addition to the functions introduced above, PC Conduit has another 
function: It makes extra backup copies of Money’s database for up to a 
specified number of days.  

Because your data is important, we don’t want you to lose your data by 
accident, so every time you perform a HotSync, PC Conduit makes an 
extra copy of the database to a sub-directory called “Backup” under the 
data directory you specified in the Configuration dialog box. Backup 
copies of database files are place in this sub-folder, filenames are the 
date of HotSync. If you performed more than once of HotSync in the 
same day, a serial number is appended to the filename. 

There is an option in the dialog box called Backup database for up to. 
Here you can specify up to how many days the backup copies should be 
kept; when a file is older than this number, it will be deleted. 

 Working with Quicken 

  Getting the Databases in Sync  

Before you start exchanging transactions between Quicken and Adarian 
Money, it’s important to know that Quicken does not accept unknown 
accounts. That is, if you created an account in Adarian Money, you must 
create it in Quicken manually too; otherwise you will encounter 
problems when you try to export transactions from Money to Quicken. 
So in order to keep accounts in the two databases in sync, you should 
first download account information from Quicken to Money. 
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Other than accounts, it’s also better to keep the categories and classes in 
sync too. Unlike accounts, this is not mandatory, but it’s a good idea. 
After all, it’s convenient for you to see the same names on both the PC 
and the handheld. 

Therefore, it is highly recommended, although it’s not a must, that you 
perform a database synchronization before you start using Money with 
Quicken. This will save you a lot of time (and even problems) in the 
future. Next we will show you how. 

1. Clean Up Everything on the Handheld 

When you first activated Money on your handheld, it will automatically 
create a database with some default information in there. Of course 
these default information do not match with what you have in Quicken. 
So what you need to do is clean up everything on the handheld. You 
need to delete all the accounts, categories, classes, and payees from your 
handheld. To do so, you should use the respective commands from the 
Lists menu. In the list editing dialog box, tap on the Del All button to 
delete the entire list at once. 

  When you delete accounts as described above, be noted that 
transactions from those accounts will be deleted too. Make sure  
you know the risk. 

2. Export from Quicken 

Now go to Quicken, select File> Export> QIF File command, the following 
dialog box appears: 

 

In this dialog box, enter a filename (must have a file extension of .QIF) in 
the “To Handheld” sub-folder under your Data Folder (see the 
“Installing the Conduit” section for details on what’s the Data Folder) in 
the QIF File to Export to field. Select any account in Quicken Account to 
Export from and use any date range. In the Include in Export box, check 
only Account List and Category List, leave everything else unchecked. 
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Then click the OK button. When it’s done, a QIF file will be created in 
the “To Handheld” folder and ready to be downloaded. 

Before we move on, there are a two things you should know: 

 The maximum lengths of names in Money and Quicken are different. 
In Money, names (e.g., account names, category names, etc.) can 
only be up to 31 bytes, but Quicken can accept 40 bytes. Although 
Money can automatically chop them down to 31 bytes when 
downloading, but this will create problems when uploading 
transactions back to Quicken. Quicken will treat those shortened 
names as different names! Therefore, you’d better make sure the 
names in Quicken are not too long.  

 When you download account names from Quicken to Money, 
Money does not accept investment accounts. Money will simply 
ignore them. 

 When downloading to Money, Quicken only exports the names. 
Quicken does not export other information, such as account limits 
or budgets. 

3. Download to the Handheld 

Now perform a HotSync. Please refer to the “Importing QIF Files” 
section to see how Money handles imported data. When it’s finished, 
you will be notified of how many items have been imported.  

 

As you can seen from the above message, accounts, categories, and 
classes are added into Money; but no transactions or payees added, 
because we did not choose to export those from Quicken. 

  Exporting Transactions To Quicken  Directly  

If you have Quicken 2002 through 2004, there are two ways of exporting 
transactions to Quicken: go through QIF files, or export directly to 
Quicken. You can choose the export target you want from the Conduit 
Configuration dialog box. 
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For the direct method, during HotSync, transactions are directly put into 
Quicken’s folder, next time when Quicken starts up it’ll automatically 
detect that there are data coming in and process them. 

When Quicken examines the data, if it finds problems in it (such as 
accounts, categories, payees, or classes that do not already exist in 
Quicken’s database), it’ll pop up a dialog box to let you edit the 
imported transactions: 

  

It’s often that you created new categories, classes, or payees on your 
handheld but not in Quicken. When importing into Quicken, this dialog 
box gives you the chance to manually add those things into Quicken. 
But please be aware: Quicken does not let you create new accounts from 
this dialog box. That is, if you created new accounts on your handheld, 
you have to create the counterparts in Quicken BEFORE you perform 
the import.  

If there are no unknown items in the imported data, this dialog box will 
not show. 

Next, you’ll need to go to Quicken’s account register view (click on an 
account’s name from the panel located on the left of its window), you’ll 
find the newly imported transaction are listed at the bottom of the 
screen with the status “New”. You need to select a transaction and use 
the Accept button to accept it into the account register. 
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Exporting directly into Quicken is better than using QIF files because 1. 
you don’t have to manually look for the files to import in Quicken; 2. you 
can export transactions from all accounts at once. 

Setting Up for Direct Import 

To enable the direct import, first check the Export directly to Quick 
option from the Conduit Configuration dialog box. Then click the 
Quicken Options buttons to further specify a few other options, see below: 

 

In this dialog box, you need to tell the Conduit where Quicken’s 
program file is located by entering the folder name into the Quicken 
program folder edit box. You can use the Browse button to locate the 
folder. Usually the Conduit can find it by itself. When the first time you 
get into this dialog box and there is already a folder name in the edit box, 
then it means the Conduit has found it. You don’t need to do anything. 
If it’s blank, then you’ll have to tell the Conduit where it is. Quicken’s 
executable filename is qw.exe, you need to enter the name of the folder 
where this file is in. 
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In Money, transfer transactions don’t have a payee. But in earlier 
versions of Quicken, they use “Transfer Money” as the payee for transfer 
transactions. If you wan, you can check the checkbox at the bottom so 
that when exporting transfer transactions, “Transfer Money” is used as 
the payee. 

  Exporting Transactions To Quicken Through QIF Files  

Other than the direct method, you can also export transaction to 
Quicken through QIF files. First let’s look at how to set up the QIF export 
options. 

You should first check the Export to QIF File radio button from the 
Conduit Configuration dialog box. Then click the QIF Options button 
next to it, see the picture below.  

 

When the Conduit exports transactions, one QIF file is created for each 
account, the filename is the account name. These files are all in the 
“From Handheld” sub-folder. 

The Convert currency checkbox at the bottom of the dialog box allows 
you to convert currency amounts when exporting. This may be useful 
when you work with software that doesn’t support multiple currencies. 

And just as we’ve mentioned earlier in this section, you’d better make 
sure all the lists are consistent in both programs’ databases. If Quicken 
finds there are unknown items in the QIF files, it will pop up a message 
to ask you to create it. You can create new categories, payees, and 
classes; but you can’t create accounts. Therefore, if you created new 
accounts in the handheld, you should create them in Quicken before 
importing. Keeping the two database in sync always gives you smoother 
experiences in importing and exporting. 

Next you should perform a HotSync, QIF files will be created in the 
“From Handheld” sub-folder in your specified Data Folder. Then, go to 
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Quicken, select the File> Import> QIF File command, you will see the 
following import dialog box: 

 

As we said earlier, transactions are exported by accounts; each account 
in Money will have a corresponding QIF file. Therefore, here in this 
dialog box, you should select one file at a time and import it into the 
corresponding account in Quicken. Don’t import into a wrong account, 
or it will waste you a lot of time to correct it. In this dialog box, check 
only the Transactions checkbox, leave others unchecked. 

  Importing QIF Files from Quicken To Money  

If you have Quicken 2002 or above, you can use the File> Export> QIF File 
command to export transactions and other information to Money:  

 

At the beginning of this section, we’ve already seen how to export 
categories, accounts, and classes lists to Money. If you checked the 
Transactions checkbox, then only transactions get exported. 

Transactions are exported by accounts, one account at a time. So you 
need to perform this export as many times as necessary to get all 
accounts exported. Remember, the exported QIF files must be in the  
”To Handheld” sub-folder of the Data Folder.  
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When you’re done, perform a HotSync. The rest of the details have 
already been explained in the section of “Importing QIF Files”, please 
refer to that section for details. 

 Working with Microsoft Money 

  Exporting QIF Files to Microsoft Money  

When Microsoft Money imports transactions, it has the ability of 
accepting categories, payees, and classes that don’t exist in its database.  
When it sees an unknown item, it automatically adds it to its own 
database without asking you. This is very convenient. But you have to 
make sure the spelling of an item’s name is the same on both sides, 
otherwise you’ll have duplicate items like “Tax” and “Taxes”, or “Auto” 
and “Automobile”. 

In any case, keep the databases on both sides always in sync is always a 
good idea. 

To export transactions to Microsoft Money, you need to go through QIF 
files. In the Conduit Configuration dialog box, click the QIF Files radio 
button, then click on the QIF Options button, make sure the Local format 
checkbox is checked. And don’t forget to set up the date range and if you 
want to export new transactions only, etc. 

Then, perform a HotSync. When the HotSync is done, several QIF files 
will be created in the “From Handheld” sub-folder of the Data Folder. 
(To specify the Data folder, go to the Conduit Configuration dialog box.) 
Each QIF file corresponds to one account in Adarian Money. You need 
to import them one by one into Microsoft Money. 

Now go to Microsoft Money, use the File> Import command to start 
importing. At this time, Microsoft Money will ask you if this file is a bank 
statement or a recovered or new account (see the picture below)?  
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Microsoft Money treats these two types very differently. The differences 
are: 

For Bank Statements 

 Split transactions, categories, and classes information are not 
imported. The import will still continue, but Microsoft Money 
simply ignores these information. 

 Microsoft Money does accept payee information in transactions 
coming from Adarian Money. But when it finds that a transaction 
whose payee matches with that of its remembered transaction, it will 
apply the remembered transaction’s details to the imported one. For 
example the category of the remembered transaction is assigned to 
the imported transaction. Thus, sometimes the result may not be 
exactly what you want. 

 Transfer transactions all become ordinary deposits or withdrawals. 

 But the benefit is imported transactions are displayed in bold text 
and the status is marked with ‘E’ so that you can easily tell which 
transactions are imported. This will be very useful for reviewing 
them. 

For Recovered or New Account 

 Comparing to the bank statements, Microsoft Money accepts a all 
information from the QIF file if it’s treated like a recovered or new 
account. The only problem is it doesn’t highlight those transactions 
for you to review.  

You should choose the type that best suits you. 

  Importing QIF Files from Microsoft Money  

You can use the File> Export command to export transactions to Adarian 
Money. When selected, Microsoft Money will first ask you the file format, 
see below. You can choose Loose QIF.  
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You will also be asked what type of accounts to export. Adarian Money 
does not support investment accounts, so you should always choose 
Regular in the following dialog box: 

 

Then you will be asked to select an account to export. Microsoft Money 
exports one account at a time, so you should repeat this procedure for as 
many times as necessary. 

You should save these files in the “To Handheld” sub-folder with the file 
extension .QIF. When you next time perform a HotSync, these QIF files 
will be downloaded to the handheld. For details about how Adarian 
Money handle these files, please read the “Importing QIF Files” section. 
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The Goodies 

Under the View Menu, there is a Goodies submenu which contains four commands. 
These commands can call up four tools which may come in handy when you’re using 

Adarian Money™. These tools are:  

1. Arithmetic Calculator 

2. Calendar 

3. Currency Converter 

4. Loan Calculator 

These four tools have one thing in common: They are independent from Money’s 
database and the rest of the functions. No matter what you do, Money’s database will 
not and can not be affected. They are here only for your convenience. 

 Arithmetic Calculator 

 

The Arithmetic Calculator can be called up from many dialog boxes. 
When used from dialog boxes, there will be an Enter button in the 
calculator. When tapped on, the number shown in the calculator will be 
returned into the dialog box. But when the calculator is called up as a 
view from the Goodies submenu, then there is no an Enter button and 
there is no way (and no place) to return  the result to. 

Operations of this calculator is very much alike real world calculators 
with only a few differences: 

Tax – can be used to calculate sales taxes when shopping. You can set up 
the sales tax rate from the Preferences command. 
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Tips – can be used to calculate tips. You can setup the tips rate from the 
Preferences command. 

Registers – real world calculators have only one memory, but 
this one has 10 memories (registers.) When you tap on the 
M+, MR, or MC buttons, a list of registers show up for you to 
choose. The M+ button adds current result to the selected 
register; MR button retrieves the value stored in the selected 
register; and the MC button sets the selected register’s value 
to 0. Values in these 10 registers are remembered even after 
you quit Money; next time you run Money, the register values are  still 
there for you to use. 

To quit the calculator, you can either tap on the Cancel button, or just 
tap anywhere outside the calculator window. 

 You can use a Quick Access Key to call up the calculator, but you 
can’t use a Quick Access Key to switch to another view. 

 Calendar 

 

This is the standard Palm OS date selection dialog box. We put it in the 
goodies is because we though you may sometimes want to check the 
dates. It might be useful.  

When in this dialog box, you can tap to change date or year. But if you 
tap on any date, the dialog box will close. No matter what you tapped in 
here will not be returned to Money. This is only for you to look up dates. 

 Currency Converter 

The Currency Converter is a convenience tool for people who may need 
it, but it is completely independent from the rest of the functionality of 
Money.  
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By default, you can use Graffiti or hardware keyboard to enter the Quick 
Access Key ‘3’ to switch to this view.  

 

It’s very straightforward to use the Currency Converter. Just select the 
currencies you want and enter a number in any of the fields. When you 
enter, the rest of the fields will automatically update to proper values to 
show converted results. To change currency exchange rates, you need to 
use the Currencies command from the Lists menu. Please refer to the 
“Defining Currencies” section for details. 

  Removing Focus  

When you’re in this view13, the focus may be on a text editing field. That 
is, there is a blinking cursor showing in one of the text editing fields. 
When in this situation, the Quick Access Keys function will not function 
because any key you entered will be considered as an input to the text 
editing field.  

For example, if you used Graffiti to enter the letter ‘t’ in an attempt to 
switch to the Transaction Log view, but the system thinks it’s an input to 
one of the Currency Converter’s text editing fields and thus send it there. 
Money will have no chance to process it as you expected. 

To remedy this, you have to remove the focus first. To remove the focus, 
simply tap on an empty space on the screen that won’t trigger an action. 
That is, don’t tap on any field, button, selector, table header, etc; just tap 
on an empty space. Having done so, the blinking cursor will be gone and 
now you can use Quick Access Keys again. 

                                                            
13 Well, Currency Converter is not actually a view like the rest of the build-in views, but because 
it has the same behavior as and is treated like any other views, sometimes we think of it as a 
view too. 

 Page 148 of 171 



Adarian Money™ for Palm OS® User’s Manual  © 2003-2006, Adarian Software, LLC 

 Loan Calculator 

The Loan Calculator is a convenience tool for people who may need it, 
but it is completely independent from the rest of the functionality of 
Money.  

By default, you can use Graffiti or hardware keyboard to enter the Quick 
Access Key ‘4’ to switch to this view.  

To use the Loan Calculator and the Pie Chart, you have to install the 
freeware MathLib.prc too, details can be found in the “Installation” 
section. 

 

When you tap on the Calc button at the bottom, a pop-up menu appears 
to let you select what to calculate. You can choose to calculate one of the 
three parameters: Loan amount, Loan length, and Payment. When 
calculation is done, the results are put in the corresponding fields in the 
upper half of the screen. Also, the table in the lower part will be updated 
to reflect the payment schedule based on the conditions given above.  

The Loan Calculator can calculate based on two kinds of interest 
compounding periods: monthly or semi-annually. You can set this 
option from the Preferences dialog box. 

Columns in this table are: 

Number – sequential number of the payment period. 

Interest – out of the payment made in this period, how much is used to 
pay for the interest. 

Principal – out of the payment made in this period, how much is used to 
pay for the principal. The sum of this amount and the above amount 
equals to the payment of each period. 

Interest Sum – The sum of all that you have paid for interest from the 
start of the loan.  

Principal Balance – How much principal you still owe the bank. 
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All amounts displayed in the table of Loan Calculator are in home 
currency and thus no currency symbols are shown. Nor there are 
decimal digits. 

  Removing Focus  

When you’re in this view, the focus may be on a text editing field. That is, 
there is a blinking cursor showing in a test editing field. When in this 
situation, the Quick Access Keys function will not function because any 
key you entered will be considered as an input to the text editing field.  

For example, if you used Graffiti to enter the letter ‘t’ in an attempt to 
switch to the Transaction Log view, but the system thinks it’s an input to 
one of the Loan Calcualtor’s text editing fields and thus send it there. 
Money will have no chance to process it as you expected. 

To remedy this, you have to remove the focus first. To remove the focus, 
simply tap on an empty space on the screen that won’t trigger an action. 
That is, don’t tap on any field, button, selector, table header, etc; just tap 
on an empty space. Having done so, the blinking cursor will be gone and 
now you can use Quick Access Keys again. 
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Options Menu 

 The File Manager Command 

Money lets you create and keep more than one database (or “file) in the 
memory; you can work on these databases as you would with Word 
documents or Excel spreadsheets. You can crate new files, open existing 
ones, rename them, etc. With multiple databases, you can better 
manage your financial information, for example, you can keep all your 
personal financial information in one file, and business financial 
information in another. 

When you select the File Manager command from the Opt ons menu, the 
following dialog box appears: 

i

 

The first row shows the database that is currently in use; you can’t delete 
this database. The second row Memory is a list of the volume labels of 
memory cards inserted in your handheld. The item Handheld in this list 
refers to the main (internal) memory of your handheld; this item always 
exists even if your handheld does not have any memory expansion cards.  

 Although you can keep Money’s databases in memory expansion 
cards, but please be noted, such databases will not be backed up 
to your desktop computer during HotSync, nor can be they 
opened directly.  

Rename – this button lets you rename the selected file. 

Copy – copies the selected database to another memory card (or main 
memory). 
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Details – shows the detailed information about the selected database; 
this command works only for databases that exist in the main memory. 

Delete – deletes the selected the file or folder (on memory card); the one 
that’s currently in use cannot be deleted. 

New Dir – create a new folder on a memory card; main memory does not 
support folders. 

Show File Manager at start-up – when this option is checked, this dialog 
box will appear immediately after you started running Money; this is 
useful if you have multiple databases and often switch among them. 

New – creates a new database and switches to it. When this button is 
clicked, the File Manager dialog box closes and another one shows: 

 

The Duplicate the current file option lets you decide what contents there 
will be in the newly created database. If checked, the new file will have 
exactly the same contents as the one that you’re now working on; if not 
checked, there will only be some “factory defaults” in the file. 

Open – opens the selected database. Note that databases reside in 
memory expansion cards cannot be opened directly; they have to be 
moved to the main memory before they can be opened. 

 The Auto Backup Command 

This command lets you create backup copy of the data in a memory 
card. 

 

When this option is enabled and when a database is closed (e.g., exiting 
the program or opening another database), the program would perform 
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a self-check to make sure all the data in the database are valid. When 
verified, the program will create a backup of it in the specified folder in 
the expansion memory card. If a password is assigned and if encryption 
is enabled, the backed up copy is always encrypted.  

As explained in the section about the File Manager command, databases 
in a memory card cannot be opened by Money directly; you’ll have to 
move it to the main memory first. So if for any reason you need to revert 
back to a previously saved backup copy, you should use the File Manager 
command to copy it to the main memory then open it. 

The program will not issue any error message if there is any error when 
performing an automatic backup.  

 The Password Command 

This command lets you assign a password so that every time Money is 
started, the user will be asked to enter a password to get access to the 
data. When you use this command for the first time, you’ll see the 
following dialog box: 

 

One a password is assigned and if you have enabled encryption from the 
Preferences dialog box, selected parts in the database will be encrypted 
using Blowfish encryption algorithm. Please refer to the Security options 
in the Preferences dialog box to see what else you can do to protect your 
data. 

 Encryption is a better way to protect your data from being 
accessed by unauthorized people. However, there is no 100% 
guarantee that people can’t crack the encryption; given enough 
time and resource, a determined person can still have a chance 
to access your data without a password. So, the best way to 
protect your data is – don’t let your data fall into wrong hands. 

The Activate security mode checkbox is not checked because you haven’t 
assigned a password yet. If you want to enable the security mode, just 
check the checkbox and tap on the OK button to exit. Now you’ll see the 
following dialog box where you can choose a password that’s easy for 
you to remember: (the password dialog box can be in either Numeric or 
Alphabetic mode, depending on which one is easier for you to member) 
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You can enter up to 16 digits or alphabets as the password. Once you 
have entered and confirmed the password, the security mode is turned 
on. Next time you enter Money, you’ll have to pass the password test 
first. Also, if the handheld goes to sleep (e.g. no operation for too long) 
while Money is running, Money will automatically quit. 

If the security mode is already turned on when you select the Security 
command from the Options menu, you’ll have to first pass the password 
test before you’re granted access to the Security dialog box. 

 The Lock Now Command 

When you have assigned a password to the database, by default, every 
time when you open the database, you will be asked to enter the 
password to unlock it. But in order for you to be able to quickly return to 
the program without having to enter the password again, you can use 
the Don’t ask for the password option from the Preferences dialog box so 
that if you returned to the program within, say, 3 minutes, the program 
will not ask you to enter the password. 

Convenient as it is, but it also brings security risk, because anybody can 
access your database within the grace period without using a password. 
So when you know that you will leave the program and won’t come back 
immediately, you should use the Lock Now command to quit the 
program and lock it up immediately. The next time you, or someone, 
return to the program, you will always be asked to enter the password. 

 The Preferences Command 

The Preferences command has four groups. The first group is for general 
preferences: 
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  General Options  

 

Start-up view lets you select which view do you want to see when you 
start up Money. The default is the Last view, which shows the view that 
you were in when you exited Money last time. You can select any of the 
eleven built-in views or the custom views you defined. 

Auto check balances and budget option, if enabled, instructs Money to 
perform automatic checks on budgets and account balances to see if 
over-budgets or overdrafts are about to happen. These checks happen 
every time after a new transaction is created or an existing one is 
modified. Complete discussion about overdrafts and over-budgets  can 
be found in the  sections of “Overdraft Alerts” and the “Over-budget 
Alerts” sections. 

Retain sort order makes Money remember which column in the table is 
sorted when leaving a view. Next time you switch to that view, data will 
automatically be sorted based on values in the same column. If disabled, 
when you switch to a view, data will always be sorted by the default 
column. For the Transaction Log and the Account Register views, data 
are sorted by date by default. For other views, the default sort order is 
sort by name. 

Auto fill-in  enables or disables the auto fill-in feature when entering or 
modifying a transaction. 

Reinstate hint messages re-enables all hint messages. In Money, there are 
several messages that has a Don’t show this message again option in the 
message box. Once checked, the hint message will never be shown again. 
This keeps you from being bothered by the same hint message again 
and again. But there are times when you may want to see those hints 
again, so you can check this option to re-enable them. 

This option is always at the off state every time you enter the Preferences 
dialog box. 
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Work on temp database  Although it’s rare, but it’s possible that you lose 
your data if the database is corrupted in situations like when Money 
works under low memory condition, or experiences an abrupt shut-
down, or even software bugs. To protect your data, we have put in an 
extra layer of backup function in the PC Conduit. To go one step further, 
we provide this option to keep your data safer.  

When this option is not checked, every time you enter Money, Money 
will open the main database, and all the changes you made will be saved 
directly into the main database. But the risk is if something happened, 
your database can be damaged and the data in it becomes 
unrecoverable. 

To protect your data, you should check this option. This is how it works 
when it's checked: 

When you activate Money, it will copy the active database to a 
temporary database (“AMTempDB”), this is your working copy of the 
database. That is, all the changes you make during this session will not 
be saved into the main database, instead, they are saved into this temp 
database. When exiting, the program will perform a validity check on the 
temp database. If it’s found to be all right, Money will copy it to the main 
database and delete the temp, thus your changes are saved. If however, 
the temp is found to contain invalid data, Money will leave the temp in 
the memory and keep the main intact. This way, your main database is 
guaranteed to be safe, although all the changes you made are lost.  

When Money starts running, if it finds a temp database in the memory, 
it will issue the following message to let you decide what to do: 

 

If you said No, Money will delete it and create another working copy 
from the main database. That is, you’re back to the database before the 
problem occurred. If you said Yes, Money will check the temp database 
to see if it’s corrupted. If it’s not corrupted, Money will use it, and thus 
you didn’t lose anything. If it’s indeed corrupted, Money will show 
another message (see below) to let you know. Then it will create another 
working copy from the main database. 
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When Money creates the temp database, if for any reason it failed (e.g., 
not enough memory), you will see the following message. When this 
happened, Money can continue execution, but you will be working on 
the main database. 

 

The benefit is obvious: your data is safer. But it comes with a price: 
slower start-up and exit, and more memory space. The time spent on 
copying the database when start-up shouldn’t be too much. But the 
time spent on checking the temp database’s sanity when existing can be 
long if the database is large. And the extra amount of memory required 
to store the temp database is exactly the size shown at the bottom of the 
Database dialog box. So it’s up to you if you want to use this option or 
not. 

To find out which database you’re using, you can use the Database 
command from the Options menu. 

If a problem occurred during execution and you believe it’s a software 
bug, you can send the temp database to Adarian for further analysis. 
This is how: After Money abnormally quits, as explained earlier, the 
temp will be left in the memory. But because it will be deleted next time 
you run Money, so before you run Money again, perform a HotSync. 
This will bring the temp database to your hard disk. You should look for 
a file named AMTempDB.pdb in your hard disk, and send it to Adarian. 
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  Income/Expense Options  

 

These options control which transactions should be included in the 
calculation of income and expense. A detailed discussion about these 
options can be found in the “Calculation of Income and Expense” 
section. 

  Display Preferences  

 

Show future transactions controls how many days into the future the 
upcoming scheduled transactions and unrealized transactions should 
be displayed in the Account Register view.  

Show complete category names controls whether the full category names 
or just the subcategory names are displayed in Transaction Log and 
Account Register views. When checked, full names are displayed, such 
as “Auto:Fuel”; when disabled, only subcategory names are shown, such 
as “Fuel”. 

Show decimal digits controls whether decimal digits are displayed in the 
Summary, Categories/Budgets, Classes, and Payees views. When not 
checked, all amounts shown in these views are rounded to the nearest 
integers. When checked, Money will display decimal digits according to 
the Accuracy setting in their corresponding currency definitions. 

Show combined expenses controls whether combined expenses should 
be displayed in the Categories/Budget view. See here for more details. 
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Show years shows or hides the year part in all dates shown in Money’s 
table.  

Show button bar shows or hides the Quick Access Button bar. This option 
does not show if the handheld’s screen is not 320x450 or 450x320. 

  Security Options  

 

Quit when Palm sleeps lets the program to stop running if the Palm 
handheld times out and goes to sleep. This prevents people from seeing 
your data if your data if you forgot to quit Money and leave it open there. 

Encrypt the following  This option lets you decide which parts of the 
database are to be encrypted when there is a password assigned to the 
database. Encryption gives you better security so that it will be very 
difficult for unauthorized people to pry into your privacy without a 
password. But encryption and decryption also takes time and memory. 
It is recommended that you select only the parts that are sensitive to you. 
If there is no password for this database, no encryption will take place. 

Don’t ask for password lets you specify a period of time within which if 
you re-open the database again, the program will not ask you to enter 
the password. This is an easier way for you to return to the program 
within the grace period. If you choose Always here, then the program 
will always ask you to enter the password. 

  Sync with AMWin Options  
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Adarian Money™ for Palm OS® has a sister product that runs on 
Windows PC. If you have both versions and you wish to synchronize 
your data so that you can edit/view your financial information on both 
platforms, then you have to choose Yes here. Otherwise, you must 
choose No, because this helps eliminate some unnecessary information 
kept in the database and save some memory on the handheld. 

 Please make sure both sides have the same settings at all time, or 
the results can be unpredictable. 

If you disabled data sync function and re-enabled it after some time, the 
databases on the PC and the handheld might be out of sync. To ensure 
future sync can work properly, you have to bring them back in sync first. 
To do so, after re-enabling the data sync function, you must perform 
either a Handheld overwrites PC or PC overwrites handheld sync first.  

Automatic Processing 

If you decide to enable the data sync function, there is one more 
decision you'll have to make: Which side, the PC or the handheld, will be 
responsible for the auto processing of scheduled transactions? 

In Adarian Money, when a scheduled transaction is due, the program 
will, for example, automatically insert a new transaction into the 
database. This automatic processing can happen only in one place, 
either the PC or the handheld, but not both. Otherwise, the next time 
when you perform a HotSync, you will have two entries for the same 
scheduled transaction – because both sides did the insert. So depending 
on your need, you have to choose which side is going to take care of this. 
(For more details about auto processing, you can check out the chapter 
on scheduled transactions.)  

This automatic processing for scheduled transactions will be enabled on 
the handheld side if you either disabled the data sync function (choose 
No, meaning you don’t have a Windows version, so of course the auto 
processing has to be done on the handheld), or you enabled the data 
sync and chose to let the handheld do it. 
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  Currency Options  

 

The first three options in the Currency preferences are used to define 
the attributes of your home currency. The meaning of these options is 
the same as in the Currency dialog box. 

The Currency symbols option controls whether currency symbols should 
be displayed in the table. If you don’t have any foreign currency account, 
you can choose Never display to save screen space; in most cases Display 
if not home currency is the best choice. 

  Calculator Options  

 

The Sales tax rate and T p percentage options are used by the arithmetic 
calculator to calculate sales taxes and tips. The Loans compounded option 
is for the 

i

Loan Calculator. This is how loan interests are compounded, 
monthly or every 6 months. In the United States, interests are 
compounded monthly, whereas in Canada, they’re semi-annually. 

 Expand All and Contract All Commands 

These two commands are available only when you’re in the 
Categories/Budget view. As their names imply, they expand or contract 
all sub-categories under a parent category at a time. 
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 Zero Items Command 

This command is available only when you’re in Categories/Budget, 
Payees, or Classes view. This command is used to show or hide all items 
in the table whose actual amounts are 0.  

 Page 162 of 171 



Adarian Money™ for Palm OS® User’s Manual  © 2003-2006, Adarian Software, LLC 

Miscellaneous 

 HotSync Between PC and Handheld 

If you have both the Windows and Palm OS versions of Adarian Money, 
and if you wish to synchronize data between the two, there are a few 
things you need to know before you sync. For details about how to set 
up the programs for syncing, please refer to the “HotSync with a Palm 
Handheld” section in the online help that came with the Windows 
version of Adarian Money. You can use the Online Help command from 
the Help menu to access the online help. 

 

 Navigation Buttons 

Almost all Palm-Powered handhelds have hardware navigation buttons 
of one type or another. Following paragraphs describe how Adarian 
Money supports different types of navigation buttons or wheels on 
different handhelds. 

  palmOne Treo 600/650, Tungsten T5  

At any view in Money, you can use the Left and Right buttons to switch 
focus among the buttons and selectors on the screen. A blue focus ring 
will appear around the object that has the focus, see below: 

       

Every time you press the Left or Right button, the blue focus ring jumps 
to the previous or next object. When the focus is on the object you want, 
you can press the Select button to activate that object. 
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 Unlike other views, Currency Converter and Loan Calculator 
views have text edit fields. When a blinking cursor is showing in 
a text field, pressing Left or Right buttons can only move the 
cursor inside the field, instead of switching focus as described 
above. To switch focus when a blinking cursor is showing, you 
can use stylus to tap on anywhere on the screen outside of a text 
edit field, the blinking cursor will disappear and you can use the 
Left and Right buttons to switch focus again.  

When the focus is first switched to the table, the entire table is 
surrounded by the focus ring (see the picture on the left below). This 
indicates that it’s in the page-scrolling mode. When at this mode, 
pressing the Up/Down buttons will scroll the table one page at a time. If 
you press the Select button, the focus ring will be on one row only (see 
the picture on the right below), this indicates it’s in the line-scrolling 
mode. When at this time, pressing the Up/Down button will scroll one 
line at a time. Pressing the Select button will call up the Transaction 
dialog box to let you modify the transaction that has the focus. 

       

When you’re at line-scrolling mode and wish to switch back to page-
scrolling mode, you need to use the Left/Right button to first switch the 
focus away from the table, then switch back to the table again.  

When the View Menu or the Range menu is showing, you can use Up 
and Down buttons to move the highlight up and down in the menu. 
When a menu item without a submenu is highlighted, you can use Left 
or Right button to dismiss the menu (make it disappear). If the 
highlighted menu item has a submenu, you can use the Right or Select 
button to activate the submenu. 

When the focus is on an object such as a button or the Range selector, 
you can press the Select button to activate that object. The resulting 
action will be the same as tapping on it using the stylus. 

In all other dialog boxes, the 5-way navigator’s behavior follows the 
default behavior. 
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  palmOne Tungsten and Zire Series  

On Tungsten or Zire handhelds, the 5-way navigator has the following 
behavior: 

When you’re in any view: 

 Left button: Displays the Range menu. 

 Right button: Displays the View Menu. 

 Up/Down buttons: Moves the highlight up and down in the table 
when there is already a selection in the table. If there isn’t, you can 
press the Select button to select the first item in the table, then use 
Up/Down buttons to scroll. 

 Select button: When there is no selection in the table, pressing 
Select button selects the first item in the table. When there is already 
an item selected, pressing Select button activates the Modify 
Transaction dialog box. 

When a pop-up menu (View Menu or Range menu) is showing in a view: 

 Up/Down buttons: Move the highlight up and down the menu. 

 Left button: Dismisses the menu without activating any menu 
command. 

 Right button: Dismisses the menu if the currently highlighted menu 
item does not have a submenu; otherwise, it’s used to display the 
submenu. 

 Select button: Activates the highlighted menu item. 

The 5-way navigator is not supported in all other dialog boxes. 

  Sony Clié Series  

Sony Clié series handhelds have three types of JogDials: the first type is a 
2-D wheel which you can roll up or down; the second type is the same as 
the first type with the added operation of pushing the wheel inward; the 
third type is a 3-D wheel which you can even roll it left or right. Adarian 
Money supports all these three. 

JogAssist 

In earlier models of Sony Clié (Palm OS 4.0 or 4.1), they came with a 
“JogAssist” function found in the system’s Preferences application, see 
the picture on the left below.  

 Page 165 of 171 



Adarian Money™ for Palm OS® User’s Manual  © 2003-2006, Adarian Software, LLC 

      

The purpose of this function is to assist those applications that do not 
support JogDial so that they can also enjoy the benefits JogDial brings. 
By default the JogAssist is enabled for all applications. (Note the Use 
JogAssist option in the above picture is checked.) However, there are 
applications who are JogDial-aware, these applications don’t need the 
help from JogAssist. Therefore, it also allows the user to disable JogAssist 
for select applications. You can do so by tapping on the Select 
Applications in the picture on the left, then the dialog box on the right 
appears. In this dialog box, check applications that are JogDial-aware. 
By default, when Adarian Money was first installed, it’s not checked, i.e., 
JogAssist will assist it. But since Money is JogDial-aware, you should 
check it in the Select Applications dialog box. If you don’t do so, Money 
will be thought of as a “legacy” software and will be treated as such. If 
you want to enjoy the full benefit of that little shiny JogDial on your cool 
Clié, check it! 

The Behavior 

No matter what type of JogDial you have, the operations of it are the 
same as described in the previous section “palmOne Tungsten and Zire 
Series”. In that section, Left, Right, Up, and Down buttons are the same 
as rolling the wheel left, right, up, and down; the Select button is the 
same as pushing the wheel inward. 

If you didn’t check Adarian Money in JogAssist, then its behave will be 
the same as described in the following section: “Legacy Palm-Powered 
Device’s”. 

There is also a Back button on Sony Clié handhelds. The behavior of this 
button follows the system default behavior: quit the application or 
cancel a dialog box. 

  Legacy Palm-Powered Devices  

Almost all earlier models of Palm-Powered devices, such as Palm V, have 
up and down buttons. When at any view, pressing the Up or Down 
button will make the table scroll up or down by one page.  
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 Installation 

The delivery file you downloaded can be one of the two formats: an .exe 
file or a .zip file. If you downloaded the .exe file, the filename is 
something similar to AM.exe, it contains both the Windows and the 
Palm OS versions of Adarian Money (and the PC Conduit too). All you 
need to do is to finish the installation program, perform a HotSync, and 
then everything will be in place. 

If the file you downloaded is a .zip file, the filename is something similar 
to AMP.zip, you should uncompress all files in the zip to a hard disk sub-
directory. In there you will find a document “Installation.pdf”, it has 
everything you need to know about installing Adarian Money™ for Palm 
OS® onto your handheld. 

  Expansion Memory Card  

DO NOT install the main program file AM_Enu.prc (or AM_xxx.prc) to a 
memory expansion card. Doing so will make the PC Conduit and the 
alarm function unable to work.  

  Syncing with AMWin  

When you start up Adarian Money for the first time, you’ll first see a 
welcome message, then followed by a Sync Options dialog box: 

 

Here you need to decide if you want to synchronize Money's data with 
its sister product Adarian Money for Windows. If you have both the 
Palm OS and Windows versions of Money, then should tap on the Yes 
button. This way Money will keep proper information in the database so 
that they two can successfully synchronize. 

If you don't need this function, then just choose No. This will help 
eliminate unnecessary data in the database and the memory.  

Either way, you can change your mind later and change this option from 
the Preferences dialog box. 

 Page 167 of 171 



Adarian Money™ for Palm OS® User’s Manual  © 2003-2006, Adarian Software, LLC 

  Choosing Your Home Currency  

Next you will see a Home Currency dialog box: 

 

The purpose of this dialog box is to let you decide which currency is 
going to be your home currency. Money came with several pre-defined 
currencies, it’ll try to pick one for you based on the country setting on 
your handheld. If the currency shown in the dialog box is the correct one, 
just tap on the OK button to exit. If it’s not, you can tap on the currency 
pop-up list  to pick one from the pre-defined currencies. If 
your home currency is not on the list, at the bottom of the list there is a 
command called —Define –, select this command and you’ll be brought 
to a currency definition dialog box: 

 

Here you can define your own home currency. Details about how to use 
this dialog box is covered here.  

 Once chosen, the home currency cannot be changed. Therefore 
you must be careful at this step.  

 Uninstallation 

  Uninstalling the Main Program  

To uninstall the main program from your handheld, go to the 
Application Launcher, select the Delete command from the App menu, 
see below: 
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Then in the Delete dialog box, select the item named Money and tap on 
the Delete button. The program and the data will all be removed. 

  Uninstalling the Online Help  

The Online Help that came with Adarian Money is optional. If you did 
not install the AMOnlineHelp.prc and AMOnlineHelpDoc.pdb, then 
there is nothing you need to do here. 

If you have, and if you don’t need the online help any more, you can 
remove them and save some memory space on your handheld. 

To remove the Online Help, go to the Application Launcher, select the 
Delete command from the App menu, see picture above. In the Delete 
dialog box, select an item named AMOnlineHelp, tap on the Delete button, 
and you’re done. 

 Purchasing and Registration 

The file you downloaded is a fully-functional 30-day trial version. After 
30 days, you’ll have to purchase and register if you want to continue 
using it. Usually within 24 hours of purchasing, you’ll receive an e-mail 
from us containing your Registration Code. If you don’t see the mail in 
24 hours, it could be that your mailbox is anti-spam protected, or the 
mail just got lost somewhere in the cyberspace. When this happens, you 
can retrieve your code from our web site. Or you can write us directly.  

When you received that mail, you don’t need to make another download 
or anything, just follow the procedures below to enter the code into the 
Trial version. When you’re done, the Trial version will automatically 
become a registered version, and the 30-day limitation will be lifted. 

  Entering the Registration Code  

When you received the registration code, go to the About command 
under the Opt ons menu. In the About dialog box, tap on the Register 
button at the bottom, you’ll see the Registration dialog box: 

i
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First make sure the HotSync username appeared in this dialog box is the 
same as the one shown in the e-mail you received from us. (If it’s not the 
same, contact us immediately.) Then enter the code into the four fields 
at the bottom and tap on the OK button. If everything goes all right, 
you’ll be brought back to the About box, and it will show your name and 
the registration code. 

If the program does not accept the code, there can only be three reasons: 
(1) the HotSync username shown in the dialog box is different from 
what’s used in the e-mail; (2) you did not enter the code correctly; (3) 
you purchased a wrong product! (Don’t laugh, it happened.) Contact us 
when any of the above happened. 

  Your HotSync Username  

When you purchase, you’ll be asked to give the HotSync name that you 
use on your handheld. It is important that you give the correct name, 
otherwise, you’ll receive a wrong registration code and it’ll take you time 
to change to the right one. To find out your HotSync username before 
purchasing, select the About command under the Options menu, then 
tap on the Register button at the bottom. The Registration dialog box 
appears: 

 

Your HotSync name is displayed in this dialog box. Make sure you use 
this name when you purchase. Important!!! 
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  Your E-Mail Address  

There is one thing to note regarding the e-mail address you use when 
purchasing. We’ve experienced cases when users failed to receive our e-
mail because they have anti-spam software installed either in their 
computers or e-mail servers. These software sometimes mistakenly 
believe our mail was a spam and thus blocked it from being sent to you. 
This happened mostly on those free mail servers like AOL.  

Therefore, it’s best if you can use an e-mail address that doesn’t have 
this “protection” when you purchase. Or, when you don’t see the mail in 
24 hours, please first go check the mail folder where spam mails are kept, 
usually anti-spam software or server has a place to keep them.  

 Support and Upgrade Policy 

Adarian Money™ for Palm OS® version 3.6 is a free upgrade for all 
previous versions. 

No matter how you obtained the product, as long as you have obtained a 
registration code, we’ll always provide services to our users until we’re 
out of business or the Earth stops spinning, whichever comes first.  
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